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Resumo da Dissertacdo apresentada a COPPE/UFRJ como parte dos requisitos

necessarios para a obtencéo do grau de Mestre em Ciéncias (M.Sc.)

PROGRAMA COMPUTACIONAL PARA PROJETO
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Alessandro Barile

Margo/2009

Orientadores: Julio César Ramalho Cyrino

Richard David Schachter
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Este trabalho descreve o desenvolvimento de um Programa Computacional
para Projeto Estrutural de Mono Cascos Planadores, que permita a atuacao interativa
com o projetista, calculando e desenhando todos os elementos estruturais,
chapeamento e reforcos, utilizando como referéncia para calculo as regras da
sociedade classificadora American Bureau of Shipping ( ABS), “Guide for Building and
Classing High-Speed Craft” de Outubro de 2001”.

Para uma dada embarcagéo, o programa importa a forma geométrica,
compartimenta a mesma, calcula as pressdes locais impostas a estrutura, espessura
de chapeamento, elementos estruturais longitudinais e transversais, reforcos de
anteparas, momento fletor atuante ao longo da vida navio, médulo de sec¢éo e inércias
requeridas e oferecidas para as segdes da viga navio, aproxima as espessuras
calculadas para valores comerciais, verifica os elementos longitudinais em flambagem
e por fim calcula o peso e centro de gravidade da estrutura calculada.

O programa foi desenvolvido para trabalhar interativamente com o projetista
calculista, apresentando telas com operagbes faceis e compreensiveis. Os comandos
se resumem na escolha da acdo e obtencédo de resultados através de um simples
clique de mouse.

Depois de terminados os calculos estruturais o programa gera um relatorio,

apresentando os resultados de todos os calculos efetuados.
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This work describes the development of a computer program for Mono Hull
Planing Boats Structural Design, that allows the interactive action of the designer,
computing and drafting all structural elements, such as plates and stiffeners, based on
Classification Society American Bureau of Shipping (ABS), “Guide for Building and
Classing High-Speed Craft” of October 2001”.

For a given vessel, the program imports its geometry, allows for its
compartmentation, calculates local pressures imposed to the structure, plates
thicknesses, longitudinal and transverse structural elements, bulkheads stiffeners,
acting bending moment along the entire vessel, section modulus and inertias required
and offered for the vessel’s sections, approximates calculated plate thicknesses to
standard thicknesses, checks longitudinal elements for buckling stability and at the end
calculates the weight and center of gravity of the designed structure.

The program was developed to be interactively user friendly, with screens for
straight forward operation. The commands are designed for logical choices of action
and results, workable by simple mouse clicks.

At the end of calculations, the program generates a report with the results of

all calculations performed.
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1. Introducao

Ao iniciar-se um projeto, muitas solu¢des devem ser estudadas, para atender a

finalidade a que o objeto em estudo se propde.

Este trabalho em particular vai tratar do dimensionamento estrutural mais adequado
para estruturas de embarcagdes do tipo alto desempenho e em especifico, mono

cascos de planeio.

A tarefa, que a primeira vista pode parecer simples, na verdade € bastante complexa.
As formulacdes de calculo sdo extremamente trabalhosas, portanto a solugéo ideal é
dar ao projetista uma ferramenta de trabalho que permita calcular a estrutura de uma
embarcacdo mono casco em V de alta velocidade com maior qualidade, preciséo e

rapidez.

Um programa computacional denominado PARLA foi idealizado, com o conceito de
ser uma ferramenta amigavel e que atuasse interativamente com o projetista,

fornecendo respostas rapidas e precisas para o dimensionamento estrutural.

Por se tratar de um trabalho académico, muito ainda pode ser inovado e melhorado, e
o importante é notar claramente que programas computacionais altamente complexos
podem ser desenvolvidos e chegar ao mesmo nivel dos paises mais avancados em
tecnologia atualmente. Mais importante ainda é poder criar um banco de dados para a

tecnologia nacional.

A presente proposta, longe de competir com os programas mais avanc¢ados atuais, &
apresentar um Software para calculo estrutural de embarcagdes de alto desempenho,
e em especifico, mono cascos de planeio, apresentando simultaneamente a parte

grafica e os resultados de calculo.

O programa tem como referéncia para calculo as regras do ABS, “Guide for Building
and Classing High-Speed Craft — October 2001”[1], e foi desenvolvido para atuar de
forma interativa com o projetista, calculando e desenhando todos os elementos
estruturais, chapeamento e reforcos, de uma embarcagéo de alta velocidade tipo

mono casco de planeio.



A motivacao do desenvolvimento do referido programa vem da necessidade de dar ao
projetista ferramentas simples, eficientes, rapidas, competitivas de calculo estrutural, e
que o auxiliem na concepgdo, inovacdo e otimizagcdo estrutural baseado em

fundamentos tedricos.

Este projeto apresenta um passo adicional no desenvolvimento do sistema
computacional para embarcacgdes e plataformas, denominado SFD SYSTEM (Solution
— Focused Design System), cuja estruturacao € baseada em processos de projeto com
foco na solucado e interagbes multidisciplinares [2], que ja conta com varios moédulos,
definicdo de forma de embarcacdes [3] e para plataformas, definicdo da forma, célculo
das caracteristicas hidrostaticas (embarcagbes e plataformas), curvas cruzadas,
estabilidade, avaliacdo do comportamento em ondas de embarcagdes, equilibrio
dindmico (lanchas [4], aerobarcos, asas em efeito de solo e aerodeslizadores),
propulséo, etc. Foram citadas aqui apenas as referéncias das publica¢des utilizadas
neste trabalho. O software desenvolvido também evoluiu de um trabalho piloto e
simplificado de projeto estrutural de embarcagcbes de até 90m, também estruturado

para o sistema [5].

O Software PARLA tem sua estruturagdo inspirada no Solution Focused Design [2],
que para funcionar como programa, precisa ter arquivo Unico por projeto de
embarcacgbes com varias rotinas, minimo de telas multidisciplinares, e possibilidade de
qualquer sequéncia de processamento (entrada de dados sem dependéncia de outra
rotina anterior e posterior aproveitamento destes dados). Desta forma, parte da
geometria do casco que é importada de um arquivo do tipo”.SAI” (.txt) do programa
PHF [3]. Trabalhando interativamente em conjunto com o projetista, o software calcula
o chapeamento de todos os elementos do casco, fundo, convés, costado, anteparas,
superestruturas, chapeamentos internos em geral, refor¢cos estruturais comuns e
gigantes, apresentando simultaneamente uma visualizacdo grafica das solugbes
encontradas. Calcula também o médulo de se¢éo de viga navio e esforcos atuantes
em qualquer secao determinada pelo projetista, e a partir destes valores verifica a

estabilidade das chapas e perfis longitudinais em compresséo quanto a flambagem.

O Casco podera ser compartimentado a critério do projetista, e nestes casos o
programa PARLA calculara também as estruturas das divisérias, anteparas limites de

tanques e demais anteparas limites de acomodacdes.



Apbs o célculo das sec¢des requeridas pelo projetista, PARLA calcula o peso e centro
da embarcacdo e compara o modulo das secgbes previamente projetadas com os

valores minimos requeridos pela Regra.

E importante salientar que a maioria dos programas comerciais hoje referentes a
embarcagbes mono casco planadoras estdo focados para a arquitetura, formas e
estabilidade, resisténcia a propulsdo e seakeeping. O PARLA calcula a estrutura
apresentando seu modelo gréfico, calcula médulo e inércia de viga navio real e minimo
requeridos por regra, e da uma estimativa de peso e centro da embarcacgéo. O capitulo
4 apresenta comentarios adicionais sobre os softwares estruturais existentes no

mercado atual.

E muito importante salientar que se trata de um trabalho que dara resultados praticos,

servindo de base para um projeto de detalhamento construtivo.

“E fungdo do Engenheiro procurar solugbes simples para os problemas mais

complexos”

A principal contribuicdo do programa € dar agilidade de resposta para diferentes
solugcbes estruturais adotadas pelo projetista, em uma estruturacdo ergondmica
baseada na experiéncia em calculos estruturais, sendo ao mesmo tempo feito em
programa compativel com o sistema. Sua ergonomia foi projetada para permitir que se

opte tanto por calculos detalhados quanto simplificados nas mesmas instancias (telas).

A seguir, no desenvolvimento desta dissertacdo, os seguintes tdpicos serao

abordados:

O capitulo 2 apresenta uma revisdo da literatura e o conceito estrutural dos esforgos

aos qual uma embarcacéo do tipo mono casco de alta velocidade esta sujeita.

O capitulo 3 apresenta a conceituagéo tedrica de calculo baseado nas Regras do ABS,
para calculo de pressdes nas diversas areas da embarcacéo, calculo de espessuras

das chapas e dimensionamento dos refor¢os longitudinais e transversais.



O capitulo 4 apresenta a metodologia da pesquisa, softwares existentes no mercado e

o sistema operacional Delphi utilizado para elaboracao do software PARLA.

O capitulo 5 apresenta passo a passo os calculos desenvolvidos pelo programa
PARLA e seu manual de operacao descrevendo as varias telas com seus respectivos

comandos e objetivos de calculos.

O capitulo 6 apresenta os resultados de célculo representados graficamente de uma
embarcacdo de 39m em aco, da mesma embarcagcdo de 39m em aluminio e uma
embarcacédo de 12,20m em aluminio. As listagens de saida do PARLA estdo sendo
apresentadas nos Anexos A2, A3 e A4. O Anexo A2 apresenta as listagens de saida
do PARLA para a embarcacédo de 39m, considerando a utilizagdo do material agco, o
Anexo A3 apresenta as listagens com os resultados da mesma embarcacao
considerando material aluminio e o Anexo A4 apresenta os resultados de uma
segunda embarcagdo, menor, em aluminio, para demonstrar aplicagdes com mais de

uma embarcacéo e mais de um material.

O capitulo 7 comenta os resultados obtidos das embarcacgbes utilizadas como

exemplo.

O capitulo 8 apresenta um resumo desta dissertagdo com perspectivas futuras de

desenvolvimento e analise do resultado deste trabalho em especifico.

E por fim o capitulo 9 apresenta a bibliografia utilizada para elaboragdo desta

dissertacao.

2. Revisao da Literatura - Projeto Estrutural

21 Desenvolvimento das Regras

Fundada em 1862, pertencente ao grupo de classificadoras da IACS, a classificadora
American Burea of Shipping — ABS, tem o firme propdsito de promover segurancga a
vida humana e preservagédo das condigbes ambientais, através de desenvolvimento e
verificagcdo de padrbes de projeto, constru¢do e manutengdo operacional de

facilidades maritimas.



Com o proposito de atender a demanda da Industria, com o resultado de varios anos
de experiéncia, o ABS publicou pela primeira vez o “Guide for Building and Classing
High-Speed Craft” em 1990.

Para o desenvolvimento do “Guide”, o ABS formou varios comités em varios paises
assistidos por 6rgados cientificos locais. Apds pesquisa da literatura existente e
adicionando os devidos fatores de seguranga, apresentou ao mercado sua primeira
versao de Regras para dimensionamento de embarcagdes de alta velocidade para

uma variedade de materiais, tais como ago, aluminio e compdsitos.

Atualmente o “ABS Guide” para embarcacdes civis ja esta em sua atualizagdo datada
de Outubro de 2001, e o “ABS Guide” para embarcacdes militares teve a sua ultima

atualizacdo em 2007. Veja referéncias [1] e [9].

De modo a determinar as cargas apropriadas de projeto, o ABS elegeu trés equacdes
de pressbes atuantes na estrutura externa e interna para escolha do maior valor

calculado pelas mesmas.

211 A pressdo de fundo

Pb (“bottom pressure”) baseada na aceleragéo vertical da embarcacao foi derivada da
analise semi-empirica apresentada por Heller & Jasper (1960) [12] e Savitsky & Brown
(1976) [7].

2.1.2 A pressao de impacto
Pi (“impact pressure”) baseada no fator dindmico que depende do estado de mar foi

derivada do estudo analitico simplificado de Allen & Jones (1978) [11].

2.1.3 A pressao hidrostatica

Pd (“hydrostatic pressure”) foi equacionada como a coluna estatica igual ao pontal da
embarcagéo ao lado acrescida de 4 (quatro) pés e acrescida de 20% da presséo de
fundo Pb, derivada do trabalho de Herickson and Spencer (1982) [13].

Os dimensionamentos de conveses, superestruturas e casarias foram baseados na
experiéncia acumulada de outras embarcagdes de aco através de regras publicadas
anteriormente pelo proprio ABS. As tensdes admissiveis para todos os elementos
estruturais, painéis e reforcos internos, foram estipuladas a partir de projetos

consagrados historicamente.



2.2 Conceituagdo de uma embarcacgao de planeio

As embarcacgbes de alta velocidade estdo sujeitas aos movimentos dindmicos de
grande magnitude, gerando cargas hidrodindmicas, cargas de impacto e cargas

inerciais que devem ser resistidas pela estrutura.

Nas ultimas décadas grandes avangos tecnoldgicos ocorreram em todas as areas da
Engenharia, favorecendo o aparecimento de projetos arrojados na area de
embarcacgdes de alto desempenho, em particular para as embarcagdes mono casco de
planeio. Embarcacdes mais leves, com novos materiais e mais velozes requerem
estudos mais profundos de hidrodindmica, dos movimentos dinamicos em estado de

mar (seakeeping) e no dimensionamento estrutural.

A figura 2.1 abaixo apresenta a fotografia de uma lancha de planeio em movimento
sujeita aos esforgcos dindmicos e inerciais. Notar que a maior parte do comprimento

esta fora d’agua.

& e
g

Figura 2.1: Lancha Patrulha da Industrial Research Ltd

Embarcacbes de planeio e semi-planeio s&o aquelas que apresentam uma
sustentacdo hidrodindmica preponderante em relacdo a sustentacao hidrostatica, e
possuem uma configuracdo geométrica do casco que possibilita este efeito. O casco
apresenta um fundo plano, e a popa do tipo transom, de modo que o mesmo se

comporte como uma placa plana planadora a partir de uma determinada velocidade.

Estas embarcacdes deslizam sobre a superficie da agua, ao invés de serem

arrastadas através das mesmas como acontece com embarcagdes de deslocamento.



Sabe-se que a velocidade de uma embarcacgéo esta relacionada com seu tamanho ou
dimensdes. Portanto pode-se definir como parametro importante para esse estudo a

relacéo da velocidade com o tamanho da embarcacéo.

Para V em nés e L em pés, onde L € comprimento de linha d’agua, nota-se que para a

~ ¥ A . , .
relacéo de , =0,336 a resisténcia oferecida pelo casco é puramente friccional. A
]

partir de iI =:0,336 essa resisténcia de onda comeca a tornar-se importante. A partir
L

de 51 =1,20 a resisténcia de onda aumenta rapidamente e para é —1,34 a formacao

de ondas torna-se uma barreira para a velocidade para cascos de deslocamento, com
formas arredondadas. Uma embarcagédo de popa arredondada gera pressdes
negativas no fundo do casco, puxando a mesma para baixo e fazendo com que a proa

se levante e tenda a subir a crista da onda [4].

¥ - - . .
Para T =1,34 as formas do casco deverdo ser modificadas, com linhas do alto mais
<E

retas, com fundo formando uma placa plana e com a popa terminando em espelho reto

plano tipo transom.

Ja no caso de popa em forma de placa plana, uma pressao positiva aparece em toda a
superficie do fundo e o casco tende a se separar da agua, formando a conhecida
‘popa seca”. Para alcancar altas velocidades é necessario que haja a maior separacao
possivel do casco com a agua. Por este motivo podem ser dispostas quinas reversas
nos bojos com um ligeiro angulo para baixo (spray strip reversers ou spray rails) para

estimular a separacdo da agua também de suas laterais do fundo.

Para a faixa de 1,34 = ;I =3,0, aproximadamente, a embarcacao estara no regime de

semi-planeio.

¥ o . A
Para = =3,0 atingimos o planeio puro, a resisténcia ao avango passa a ser
L

dominantemente friccional (além da resisténcia de pressao e spray) dependendo da
area molhada, e a resisténcia de onda deixa de ser significativa. Portanto é desejavel
reduzirmos a superficie molhada, e termos as formas prismaticas, para que a

embarcacéo possa decolar e se manter em equilibrio dindmico apés a decolagem.



A figura 2.2 a seguir apresenta as distribuicdes de pressées ao redor de dois corpos
flutuantes com configuragdes geométricas diferentes. O primeiro representa uma

embarcacgéo de deslocamento e o segundo representa uma embarcacéo de planeio.

Figura 2.2: Distribuigdo de pressdes no fundo de dois

corpos flutuantes com diferentes geometrias.

A figura 2.3 abaixo mostra as formas de uma embarcacao de planeio tipica com V
profundo.

Figura 2.3: Forma geométrica tipica de uma

embarcacédo de planeio

Quando uma embarcacao inicia o planeio, uma boa parte de seu casco fica fora
d’agua, diminuindo consideravelmente a resisténcia de arrasto. Quando isto se da (a

¥ A , . A
= =1,34) as curvas de resisténcia se separam, ficando maior a resisténcia da
L

¥

embarcagcdo planadora. Em " =1,70, ocorre o chamado hump speed, elevagéo

instantanea da resisténcia devido a transicdo forte entre a coexisténcia do regime



residual de deslocamento e o inicio da dominancia do planeio, cuja estabilizagéo final

ocorrera em —= = 3,0.

A figura 2.4 abaixo, apresenta a comparagéo da resisténcia ao arrasto x v/T para
uma embarcagéo de deslocamento e uma embarcagédo com casco com forma de

planeio.

L

| embarcagdode
| deslocamento

I
I
I
l

/ casco com forma
de planeio

arrasto

VINL
Figura 2.4: Comparacao de resisténcia ao avanco entre

um casco de deslocamento e uma embarcagé&o de planeio.

Outras relagbes geométricas da embarcacdo com sua velocidade foram analisadas.
Vejamos; quando uma embarca¢ado comecga a planar, uma parte de seu comprimento
sai da agua, portanto o comprimento ndo € mais uma caracteristica tdo importante.
Savitsky e Brown [7] caracterizaram uma embarcacdo de deslocamento para o
adimensional coeficiente de velocidade (Cv), V/NgB<0.5, semi-planeio para
0.5<V/NgB<1.5 e planeio para V/NgB>1.5. J& a IMO(2000) [9] caracteriza as
embarcacgdes de planeio relacionando sua velocidade com seu volume deslocado, isto
€, uma embarcacgéo é considerada como planeio quando Vmax>3.7.V*".m/s, sendo
que “g” € a aceleragdo da gravidade, B a boca no espelho de popa e ¥V o volume

deslocado.

A tabela 2.1 apresenta um quadro comparativo dos limites de velocidade para

embarcacbes de deslocamento, semi-planeio e planeio.



Tabela 2.1: Limites de velocidade para embarcacdes de deslocamento,

semi-planeio e planeio

VAL Cv=% (adimensional) [7] |V (m/s)
L
Knot/./Ft

(m”s™)

Deslocamento | <1,34(1.25) <0.5 -

Semi-Planeio 1,34~3,0 0.5~1.5 -
(1.25 ~ 2.8)
Planeio 3,0 (2.8) >1.5 >3.7xv% "7

O ABS [1], considera embarcacbes de alta velocidade, as embarcagbes com

velocidade acima da velocidade de semi-planeio e como é usual das classificadoras,

adota um fator de seguranca para essa velocidade de semi-planeio, 1,3 knot/,‘f i

(2,36knot/+'m) ao invés de 1,34 knot/.[Ft. A figura 2.5 abaixo apresenta o grafico que
identifica a regido de abrangéncia da regra considerada neste trabalho, para

embarcacgdes. Essa regido de abrangéncia é toda a area superior do grafico.

30.0
250
20.0
15.0

10.0

YV emnos

50

0.0
0 M0 20 30 40 S50 60 70 80 90 100 110 120 130

L(m)

Figura 2.5: Grafico V x L — Limite de abrangéncia das formulagbes do ABS

para embarcagdes do tipo mono casco planadoras
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2.3 Conceituagdo dos Esforgos Atuantes

Um corpo flutuante esta sujeito a uma série de esforcos que deverdo ser resistidos

pela estrutura projetada.

A teoria convencional costuma considerar uma embarcagdo como uma viga e que é

denominada de “Viga Navio”. Esta esta sujeita aos seguintes esfor¢os:

Peso leve

Carga paga

Peso operacional

Cargas hidrostéaticas devido ao empuxo
Cargas hidrodindmicas devido as acelerag¢des

Cargas de impacto (slamming)

AN N N N N NN

Cargas provenientes de docagem e icamento

A carga hidrostatica ou o0 empuxo da embarcacgéo € a reagdo em cada secao da viga

navio, associada ao volume deslocado na respectiva segao.

O peso leve da embarcacao é proveniente do peso estrutural, equipamentos e pesos

localizados.

A carga paga como o nome ja diz, é a carga transportada pela embarcagao, que pode

ser matéria prima (6leo, gas, cimento, madeira, etc.) ou até mesmo passageiros.

O peso operacional esta relacionado aos itens de consumo que permitem que a

embarcacgéo navegue, isto é, 6leo diesel, 6leo lubrificante, etc.

Os carregamentos desses componentes ao longo da viga navio geram esforgos
solicitantes, tais como momento fletor longitudinal, momento fletor transversal,
momento torsor e esfor¢o cortante, que devem ser suportados pela estrutura, caso
contrario a embarcagdo pode partir e seus elementos estruturais podem entrar em
colapso. A figura 2.6 a seguir, apresenta os graficos dos esforgos atuantes na viga
navio qualitativamente para uma embarcacdo em &guas tranquilas com pequenas

velocidades sem efeito de sustentagao hidrodinamica.
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~ rgforco cortante
e

Y
e ‘f

~
distribuigsn de empien ,:‘ ’

mofmento fletor

Figura 2.6: Curvas tipicas para embarcacdes de planeio para baixas velocidades em

aguas calmas.

Os efeitos de flexdo da viga navio e efeitos de fadiga e vibragbes provenientes dos
esforcos estaticos e dindmicos atuantes na viga navio ndo podem ser ignorados,

entretanto sera objeto de outro estudo.

Uma embarcagdo quando parada, apresenta uma distribuicdo de pressao hidrostatica
ao redor do casco que cresce linearmente com a distancia do ponto abaixo da linha
d’agua, e é calculada pela expressdo Ph=pzg, onde p € a densidade do meio fluido, z
€ a distancia vertical do ponto até a linha d’agua e g € a aceleragao da gravidade. Ver

figura 2.7.

Figura 2.7: Distribuigdo de pressao hidrostatica no

fundo da embarcacgao
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Para uma embarcagédo em alta velocidade navegando em aguas calmas a distribuicédo

de presséo hidrostatica recebe uma componente adicional: a presséo hidrodinamica.

A figura 2.8 apresenta uma embarcacao com velocidade V em regime de planeio.

water ling

Figura 2.8: Vista de perfil e de uma secao para uma lancha de planeio com velocidade

constante.

A pressdo dinamica é proporcional a velocidade ao quadrado, isto é, P « V?, e sua
distribuicdo depende do angulo de pé de caverna (&), conforme apresentado nas
figuras 2.9 e 2.10.

Notamos nesta figura uma formacéao de spray no fundo do casco, mantendo as quinas
secas, quando a posicao longitudinal estiver localizada entre a e b, e molhadas
quando a posigao longitudinal estiver entre b e ¢, conforme indicado nas figuras 2.9 e
2.10.

(LT
formagdo dia
SOy

quiifa

Figura 2.9: Regiao do casco onde as quinas estdo secas
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Figura 2.10: Regido do casco onde as quinas estdo molhadas

A figura 2.11 apresenta a distribuicdo de pressao no fundo do casco para diferentes
angulos de pé de caverna. O valor de y/b(t), é a relagdo da posigéo transversal “y” em
relacdo a boca da embarcacdo “b”. A funcédo (t) denota que esta pressdo esta

associada a um tempo “t”.

A

B=10°

P
B=15°

__//1 B=20°

-

yh(t)

Figura 2.11: Distribuicdo de pressao para diferentes angulos de pé de

caverna para um instante t.

Quando a embarcagdo esta navegando em estado de mar diferente de zero, a
distribuicdo de pressbes ao redor do casco é similar a apresentada anteriormente.
Entretanto, a incidéncia de ondas na embarcacdo e sua oscilacdo vao afetar a
velocidade da embarcagdo assim como gerar aceleragdes de arfagem na mesma e

gerar pressdes de impacto.



24 Escolha do Material Estrutural

Varios fatores devem ser considerados para a escolha do material mais apropriado

para a construcdo de uma embarcacéo, tais como:
v' Peso
Corrosao
Facilidade para gerar formas geométricas diferenciadas
Facilidade construtiva
Custo inicial
Custo de manutengéo
Durabilidade
Resisténcia
Soldabilidade
Efeito de pilha galvanica
Disponibilidade do material no mercado
Resisténcia a fadiga
Resisténcia ao fogo
Invisibilidade ao radar
Vibracoes
Facilidade de reparo
Isolamento térmico

Isolamento ao som

N N N T N N N N N N N N N R NN

Resisténcia ao impacto

O tipo de embarcagédo, fungéo, local de operagdo e rota sdo fatores decisivos na
escolha dos materiais mais adequados que vao dar a embarcag¢ao as caracteristicas
de desempenho desejadas e capacidade de resistir aos esforgos locais e globais que

Ihe s&o impostos.
Todos os itens acima devem ser considerados no projeto, entretanto, para o caso

especifico de lancha de planeio, o menor peso leve da embarcagcdo tem uma

importancia bastante significativa.
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Uma grande variedade de materiais estruturais alternativos apareceu no mercado nos
ultimos anos. O projetista deve estar familiarizado com os constantes avangos

tecnolégicos de modo a oferecer ao Armador a melhor opgao.

O projetista deve ter uma mente aberta para investigar as diferentes possibilidades de
arranjos estruturais e diferentes materiais. O software que faz parte desta dissertacao
sera uma ferramenta muito Util, pois oferece condicbes de averiguar rapidamente

diferentes solugdes.

E importante notar que os diversos fatores de escolha devem ser ponderados e
avaliados em conjunto. O custo inicial alto pode ser a melhor proposta para um custo

operacional baixo, ou para uma receita maior.

Uma tabela de selecao de materiais para chapas e para perfis € apresentada no inicio
do programa PARLA. Acos comuns e de alta resisténcia, assim como varios tipos de
aluminio podem ser selecionados pelo projetista antes dos calculos. Embora materiais
compositos ndo fagam parte desta dissertacao, estes foram tabelados como um passo

inicial para a atualizagao prevista do programa, de calculos utilizando estes materiais.

25 Definigao do Projeto Estrutural

Uma embarcacgao deve resistir ao conjunto de esforgcos a que esta submetida, flexdo
da viga navio, pressdes locais, for¢as locais concentradas provenientes das fixagdes
do eixo (dos pés de galinhas), lemes, etc. Para embarcagbes pequenas (menores que
9m) os efeitos de viga navio podem ser ignorados. Entretanto, para embarcacdes
maiores, o efeito de flexdo de viga navio associado aos efeitos de slamming, que

ultrapassam em muito o empuxo local, é bastante significativo e deve ser investigado.

E muito dificil determinar a pressdo e as forcas resultantes do slamming. Elas séo
dependentes de muitas variaveis como, dimensdes, velocidade, forma do fundo casco,
forma das ondas encontradas, dire¢gdo das ondas em relagéo a embarcagéo. Para dar
um critério razoavel de calculo é necessario definir as pressdes de fundo e as
aceleragdes ao longo da viga navio provenientes do comportamento da referida

embarcagédo num determinado estado de mar.
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Os esforcos da viga navio poderdo ser determinados conhecendo-se os valores de
aceleracdes maximas experimentais, da distribuicdo de pesos e assumindo que a viga

navio se comporta como corpo rigido, isto € com deflexado da linha neutra desprezivel.

Para resistir aos esforcos acima, uma estrutura devera ser projetada para a

embarcacgédo em estudo.

Geralmente a estrutura é composta por um chapeamento, que atua como uma casca
de ovo que da a forma ao casco e serve de abrigo para a carga a ser transportada.
Essa forma é responsavel pelo desempenho em estabilidade e propulsivo desejados.
Internamente anéis transversais sdo dispostos, 0s quais se apoiardo nas longarinas
gigantes (quilhas, sicordas, escoas, etc.), e estas por sua vez se apoiardo nas
anteparas transversais ou outro elemento estrutural que garanta a rigidez necessaria

de apoio.

E pratica usual para estes tipos de embarcacdes, projetar elementos longitudinais com
a finalidade de dividir o chapeamento em pequenos painéis, reduzindo a espessura e
dando-lhes maior resisténcia a flambagem para os esforcos de compressao

provenientes da flexdo da viga navio.

As anteparas s&o projetadas para suportarem os esforcos de reacdes das longarinas

gigantes, e da presséo hidrostatica devido a coluna de liquido que lhe é imposta.

Os conveses devem ser projetados para funcionarem como a flange superior da viga
navio, resistindo aos esforcos solicitantes que lhe sdo impostos e as cargas neles

aplicadas, concentradas ou distribuidas.

Os calculos envolvidos no projeto estrutural de uma embarcacdo sdo muito
complexos, trabalhosos e demorados, onde mesmo com a utilizacdo de softwares
consagrados para calculo, como por exemplo, elementos finitos, os dados de entrada,
condicbes de carregamento e condigcbes de contorno apresentam uma dificuldade

consideravel mesmo para os projetistas mais habituados a esse tipo de analise.

As formulagdes das classificadoras, empirico-tedricas simplificam um pouco os
calculos necessarios, entretanto, nem sempre essas formulagdes séo simples, faceis e

rapidas de serem aplicadas. Muitas equagdes apresentam muitas variaveis, e estas

17



por sua vez sdo obtidas através de outras equacdes, também trabalhosas. As

possibilidades de erros por parte do calculista sdo bastante elevadas.

Com a finalidade de reduzir o tempo e erros nos calculos, o software PARLA foi criado
para auxiliar o projetista. Através de um simples clique sobre o elemento estrutural, o
software realiza todos os calculos necessarios, dando as respostas finais necessarias

de projeto ao projetista.

E importante salientar que ao iniciar-se o projeto de uma embarcagéo, os elementos
estruturais da sec¢do da viga navio ndo sao conhecidos e, portanto, o médulo de
secao, assim como as tensdes atuantes no mesmo, também n&o sao conhecidos. Fica

o impasse:

“Quem nasceu primeiro o ovo ou a galinha?”.

Sem definigdo da estrutura, ndo ha médulo de segéo da viga navio, e sem moédulo de
secao de viga navio, as tensbes atuantes nos elementos estruturais sao

desconhecidas.

As formulacdes da classificadora dao a primeira aproximacdo dos elementos
estruturais, e com estes valores é possivel calcular o médulo de se¢éo da viga navio e

obter as tensdes atuantes nos elementos estruturais previamente calculados.

O software PARLA, ap6s calcular a estrutura e o médulo de secao, informa quais
elementos estruturais devem ser modificados através da analise quanto a flambagem

dos mesmos.

2.6 Compartimentagem Estrutural

A partir das formas que serdo importadas de um arquivo texto tipo .SAI, do programa
PHF [3], a embarcacéo podera ser compartimentada através de simples comandos de

clique sobre os contornos do compartimento.

O projetista podera compartimentar tanques, definir posi¢cdes de anteparas, divisorias

estruturais em geral, e até mesmo sec¢des da superestrutura. Quanto maior o nimero
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de informacgdes fornecidas, maior sera o banco de dados criado sobre a embarcacao

em estudo.

Quando o projetista estiver posicionando as anteparas transversais, o software
PARLA alerta sobre a faixa de localizagdo permissivel da antepara de coliséo,

deixando a critério do projetista a escolha da posicao final da mesma.

E importante salientar que a compartimentagem devera satisfazer também aos

critérios de estabilidade preconizados pelas Normas IMO [15] e Solas [19].

A compartimentagem devera satisfazer os critérios de estudo de estabilidade em
avaria, quando requerido pelas normas acima. Esse estudo n&do esta no escopo do

presente trabalho.

“Vocé sabe que encontrou a solugdao do problema quando vocé alcangou a

simplicidade do equacionamento matematico e geométrico do mesmo”

2.7 Analise por Elementos Finitos
Com o avango das ferramentas computacionais, e principalmente considerando-se
uma maior facilidade de se trabalhar com elementos finitos, as Classificadoras tém

optado gradativamente para solugbdes mais teéricas e menos empiricas.

Deve-se ter muita atencado para as limitagbes das formulagbes apresentadas nas

Regras do ABS [1] e [9]. As mesmas sao aplicaveis para embarcag¢des construidas em
aco, aluminio ou materiais compdsitos (FRP), com :'—;>2,36 knot/~{m (>1,30 knot/,\.-'ﬁ) e
para mono cascos (tema desta dissertacdo) com comprimento néo superior a 130m.

Uma analise direta complementar para demonstrar a adequacdo da estrutura é

requerida quando a embarcagao;

v For construida de ago ou aluminio com mais de 60m de comprimento,

\

For construida em material compdésito com mais de 50m,

v Quando a velocidade operacional exceder 50 nés

A andlise direta devera utilizar um programa computacional de elementos finitos
reconhecido, e as condicbes de contorno e carregamentos deverdo refletir as

condigdes operacionais da embarcagao.
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Os seguintes dados deverao ser considerados para analise direta:

v' Altura significativa de onda e periodo;

v Tipo de ondas encontradas na regido de operacgao;

v Velocidade operacional;

v Condigdes de mar para operagao;

v’ Cargas de impacto de onda na proa, na popa, no fundo;

v' Andlise de movimento da embarcacdo (RAOs - Response
Operators),

v' Peso leve;

v Peso operacional;

v Etc.

Amplitude

Os modelos adotados com seus carregamentos deverdo ser representativos da

embarcacéo.
3. Calculo tedrico conforme regras do ABS
31 Limitagdes para emprego das formulagoes

Limitacdes para aplicacédo das regras do ABS:
Aplicabilidade: Embarcacgbes de Alta Velocidade
Materiais: Aco, Aluminio e FRP

VAL >2.36 nos/s™

L<130m (para o caso de mono cascos planadores)

3.2 Formulagdes de calculo pelas regras do ABS “Guide for Building and

Classing High-Speed Craft — October 2001” [1]

3.21 Geral

Através de formulagdes empirico-tedricas, o ABS apresenta os esforgos atuantes da

Viga Navio devido ao efeito de onda, distribuicdo de pressdes para todas as

superficies estruturais da embarcagéo, e a partir destes valores sdo dimensionados

todos os elementos estruturais. As formulacdes apresentam margens de seguranca

embutidas de modo a prever as incertezas das formulagdes teoricas, dos processos

construtivos, do material, da corroséo, etc.
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As regras ddo ao projetista seguranga, por serem baseadas em experiéncias de
muitas embarcagdes ja construidas. As mesmas permitem também a escolha de
diferentes materiais desde que os mesmos tenham um historico de desempenho

aceitavel.

3.2.2 Definigées

a. Velocidade
Velocidade ¢ a velocidade de projeto em nds na qual a embarcag¢do navega avante na

sua maxima rotacado continua RPM na linha d’agua de projeto

b. Embarcacéo de passageiros

E uma embarcac&o que transporta mais de 12 passageiros

C. Embarcacéo de carga
E uma embarcacdo, outra que a embarcagdo de passageiros, que & capaz de manter
as principais fungbes dos sistemas de seguranca, ap6s avaria de qualquer

compartimento exceto o avariado.

d. Local de Refugio
E um local abrigado naturalmente ou artificialimente onde a embarcacdo pode ser

abrigada no caso em que a embarcacao se encontrar em condi¢des inseguras.

e. Comprimento

L é a distancia medida na linha d’agua de borda livre, entre as partes extremas
moldadas da roda de proa até a madre de leme. Conforme regras do ABS [1], L ndo
pode ser inferior a 96% e n&o precisa ser superior a 97% do comprimento medido na
linha d’agua de borda livre, tomando as interse¢des moldadas da linha d’agua com a

roda de proa e espelho de popa.

f. Boca

B € a maior boca moldada medida ao longo de L
g. Pontal

D é o pontal moldado, medido a meio comprimento de L, a partir da linha de quilha até

o topo do convés de borda livre ao lado.
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Para embarcagdes com rabeta estrutural construida (ndo se refere a apéndices), D

deve ser medido a partir da linha da rabeta.

Nos casos em que as anteparas estanques se estendem acima do convés de borda
livre, convés este que sera denominado convés das anteparas, e se este convés puder
ser considerado efetivo na conceituagdo de viga navio, D devera ser medido até o

convés das anteparas.

h. Calado de escantilhdes
d é o calado, medido a meio comprimento de L a partir da linha moldada de quilha ou

linha de rabeta no seu ponto mais baixo, até a linha d’agua de borda livre.

i Convés de Borda Livre
O convés de borda livre € normalmente o convés continuo mais alto, com meios

permanentes de fechamento estanque de todas as aberturas expostas.

j- Convés de Anteparas
O convés de anteparas é o convés mais elevado para o qual as anteparas se

estendem de modo efetivo.

k. Convés resistente

E o convés que forma a parte superior efetiva da viga navio.

l. Convés de Superestrutura
Convés de Superestrutura € um convés que fica acima do convés de borda livre, € no

qual as chapas do costado n&o estao para dentro mais que 4% do valor da boca, B.

m. Superestrutura
Superestrutura é uma estrutura fechada no convés exposto ao tempo, tendo as suas

laterais nao fixadas mais que 4% da boca B para da extremidade externa do casco.

n. Casarias
E uma estrutura fechada acima do convés de borda livre situada para dentro de 4% da

boca B da extremidade externa do casco.

o. Deslocamento

E a massa deslocada da embarcacéo na condicdo de projeto
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p. Arqueacao Bruta
E a medida do volume dos espacos internos da embarcagdo como definido pela

Convencéao de Arqueacgdo de Embarcacbes, 1969

qg. Altura Significativa de Onda
Altura significativa de onda é a altura média de um terco das maiores ondas

significativas medidas em um determinado periodo de um estado de mar.
3.2.3 Pressoes de projeto
3.2.31 Pressao no fundo

A pressdo minima de projeto para a estrutura de fundo, em uma dada posicao, devera
ser o maior dos valores a) ou b) dado pelas equacgdes abaixo. As pressbes de projeto
sdo dependentes do servico no qual a embarcacao opera, e para tanto é definido um

fator de servico conforme tabela 3.1

a. Pressao de slamming do fundo

Hgd

Wl TP
Fb.’i.’f = LBy [-L + n;{;{][ﬂ:] I:D (tf/mz)

para embarcagbes menores que 61m de comprimento, ppxx Pode ser calculado pela

formula abaixo:
M
Powx =T ¢ [l + n';'!.]FDF"f (tf/m?)

b. Pressao hidrostatica

Ps=N3(FsH+d) (tf/m?)
Pucg = pressao de projeto do fundo no LCG ( tf/m?)
Puxx = presséo de projeto no fundo para qualquer segéo (tf/m?)

P4 = press&o hidrostatica de projeto (tf/m?)

23



Ncg = média de aceleragédo das 1/100 maiores aceleragdes verticais no LCG,
correspondente ao estado de mar em consideracdo em g's. g’'s sdo valores
adimensionais da raz&do da aceleragéo para a aceleragéo gravitacional no nivel do mar

(9,8m/s?), e que podem ser chamados de fatores de carga.
b

FE B
':'!:] & gs

-

B

Ncg=N2[ + 111[5":[_ E’

n,= média de 1/100 da maiores aceleragdes, para qualquer segéo diferente da segéo

do LCG, em g’s. Pode ser determinada da seguinte forma:

nxx = 5l

i P
LT
(& v

L]

N,= 0,01

N,= 0,0078

N;=1

A = deslocamento na linha d’agua de projeto (Kgf)

Lw = comprimento da embarcacgéo na linha d’agua com a mesma no deslocamento de
projeto (m)

Bw = boca maxima na linha d’agua (m)

H = parametro de onda, 0,0172L + 3,653 (m)

h, s = altura significativa de onda para o estado de mar em consideragao, geralmente
ndo inferior a Lw/12 exceto para servigo de operagéo restrito conforme tabela 3.1(m)

1 = trim na velocidade V, em graus, mas ndo menor que 4° para L<50m e ndo menor
que 3° para L<125m. Consideragbes especiais poderdo ser tomadas para valores de
projeto previstos em teste de modelos.

B.g = angulo de deadrise na se¢é@o de LCG, em graus, geralmente ndo menor que 10°
nem maior que 30°

B.. = angulo de deadrise em qualquer secao, em graus, geralmente ndo menor que
10° nem maior que 50°

V= velocidade de projeto da embarcagcdo em nds, geralmente a velocidade maxima
em aguas tranquilas, considerando a velocidade requerida para a maxima aceleracao
vertical. A velocidade de projeto podera variar com a altura significativa de onda
prevista no manual de operacao.

Fp= fator de area de projeto dado na figura 3.2 para dados valores de Ap e Ar.
Geralmente ndo podem ser inferiores a 0,40.

Ky= fator de distribuigéo vertical de aceleragéo dado na figura 3.3

Fy= fator de distribuicéo vertical de aceleragcado dado na figura 3.4
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Ap= area de projeto, cm?®. Para chapas Ap é a area do painel ndo superior a 2s°. Para
reforcadores longitudinais, transversais gigantes é a area do painel suportada por
longitudinais, transversais ou gigantes; para transversais e gigantes a area a ser
utilizada ndo pode ser menor que 0,331°.

Ag = area de referencia, cm?, 6,954 /¢ cm?

S = espagcamento de longitudinais ou reforgadores (cm)

I = comprimento dos longitudinais entre suportes, gigantes

d = calado com a embarcagéo parada, (m), distancia vertical da superficie externa
medida na linha de centro na linha d’agua de projeto a meio navio, mas n&o inferior
que 0,04L.

Tabela 3.1: Fator de servigo em funcao da area de operacgéo

Area de operacdo Altura significativa de onda Fs

Servigo sem restricao by ad 1

Servigo restrito 3,58 hy 5 =4 0,8
2,5% by 5 35 0,7
0,55 by 55 2,3 0,5

3.2.3.2 Pressao no costado e espelho de popa

A pressao de projeto, Ps, ndo deve ser menor que os valores dados pelas equacdes

abaixo:

a. Presséo de s/amming

b. Presséo hidrostatica

Py=Ns(FsH+d-y) (tf/m?)

C. Pressao na regido de proa

Psf=0,28FsCrl; (0,22 + @15 tan a){04Van i+ 0.6, T (tf/m?)
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Onde:

N4, N3, &, Lw, V, Ny, Bcgs H, d € Fp como definidos em 3.2.3.1

B.,= boca maxima na linha d’agua (m)

Bxx = angulo de caverna em qualquer secdo fora do LCG, em graus, € néo
pode ser menor que 10° nem maior que 70° (graus)

Psxx = pressao de projeto no costado para qualquer segao fora do LCG (tf/m?)

ps = pressao de projeto devido a efeito hidrostatico, (tf/m?), e que ndo pode ser inferior
aos seguintes valores (tf/m?)

= 0,05N;L (tf/m2) abaixo de 1/15 acima da linha de base ou para qualquer altura acima

da linha de base avante de 0,125L da proa

= 0,033 NsL (tf/m2) acima de 1/15 acima da linha de base, a ré de 0,125L da proa
Psf = pressao de projeto de costado avante de 0,125L da proa

y= distancia acima da linha de base, m, para , na localizacao considerada

L= comprimento da embarcagdo como definido na secdo 3.2.2, geralmente néo pode
ser tomado menor que 30m
Fs = fator dado pela tabela 3.1
Ck= 0,0125L para L< 80m

=1 para L=80m
a = angulo de costado, angulo entre a linha vertical e a tangento ao costado, medido
num plano vertical a 90° da tangente horizontal do costado.

2 = angulo de entrada, angulo entre a linha longitudinal, paralela a linha de centro e a

tangente horizontal ao costado

N.x- aceleracédo média vertical na localizagdo sob consideracdo conforme definido em
3.2.31

3.2.3.3 Pressiao no convés

As pressbes de projeto, Py, sdo as dadas na tabela 3.2

Sendo que:

W= carga de convés em tf/m?

nu- aceleracdo média vertical na localizagéo sob consideragéo conforme definido em
3.2.31

c=0,715
h = altura de compartimento fechado, espa¢o de maquinas, etc.. (m)

L= comprimento da embarcacéo conforme definido em 3.2.2
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Tabela 3.2: Pressao de projeto para conveses

Localizagéo tf/m?

Convés de borda livre exposto, e convés de superestrutura | 0,20L +0,77
avante de 0,25L

Convés de borda livre dentro de superestruturas, convés de | 0,10L + 0,62

superestrutura a ré de 0,25L, conveses internos

Conveses de acomodagdes internos 0,5
Carga concentrada em conveses W(1+ 0,5 ny)
Conveses internos de paidis, espagcos de maquinas , etc. ch(1+ 0,5 ny )

Notas: 1) Carga concentrada nos conveses € dada em tf

3.2.3.4 Pressao em superestrutura e casarias

As pressbes de projeto de superestrutura e casarias, Pq4, sdo as dadas na tabela 3.3

Tabela 3.3: Pressées de projeto de superestrutura e casarias (tf/m?)

Localizacao L=12,2m | L= 30,5m
Chapa da frente de superestrutura e casarias 2,46 3,87
Reforcos da frente de superestrutura e casarias 2,46 2,46
Chapas da parte lateral e traseira de superestrutura e | 1,05 1,41
casaria

Reforcos da parte lateral e traseira da superestrutura e | 1,05 1,05
casaria

Topo de casaria, chapas e refor¢os da parte dianteira 0,7 0,88
Topo de casaria, chapas e reforcos da parte traseira 0,35 0,7

Nota: Para embarcagdes entre 12,2 e 30,5m, a pressao de projeto devera ser obtida
por interpolagao .

L= comprimento da embarcagéo como definida em 3.2.2
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3.2.3.5 Pressdao em anteparas estanques limites de tanques

A presséo de projeto para anteparas estanques ndo deve ser menor do que o dado

pela seguinte equacéo:

PT = Nsh (tf/m?)
N; =1
h = a maior das distancias em m de um ponto mais baixo do painel ou centro da area
suportada pelo reforcador, até:
a. Um ponto localizado acima do topo do tanque, até uma distancia a 2/3 da altura
do topo do tanque até o topo do transbordo
b. Um ponto localizado a 2/3 da distancia até o convés exposto
c. Um ponto localizado acima do topo to tanque nao inferior ao maior dos valores
a sequir:
¢0,01L +0,15 (m)
¢ 0,46 (m)

Onde L é o comprimento da embarcagdo como definido em 3.2.2

Notas:
o As alturas dos transbordos deverao ser definidas para o calculo
o Estes calculos n&o sao aplicaveis a tanques pressurizados

3.2.3.6 Pressao em anteparas estanques (nao limites de tanques)

A pressao de projeto para anteparas estanques (ndo tanques) ndo devera ser inferior

ao valor dado pela seguinte equacao:
P.=Nsh (tf/m?)
N3 =1

h = distancia em m do ponto mais baixo do painel ou centro da area suportada pelo

reforcador até o convés de anteparas na linha de centro.
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3.2.4 Calculo de espessuras de chapas

As espessuras das chapas, conveses, anteparas, costado, etc., serdo verificadas
através das equacdes, 3.2.4.1, 3.2.4.2 e 3.2.4.3 abaixo, considerando-se o maior valor

calculado:

3.2.4.1 Calculo de espessuras de chapas devido a pressido normal sobre a

mesma

)
:I.pk

] 1C00ca

t= espessura do elemento calculado (mm)

s= espacamento dos refor¢cos na chapa (mm)

p= pressao de projeto atuante na chapa calculado conforme 3.2.3 (tf/m?)
k= razao de aspecto do painel, dado na tabela 3.4

0,= tensao de projeto (kgf/mm?) dado na tabela 3.5

Tabela 3.4: Coeficiente de razédo de aspecto para chapas isotrépicas

/s Kk k1
>2 0,5 0,028
2 0,497 0,028
1,9 0,493 0,027
1,8 0,487 0,027
1,7 0,479 0,026
1,6 0,468 0,025
1,5 0,454 0,024
1,4 0,436 0,024
1,3 0,412 0,021
1,2 0,383 0,019
1,1 0,348 0,017
1 0,308 0,014

Nota : s= medida do lado mais curto do painel

|I= medida do lado mais comprido do painel
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Tabela 3.5: Tenséo de projeto, @z, Aluminio e Ago (referéncia para chapas)

tensao de projeto,

Ca

e topo

Fundo e Costado abaixo do convés de anteparas com 0,9 oy
efeito de slamming

Fundo e Costado abaixo do convés de anteparas 0,4 oy
sujeito a pressao hidrostatica

Costado acima do convés de anteparas — com efeito 0,9 oy
de slamming

Costado acima do convés de anteparas — pressao 0,5 oy
hidrostatica

Chapa do convés — convés resistente da viga navio 0,6 oy
Chapa do convés — conveses inferiores 0,6 oy
Chapa de conveses expostos 0,9 oy
Anteparas de tanques estanques 0,6 oy
Anteparas divisérias 0,9 oy
Superestrutura e casarias — frente, lado, extremidades 0,6 oy

Nota: oy = tensdo de escoamento do acgo ou aluminio soldado em Kgf/mm2

3.2.4.2 Verificagao de resisténcia a flambagem

1. Tensao de flambagem no regime Elastico
0= 0,9mE(2)?

o.= tensdo elastica de flambagem (kgf/mm?)

m=4,0 (para estrutura longitudinal)

m= C,[1+ (%)2]2 (para estrutura transversal)

E= 21000 (kgf/mm?) para ago

E= 7000 (kgf/mm?) para aluminio

tb= espessura da chapa (mm)

s = lado mais estreito do painel (mm)

I= lado mais comprido do painel (mm)

C,= 1,21 para refor¢cadores tipo T ou Cantoneira
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= 1,10 para perfil bulbo
= 1,05 para perfil tipo barra chata

2. Tensao critica de flambagem
A tenséo critica de flambagem é determinada pelas seguintes formulagdes:
o= Og quando 00,50,

oc=0y(1-f‘;—E) quando 0g>0,50,

o,= tenséo de escoamento do material (kgf/mm?)

o= tensao de flambagem do elemento conforme 3.2.4.1-1(kgf/mm?)

3. Tensao de compressao atuante

A tensdo de compressao atuante nos elementos de chapa devido ao efeito de flexao

da viga navio é dada pela seguinte equacéo:

cBlFelimaeny

0d=—F7 (kgf/mm?)

0.= tensdo de compressdo no painel considerado, (kgf/mm?), mas geralmente n&o
iR

menor que fp )

Onde;

F<= valor dado na tabela 3.1

cs= 10°

M,,= momento devido a onda (tf-m)

M,,,= momento devido a aguas tranquilas (tf-m)

Y= distancia vertical do elemento considerado a linha neutra (m)
I= momento de inércia da viga navio (cm*)

Fp= 24 kgf/mm?

SMg= mébdulo de secdo de viga navio requerido (cm?m)

SMa= mddulo de secdo de viga navio na posicdo em estudo (cm?m)
4. Tensao admissivel de flambagem

A tenséo de flambagem do painel, conforme calculado em 3.2.4.2 - 2 deve ser tal que

O-CZ Oa
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3.2.4.3 Verificagao de espessuras minimas

As espessuras minimas das chapas dos conveses e anteparas ndo podem ser

inferiores as obtidas nas seguintes equacdes:

1. Fundo

ts=0,444FL +2 (mm)

tal=0,7+4FL +1 (mm)

ts = espessura minima para casco de ago, entretanto nao pode ser menor que 3,5mm

tal = espessura minima para casco de aluminio, entretanto ndo pode ser menor que

4mm

L= comprimento da embarcacéo conforme definido em 3.2.2

L E
()
ny= 24 kgf/mm?
y= tensdo de escoamento minima do material (kgf/mm?), mas ndo pode ser tomada
inferior a 0,7U ou 52 Kgf/mm? o que for menor.
U= tens&o minima de ruptura do material empregado (kgf/mm?)
e=1 para vy =24Kgf/mm?

=0,75 para y =24 kgf/mm?

2. Costado

ts=0,4+/EL +2 (mm)

tal=0,624KL +1 (mm)

ts, tal e L definidos acima. Entretanto
ts minimo= 3,0mm

tal minimo= 3,5mm

3. Convés resistente da viga navio
ts=0,4+KL +1 (mm)
tal=0,62+KL +1 (mm)

ts, tal e L definidos acima. Entretanto,
ts minimo= 3,0mm

tal minimo= 3,5mm
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4. Conveses inferiores, anteparas comuns e anteparas de tanques
ts=0,354KL +1 (mm)

tal=0,52'KL +1 (mm)

ts, tal e L definidos acima. Entretanto,

ts minimo= 3,0mm

tal minimo= 3,5mm

5. Regides especiais, sujeitas a impactos e vibragées
A espessura da chapa devera ser majorada em 50% nas regides de rabeta, pés de

galinha, tubos de escovem, etc.

3.2.5 Estrutura de Reforgo nas chapas (elementos estruturais internos)

3.2.51 Geral
Ver item 3.2.8

3.2.5.2 Resisténcia estrutural dos reforgos

a. Médulo de secao

O modulo de secdo dos elementos estruturais, vaus, cavernas, prumos, cavernas
gigantes, escoas, sicordas, e elementos estruturais em geral devem ser calculados

pela seguinte expressao:

%
SM= sl cm3
Sa

p= pressao de projeto em tf/m?dado em 3.2.3
s= espagamento dos reforgos, longitudinais, prumos, gigantes, etc. (m)
I = comprimento dos reforgos entre apoios (m)

(quando houver borboletas nas extremidades, favor referir-se a fig.3.1)
a,= tensao de projeto, conforme tabela 3.6 (kgf/mm?)

Nota: reforcos em anteparas ndo estanques poderdo ser isentos de ligagbes nas

extremidades desde que o médulo de segéo seja majorado em 50%
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| (comprimento dos reforgos)

Figura 3.1: Ligag6es de reforcos com Borborletas

Tabela 3.6: tens&o de projeto T, (referéncia para reforcos)

Localizagéo Ago ou | FRP
Aluminio

Longitudinais de fundo — presséo de slamming 0,65 oy(1) 0,33 ou
Longitudinais de fundo — presséo hidrostatica 0,55 oy(2) 0,33 ou
Longitudinais de costado — presséo de slamming 0,60 oy 0,40 ou
Longitudinais de costado — pressé&o hidrostatica 0,50 oy 0,40 ou
Longitudinais de convés — convés resistente 0,33 oy 0,40 ou
Longitudinais de convés — outros conveses 0,40 oy 0,40 ou
Transversais de fundo— pressao de slamming 0,80 oy 0,33 ou
Transversais de fundo — presséao hidrostatica 0,50 oy 0,33 ou
Transversais de costado — presséo de slamming 0,80 oy 0,33 ou
Transversais de costado — pressao hidrostatica 0,50 oy 0,33 ou
Transversais de convés — convés resistente 0,75 oy 0,33 ou
transversais de convés — outros conveses 0,75 oy 0,33 ou
Anteparas simples 0,75 oy 0,50 ou
Anteparas estanques 0,60 oy 0,33 ou
Superestrutura e casaria 0,70 oy 0,33 ou

oy = tensdo minima de escoamento (kgf/mm?)

(efeito de solda ja considerado para aluminio)

ou = tenséo de ruptura (kgf/mm?)
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Notas:

1) Embarcagées com menos de 50m
2) Embarcacdées com comprimento superior ou igual a 50m
b. Momento de Inércia

O momento de inércia de cada longitudinal, prumo, gigante transversal e gigante
longitudinal, incluindo a chapa colaborante, ndo deve ser inferior ao valor apresentado

na seguinte equacao:

IZ".‘EEF:'.:
kLE

cm®
p,s e | ja definidos em 3.2.3
k4=
=0,0015 para gigantes de costado e tanques estanques, escoas e transversais
gigantes construidos de aco;
=0,0011 para gigantes de convés e transversais construidos de aco;
=0,0021 para escoas de costado e tanques estanques e gigantes transversais
construidos de aluminio;
=0,0018 para gigantes de convés e transversais construidos de aluminio.
E = modulo de elasticidade representativo do momento de inércia calculado
(kgf./mm2)

3.2.5.3 Flambagem

O momento de inércia das longitudinais do convés, costado e fundo com suas

respectivas chapas colaborantes devem obedecer aos critérios abaixo:

a. Tenséao de flambagem elastica
El:
Jg = Cgal”

oy = tensdo elastica inicial de flambagem (kgf/mm,)
E= 2100000 Kgf/mm; para ago
I, = momento de inércia dos longitudinais incluindo chapa colaborante (kgf/mm;)

C; = 1000
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A = area da secao do longitudinal incluindo a chapa colaborante (cm;)

I= vao do longitudinal em m

b. Tenséo critica de flambagem
A tensao de flambagem critica em compressao é determinada da seguinte forma:
o.= oE quando 0g=<0,50,

oc=0y(1-f‘;—E) quando 0g>0,50,

o,= tenséo de escoamento do material (kgf/mm?)

o= tensao de flambagem do elemento conforme 3.2.5.3.a (kgf/mm?)

C. Tensao de compressao atuante

ga= _ﬂ;f‘hv;q“vwah{ (kgf/mm2)

0.= tensdo de compressdo do painel considerado, (kgf/mm?), mas geralmente n&o

menor que:

[l

&R
L, —

— (kgf/mm?)
Fs= valor dado na tabela 3.1

cs= 105

Mw= momento devido a onda (tf-m)

Msw= momento devido a aguas tranquilas (tf-m)

Y= distancia vertical do elemento considerado a linha neutra (m)
I= momento de inércia da viga navio (cm*)

C1= 24 kgf/mm?

SMg= modulo de segdo da viga navio requerido (cm?m)

SMa= modulo de secdo de viga navio na posicdo em estudo (cm?m)

d. Tenséao de flambagem de projeto
A tenséo de flambagem de projeto, @, = Bo,
£ =1,0 para a alma dos refor¢cadores

=1,1 para os refor¢gadores

3.254 Espessuras

As espessuras das almas e flanges dos elementos estruturais ndo devem ser menores

que o determinado pelas seguintes equacoes:
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a. Almas

t= c \I!'I:l.i (mm)

t = espessura total requerida (mm)
dy= altura da alma (mm)
C =70 para elementos de acgo

= 50 para elementos de aluminio

7, = tensdo minima de escoamento para ago ou aluminio (kgf/mm?)

gs = para elementos de aco : 24 (kgf/mm?)
= para elementos de aluminio: 12,76 (Kgf/mm?)

A alma também nao podera ser inferior a:

_ loogpel
3nd Ty

t

t = espessura requerida (mm)

p = pressao de projeto (tf/m?)

s= espagamento entre reforgos do painel (m)
| = comprimento do elemento estrutural (m)
dw = altura da alma (mm)

r. = tensdo de cisalhamento de projeto (kgf/mm?)

b. Barras face e flanges

I o
t==— |== (mm)
c ) Fd

t = espessura total requerida (mm)
d,, = altura da barra face ou largura do flange
C= 12 para elementos de ac¢o
= 9 para elementos de aluminio
a, = tens&o minima de escoamento do ago ou aluminio para material néo soldado
o, = para elementos de aco: 24 ,00(Kgf/mm2)

= para elementos de aluminio: 12,76 (Kgf/mm2)

3.25.5 Fixacdes

A peca estrutural de conexdo dos longitudinais com transversais deve ter uma solda

nao inferior a dada pelas seguintes equacgdes:
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_ 1E00gsl

B T (mm2)

ay=ty X Iy

tw = garganta da solda (mm)

lw = comprimento total da solda (mm)

p = presséo de projeto (tf/m?)

s = espacamento entre reforcos do painel (m)
I = comprimento do reforgo (m)

1, = tensdo de cisalhamento de projeto (kgf/mm?)

Tabela 3.7: Tens&o de cisalhamento de projeto 1,

Localizagao Aluminio | Ago

Elementos primarios do fundo — press&o de slamming 0,756 1. | 0,757,
Elementos primarios do fundo — pressao hidrostatica 0,50 7. 0,50,
Elementos primarios do costado — pressao de slamming 0,50 7,,. | 0,50,
Elementos primarios do costado — presso hidrostatica 0,50 7. | 0,50r,
Elementos primarios do convés 0,50 .. | 0,50r,

T... = tensdo minima de escoamento em cisalhamento para material soldado

1. = tensdo minima de cisalhamento para material néo soldado

3.2.5.6 Analise direta de tensoes

a. Geral

Os valores obtidos em 3.2.4 e 3.2.5 sdo os valores minimos requeridos. Quando uma

anadlise direta for efetuada para verificacdo de escantilhdes, os seguintes critérios

abaixo devem ser observados:

b. Tensao equivalente

A tensdo equivalente o, obtida pela analise de elementos finitos deve ser baseada na

seguinte equacéo:

— (0 2 o 12
Oc = (25 + & = T - — B T )
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Onde o, e 0, sdo as tensdes atuantes na membrana em x e y do elemento
considerado, e 7....€ a tensdo de cisalhamento no plano x,y;

O, deve ser menor ou igual aos seguintes valores de tenséo:
Ago: 0,833 oy
Aluminio= 0,833 oy

Onde o, e oy, € 0, s&o os valores definidos na tabela 3.5 e 3.6

C. Verificagdao de tensao de flambagem

Para verificacdo de tensdo de flambagem em compressdo tomar as formulacbes
dadasem 3.24.2e€ 3.2.5.3

Para verificagcdo de tenséo critica de flambagem em cisalhamento modelos tedéricos

comprovadamente reconhecidos devem ser tomados como referéncia de calculo.
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3.2.6 Resisténcia Longitudinal da Viga Navio

As equacgbdes em geral sdo validas para todas as embarcagbes que possuem uma

boca, B, ndo superior a duas vezes seu pontal D, como definido em 3.2.2.

3.2.6.1 Médulo de Sec¢édo da Viga Navio

a. Para todas as Embarcacgées

O moédulo de secdo SM requerido para secao da viga navio situada a meia nau, para

todas as embarcagbes é dada pela seguinte equacéo:

SM= C,C,L?B(C,+0,7)KsK,CQ cm®m

Onde:

C,=30,67 — 0,98L 12 L= 18 {m)
= 22,40- 0,52L 1835 L+ 24 {n1)
=15,20 — 0,22L 24 L= 35 {m)
=11,35-0,11L 35 L= 45 {m)
= 6,40 45 L « &1 m)
= 0,0451L+3,65 Lz 6l{m)
= 30,67 — 0,98L 122 L= 1§ ()

C,=0,01

L= comprimento da embarcagéo em (m) conforme definido na segéo 3.2.2

B= boca em (m) como definido na segéo 3.2.2

V = velocidade maxima para o estado de mar especificado em (no6s)

Cy= coeficiente de bloco no calado de projeto, baseado no comprimento, L, medido na
linha d’agua de projeto. C, ndo deve ser menor que 0,45 para L< 35(m) ou 0,6 para
Lz &1 £m), C, para comprimentos entre 35 (m) e 61(m) deve ser determinado por

interpolacgao.

v

L2k

K; = (0,70 +O,30[:t;+ ]) e K3 ndo podem ser inferiores a 1

K4 = 1,0 para embarcagbes em servico oceanico irrestrito
0,9 para embarcag¢des com servigo restrito

C =1 para ago comum

= 0,78 para ago grau H32
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= 0,72 para ago grau H36
Q = para aluminio
= 0,9 + g5 mas nao inferior a Qg
gs = 12/a;
Qo = 65/ (T, + T,
&, = tens&o minima de escoamento (kgf/cm2)

7, = tensdo minima de ruptura (kgf/cm2)
b. Embarcagdées com comprimento superior a 61m

1. Convencgoes de sinais para momento fletor e esfor¢o cortante
A convencédo de sinais para momento fletor e esforgo cortante € indicada abaixo na

figura 3.5
Fsw,Fw ( Esfor¢o Cortante)

—1

Msw,Mw (Momento Fletor)

R

Figura 3.5: Convengdes de sinais para momento fletor e esforgo cortante

2, Momento fletor devido a ondas a meia nau
O momento fletor a meia nau da viga navio devido a efeito de onda pode ser obtido
pela seguinte equacéo:

Mys=-k{C1L,B(Cp+0,7)10°  Sagging Moment

Myn=k.C+L,BC,1073 Hogging Moment
Ky =11,22
K, = 19,37

C,4,L,B, e Cy, sdo definidos em 3.2.2
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3. Médulo de secao
O mddulo de secao de viga navio requerido € obtido pela seguinte equagéo:

gV = Lty
3=

K,, C, e Q conforme definidos em 3.2.6.1.a

No caso da condicdo de navegacgao oceanica restrita, consideracdes particulares
podem ser dadas para a analise de seakeeping baseado na velocidade da
embarcacgédo e estado de mar para determinar M,,s € My,,. Nesses casos Ks e Fs devem

ser tomados iguais a 1.

M; = Mgy + MyFq

M. = maximo momento fletor para aguas calmas na condi¢cdo de hogging ou sagging
(tf m), geralmente Msw nao pode ser tomado menor que 0,5 Mws

Mw = momento fletor maximo de onda em (tfm) como determinado em 3.2.6.1.b.2

fp = 1,784 tf/lcm,

Fs = fator de restricdo baseado na altura significativa de onda conforme tabela abaixo
3.8.

Tabela 3.8: Fator de servigo, Fs

Area de operacdo Altura significativa de onda (m) Fs
Servigo irrestrito by 3 =4 1
Servigo restrito 3,55 iy i3 =5 40 0,8
2,02 hy; = 3.5 0,7
0,5% by g = 2,5 0,5
C. Embarcagdes de planeio e semi-planeio

Para embarcagbes com velocidade acima de 25 nés, o médulo da segéo da viga navio

também n&o podera ser inferior ao obtido pelas seguintes equagbes, o que for maior:
SM = .:L (128Y¢-178Ycg-50)CQ  cm’m

ou

SM = % (78Ycs-128YA-50)CQ cm2-m

Onde:
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A = deslocamento maximo da embarcagéo (tf.m)

L.= comprimento da embarcagéo na linha d’agua de projeto (m)

Ye= aceleracdo vertical na parte de vante da embarcacdo, geralmente pode ser
tomado 1,2 ngg, entretanto onde L € maior que 61m, ou onde Vi € maior que 35 nos,
esse valor deve ser obtido por teste de modelo submetido a aprovagdo do 6rgao
classificador.

Ncg= conforme definido em 3.2.3.1

C,= 1320

Ycg= aceleracgao vertical na secao longitudinal do centro de gravidade, média de 1/10
das maiores aceleragdes em g’'s. Quando Y4 ndo for submetido pelo projetista, o valor
a ser adotado n3o deverd ser inferior a 0,6 ncg, onde ne é 0 valor calculado em 3.2.3.1.
Entretanto, onde L &€ maior que 61m, ou onde Vk é maior que 35 nés, a aceleragéo
vertical devera ser determinada por teste de modelo e submetida a aprovagdo do
o6rgao classificador.

Ya = em geral a aceleracdo vertical na parte mais a ré da embarcacdo deve ser
tomada como 0, entretanto quando L for superior a 61m, ou onde V for superior a 35
nos, o valor de Y, deve ser determinado por teste de modelo e submetido a aprovacgéo
do o6rgao classificador.

C = coeficiente dado em 3.2.6.1.a.

Q = coeficiente de material dado em 3.2.6.1.a

Quando o deslocamento e a velocidade variam com a condigdo de carga, o calculo
acima devera ser efetuado para todas as combinacbes possiveis de deslocamento e

velocidade.

3.2.6.2. Extensdo do Médulo de Seg¢ao da Viga Navio ao longo de L

Quando o momento fletor em aguas tranquilas n&o for calculado, e quando a
embarcagéo estiver atendendo somente aos itens 3.2.6.1.a. 3.2.6.1.b., os escantilhdes
de todos os elementos continuos, ou efetivamente desenvolvidos devem ser mantidos

nos limites de 0,4L e gradualmente diminuidos até as extremidades.

Quando os escantilhdes sdo baseados na envoltoria da curva do momento fletor em
aguas tranquilas, os itens incluidos na secéo da viga navio de meia nau deverao ser
estendidos o suficiente para atender o médulo de secdo requerido na localizagéo

considerada.
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A envoltéria da curva de M,s € My, pode ser obtida multiplicando o valor de meio navio
pelo fator de distribuicao M dado na figura
3

FATOR DE DISTRIBUICAO DE M

o= ===
| |
i |
M 1 |
I |
1 |
0 1 l
0.0 0.4 0.85 1.0
extremidade extremidade
de ré de L de vante L
Distancia a partir da extremidade de ré de L em termos de L
Figura 3.6: Fator de distribuicdo M
3.2.6.3. Momento de Inércia

O momento de inércia I, a meia nau ndo deve ser menor que o dado pela seguinte

equacéo:

153
|l==== cm? m?
"

Onde:

I = inércia requerida da viga navio, cm?m?

SM = méddulo requerido da se¢do mestra conforme 3.2.6.1.a, b e ¢ tomando-se o maior
valor em cm®m

K = fator que depende do material e servigo conforme dado na tabela 3.9

L e Q definidos em 3.2.6.1.a
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Tabela 3.9: Fator K

Ago Aluminio
Servico Restrito L<90m 40 13,33
Servigo nao restrito L<90m 50 13,33
Servico nao restrito L>90m 33,3 11,1
3.2.6.4. Calculo do Médulo de Secao e do Momento de Inércia

a. Itens que devem ser incluidos no calculo

Em geral os seguintes itens devem ser incluidos no calculo do médulo de se¢éo e do
momento de inércia, considerando que os mesmos sao continuos e desenvolvidos
dentro da regido de 0,4L, que tenham resisténcia adequada a flambagem, e sao

gradualmente reduzidos apds a 0,4L da regidao de meia nau.

Chapa do convés (convés resistente e outros conveses efetivos)
Chapa de costado e duplo fundo

Gigantes de fundo e convés longitudinais

Chapas e reforgos longitudinais de anteparas longitudinais

Todos os longitudinais de convés, costado, fundo e duplo fundo.

b. Area efetiva incluida no calculo

Em geral a area seccional dos elementos estruturais longitudinais deve ser incluida no
modulo de secdo da viga navio. As areas de pequenas aberturas isoladas nao
precisam ser reduzidas desde que ndo haja reducdo de médulo superior a 3%. A
largura ou altura de tal abertura n&o dever ser maior que 25% da largura ou altura do
elemento no qual esta localizado e com um maximo de 75mm para escalopes. Para
aberturas superiores aos valores indicados acima, deve ser considerada uma area de
sombra para vante e para ré incluida dentro de linhas tangentes aos cantos da

abertura, formando um angulo de 30°.

C. Médulo de Se¢ao do Convés ou Fundo.
O valor do médulo de seg¢édo do convés ou do fundo € obtido dividindo o0 momento de
inércia relativo a linha neutra, pela distancia da linha neutra ao ponto considerado, isto

€, da linha neutra ao convés ou da linha neutra ao fundo respectivamente. Quando
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uma casaria ou superestrutura for muito longa e for considerada como parte da viga
navio, 0 modulo de secdo do convés é obtido dividindo o momento de inércia pela
distancia da linha neutra até o topo da referida casaria ou superestrutura ou até

mesmo borda falsa.

d. Formulagéao de calculo do médulo de segdo de viga navio

O célculo do Médulo de uma determinada secdo de uma embarcacao € efetuado com
os principios da “Resisténcia dos Materiais” [16] e do procedimento pratico indicado na
planilha “Médulo de SM” [17].

Notar que no calculo de mddulo de secdo, apenas os elementos longitudinais
continuos numa extensdo nao inferior a 0,4 L sdo considerados. Os elementos
transversais, tais como anteparas transversais, hastilhas e elementos curtos néao
contribuem para a resisténcia longitudinal da embarcacédo, e portanto ndo sao

considerados no calculo do médulo de secao.

Para a determinacédo das propriedades geométricas de uma determinada secéo, o

seguinte procedimento sera adotado:

Determinacao da area total de segéo (A)
A=, ALf)
Determinacdo do momento estatico (Ms)
Ms = D, A() « Zeglt)
Determinagdo do Momento de inércia de transporte (It)
ft =Xk, Al « Zegii)®
Determinagdo do Momento de Inércia prépria (Ip)
EL ARt

T s T il L
=TT

Determinagéo da Linha Neutra (Z;,)

Zn= Ms/A (e conseqlientemente Zjeck = D-Zpottom)
Determinagao do Momento de Inércia em relacéo a linha neutra
I=l+1,-Z),2. A

Determinagédo dos Modulos de segéo do fundo e do convés:
SMboottom=/Zpottom

SMueck = /Zgeck
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Onde,

A(i)=area transversal do elemento i

Zcg(i)= posicao do centro de gravidade do elemento i

Zbottom= posicao vertical da linha neutra em relacdo a linha de base (ou linha de
referéncia)

Zyeck = D-Zpottom  (Zaeck € a distancia vertical do convés até a linha neutra)

Zpotom= Zin - coordenada do ponto mais baixo da embarcacdo (Zsx € a distancia

vertical do convés até a linha neutra).

Depois de efetuados os calculos estruturais, PARLA calcula o médulo de secdo em

estudo para permitir a comparagdo com o médulo requerido.

3.2.6.5. Calculo de cisalhamento da viga navio para embarcagdées com

mais de 61m

1. Geral

A tensdo de cisalhamento nominal devido as cargas ativas e reativas em aguas
tranquilas e cargas induzidas por ondas sao baseadas na soma algébrica do médulo
de cisalhamento em aguas tranquilas, Fsw, e do cisalhamento em onda, Fw, na secao

em estudo. A espessura do costado deve ser tal que o cisalhamento total obtido em

3.2.6.5.3 ndo seja maior que L:jj tflcm2, onde Q é definido em 3.2.6.1a.

"

Consideracbes também devem ser dadas para a resisténcia de cisalhamento em

flambagem das chapas do costado e anteparas transversais e longitudinais.

2. Forgas de cisalhamento em ondas.

A envoltéria do cisalhamento maximo devido ao efeito de ondas Fw como indicado nas

figuras 3.7 pode ser obtida a partir das seguintes equagdes:

Fup=+kF1C1LB(Cp+0,7)x 107
Fun=- kF2C1LB(C,+0,7)x 1072

Fuwp, Fwn = forgas de cisalhamento maximas induzidas por ondas em (tf)
K= 3,059
F,= fator de distribuicdo dado na figura 3.7

F,= fator de distribuicdo dado na figura 3.7
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C,,L,B e C,, sdo os definidos em 3.2.2 € 3.2.6.1.a

Distrituicao do fator F1

0.92 x IHD&
110(G + 0.7)

F, W= F

I
1
1
!
|
1
|

] =

0.0 02 03 04 0.8 7 0.85 1.0 )
extremidade de extremidade de
ré de L vante de L

Distancia da extremidade de ré de L em termos de L

Distribuicao do fator F2

e — —

1906, |
110(Cp + 0.7)

|
T
I
[y 071 —4!-
i
|

%00 02 03 0.4 06 07 085 1.0
e}{trem-itlmle de . . extremidade de
ré de L vante de L

Distancia da extremidade de ré de L em termos de L

Figura 3.7: Fator de distribuicao F e F;
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3. Resisténcia total ao cisalhamento

Para embarcagdes que nao possuam anteparas longitudinais continuas, a tenséo
nominal de cisalhamento f; no chapeamento do costado pode ser obtida pela seguinte
equacéo:

fs = (Fswt FsFw)m/2tl

f, = tensdo nominal de cisalhamento (tf/cm?)

I = momento de inércia da viga navio em cm* na secéo considerada

M = primeiro momento em cm®, em relacdo a linha neutra, das areas efetivas
longitudinais entre o nivel horizontal em que a tensdo de cisalhamento esta sendo
determinada e a extremidade vertical efetiva longitudinal, tomada na se¢do em estudo.
ts = espessura do chapeamento do costado na posi¢cao considerada

F.w = forca de cisalhamento da viga navio em aguas calmas (if)

Fw = Fup ou F,n como especificado em 3.2.6.5-2 dependendo das cargas

Fs € como definido em 3.2.6.1-2 — Tabela 3.8

4. Embarcagdes com proporgées ndo usuais

Deverado ser criteriosamente verificadas por calculo racional e testes em modelos

quando requerido pela Sociedade Classificadora.

3.2.6.6. Viga navio sujeita a torg¢ao

Célculos devido ao efeito de tor¢gdo deverao ser cuidadosamente analisados quando

houver grandes aberturas no convés.

3.2.7. Convés efetivo

Um convés para ser considerado efetivo nos célculos da secao de viga navio, devera
ter as suas espessuras de chapeamento em acordo com os requisitos do item 3.2.4 e
3.2.5. As areas seccionais dos elementos deverdo ser mantidas a meia nau em pelo
menos 0,4L e podem ser reduzidas gradualmente para metade do seu valor de meia
nau a 0,15L das extremidades. Somente as partes do convés que forem continuas em

sua estrutura transversal poderéo ser consideradas efetivas.
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3.2.8. Arranjos Estruturais
Um dimensionamento estrutural correto € muito importante. Entretanto, o arranjo
estrutural escolhido e projetado chega a ter uma importancia superior para redugéo de

peso, bom desempenho estrutural ao longo dos anos e facilidade construtiva.

Os tipos de reforcos, espagamento entre os mesmos, estrutura transversal,
longitudinal ou mista, detalhes de ligacdes de elementos, aberturas, etc., devem ser

criteriosamente estudados pelo projetista.

A seguir alguns lembretes importantes para um bom projeto estrutural:

a. O chapeamento da estrutura primaria deve ser estruturado longitudinalmente
sempre que possivel. Isto podera levar & espessuras menores, evitando o
efeito de flambagem longitudinal dos painéis sob efeito de flexdo da viga navio.

b. Para um projeto de estrutura longitudinal, os longitudinais deverao se apoiar
nas transversais, estas nos longitudinais gigantes e estes por sua vez nas
anteparas, ou elementos de rigidez superior.

c. Para um projeto de estrutura transversal, as transversais deverdo se apoiar nos
gigantes longitudinais que por sua vez deverdo ser apoiar em gigantes
transversais, ou anteparas transversais ou elementos de rigidez superior.

d. E extremamente importante que o projeto estrutural seja bem concebido. A
pergunta, “Quem esta segurando quem?”, deve estar bem definida, isto é,
todos os elementos estruturais sempre devem ser suportados por um elemento
de maior rigidez estrutural.

e. Todos os elementos estruturais devem ter continuidade estrutural. Quando
houver variagdo das dimensdes, esta devera ser gradual.

f. Os elementos estruturais devem estar sempre alinhados com elementos
estruturais do outro lado das anteparas, divisérias ou conveses, de modo a
evitar o efeito de concentragbes de tensdes localizadas.

g. Estruturas de fixacdo do sistema de governo, propulsdo, sistema de fundeio e
amarragdo ou equipamentos em geral que geram esforgos consideraveis para
o porte da embarcacdo em estudo, devem ser reforgadas em acordo com
Normas reconhecidas, e de uma forma geral super dimensionadas, para evitar
efeitos de vibracdes e fadiga indesejaveis. Neste caso vale muito a experiéncia
do construtor ou de projetos de embarcacgdes similares que tenham mostrado

seu bom desempenho no passado.
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As ligacdes de extremidades de elementos estruturais devem ser tais que
garantam uma ligacdo eficiente entre os elementos que devem estar
rigidamente conectados. Isto podera ser feito através de ligacdo direta ou
através de borboletas. Atencdo devera ser dada aos fatores de calculo para o
tipo de ligacdo que estiver sendo utilizado. E importante observar que os
detalhes de ligacado sao extremamente importantes para que a estrutura
projetada resista aos esforcos que |Ihe sdo impostos, e também €& muito
importante observar que 0s mesmos sdo 0s maiores responsaveis pela vida util
da embarcacgéo em fadiga.

Dependendo das dimensdes dos tanques estruturais, anteparas diafragmas
sao recomendaveis, de forma a evitar o impacto de liquido sobre as estruturas
limites dos tanques, devido aos movimentos da embarcacao.

Embarcacbes para viagens internacionais, devem ser providas de duplo fundo.
Quando isto ndo for possivel, arranjos alternativos deverdo ser propostos e
aprovados pela Classificadora.

Alturas e espessuras de almas, larguras e espessuras de flanges ou barras
chatas devem obedecer as proporcbes recomendadas por Normas
reconhecidas, ou as especificadas neste relatorio.

Os reforgcos estruturais ndo devem ser interrompidos no meio dos painéis
gerando concentragbes de tensdes.

. Os cantos das aberturas de chapeamento devem ser arredondados.

As aberturas deverao ser reforcadas convenientemente de modo a garantir que
os reforgos incorporados substituem a area retirada, resistindo aos esforgos a
que a chapa retirada estava sujeita, tensao de compressao ou tragdo, tensao
de cisalhamento e tens&o normal ao painel.

Aberturas de acesso devem estar fora da area de concentragdes de tensoes, e
deverao ter suas alturas limitadas a 0,5 da altura do elemento e 0,75 da largura
entre reforgcos. Altura e largura do elemento previamente calculado para resistir
aos esfor¢os que lhe sdo impostos.

Furos de dreno e de respiro de ar devem ser inferiores a 40mm ou 1/3 da altura

do elemento o que for menor.

E muito importante que o projeto estrutural, em resumo siga a seguinte

orientagéo:
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“Um bom arranjo estrutural é facil de ser entendido, agradavel de ser observado,

esta em equilibrio com o projeto todo e esta em harmonia com a natureza”

4. Metodologia da Pesquisa

4.1 Softwares

Muitos softwares existem no Mercado para serem adquiridos principalmente na area

de arquitetura naval, tais como, NAPA, Autoship, Maxsurf, GHS, Hecsalv, e outros.

Para a area de estrutura, os programas comerciais de mercado sdo os que trabalham
com elementos finitos, tais como, ANSYS, NASTRAM, ABACUS, SAP e muitos outros.

Nota-se que todos esses programas estruturais, partem de uma geometria e de
caracteristicas estruturais ja previamente definidas pelo projetista. A modelagédo das
condicbes de contorno € extremamente trabalhosa, e os carregamentos dinamicos e

estaticos dependem de ensaios em modelos.

As classificadoras trabalham com formula¢des empirico- tedricas, isto &, baseadas na
conceituagdo teodrica somada a parametros praticos adquiridos ao longo de anos de

experiéncia para cada tipo especifico de geometria e operagéo de embarcacgéo.

Os programas estruturais especificos para as embarcagdes utilizando as regras das
Sociedades Classificadoras geralmente sdo de propriedade das referidas
classificadoras, limitados a checar uma estrutura proposta pelo projetista, e que
geralmente ndo séo acessiveis ao projetista em geral, como por exemplo, o MARS do

Bureau Veritas.

Em uma pesquisa breve, verificamos que o LLRS, o ABS, o DNV e o BV possuem

softwares proprios baseados em suas regras especificas.

O BV possui o programa MARS o qual pode ser obtido inclusive via Internet, com

rotinas de calculo estruturais para diferentes tipos embarcacdes.

PARLA foi concebido utilizando as regras do ABS [1], e para interagir com o projetista,

no desenvolvimento do projeto estrutural. O projetista podera projetar a estrutura de
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uma embarcagdo, com o auxilio do software, atendendo as cargas que lhe séo
impostas em seu regime de trabalho e considerando todos os fatores de seguranca

fornecidos pela referida classificadora.

PARLA também calcula os esfor¢cos solicitantes atuantes ao longo da viga navio,
calcula o médulo minimo requerido para cada sec¢éo, e compara o modulo requerido

com o médulo real da se¢do em estudo.

Ao calcular o modulo da secdo em estudo, PARLA simultaneamente verifica os
elementos de chapa e perfis longitudinais quanto a flambagem, informando ao

projetista os elementos que entraram em colapso.

Adicionalmente PARLA estima o peso e centro de gravidade da embarcagdo em
estudo. Quanto maior for o nimero de se¢des projetadas e calculadas, maior sera a

precisao do peso e centro estimados.

O programa MARS do BV possui rotinas de calculo estruturais para diferentes
embarcacgbes. Entretanto, ndo calcula o peso e centro da embarcacgéo, que é um item
coberto pelo PARLA.

O software PARLA foi desenvolvido para apresentacao desta dissertagdo. O mesmo

podera sofrer melhorias e implementagdes de rotinas ao longo do tempo.

4.2 Linguagem de Programacéo

A linguagem de programacao Delphi foi escolhida para elaboragdo do PARLA, por se
tratar de uma linguagem visual e que mantém uma conceituagdo de Engenharia
através da programacao Pascal utilizada pelo mesmo, além de ser a linguagem mais
utilizada na UFRJ.

Através de simples comandos em botdes da tela e comandos do mouse, € possivel

utilizar esta ferramenta com muita facilidade e rapidez.

O usuario interage com o programa através da concepcao de “Double-click” para

selecao dos elementos de calculo, e com o acionamento do botéo 'calcular’, PARLA
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fornece as dimensfes estruturais dos elementos solicitados, permitindo a visualizacao

grafica dos mesmos simultaneamente.

PARLA também foi concebido de modo a permitir ao projetista voltar para as paginas
anteriores, assim como através dos botbes de rolagem, conferir os valores

previamente calculados para cada elemento estrutural.

Caso o projetista resolva modificar algum calculo anterior, também ha a possibilidade
de apagar o elemento previamente calculado, sendo excluido ou substituido por outro

elemento.

O botao “SPEED-UP” é uma opc¢ao do projetista para obter uma estimativa inicial de
projeto, dos escantilhdes estruturais de uma embarcagdo do tipo mono casco
planadora com casco prismatico e fundo em V. Este botdo encontra-se em

desenvolvimento.

As premissas que nortearam a concep¢ao do PARLA podem ser resumidas nos

seguintes itens:

Facilidade de utilizagao;

Possibilitar o estudo de diferentes materiais;

Possibilitar a otimizac&o estrutural;

Rapidez e simplicidade de andlise;

Interacdo dos calculos com a parte grafica simultaneamente;

Ser do tipo assistido, interagindo sob os comandos do usuario.
Importar as formas

Cavernar a embarcacao, isto é, a partir das formar gerar o plano de cavernas
Compartimentar

Calcular as pressdes atuantes em todas as regides da embarcagéo
Calcular chapas

Calcular reforgos internos

Calcular esforgos solicitantes em ondas de todas as sec¢bes

Calcular médulo requerido e médulo ofertado

AN N NN U N U U N N D N N N

Estimar o peso e centro estrutural da embarcagdo em estudo
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5. Descrigdo do Programa PARLA

5.1 Apresentagao

PARLA € um programa grafico-interativo para calculo de estrutura de embarcagbes do
tipo mono casco com fundo em “V” e de alta velocidade. A versdo que sera
apresentada é a de 2009. Trata-se de um trabalho em que muito ha por se fazer e
aperfeicoar. A apresentacdo do mesmo ou a abertura da primeira tela é apresentada

na figura 5.1.

o ..:
14 Iniciar T

Figura 5.1: Abertura do programa

Esta verséo é baseada nas regras do ABS, “Guide for Building and Classing High-
Speed Craft — October 2001” [1].

E importante alertar que o programa nao foi homologado pelo ABS, portanto esta

instituicdo ndo podera ser responsabilizada pelos resultados do programa.
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Por se tratar de uma versao piloto, inicial, ndo existe ainda nenhum compromisso do
autor com os usuarios quanto ao bom funcionamento ou qualquer garantia quanto na

sua utilizagdo.

5.2 Historico

PARLA comecou a ser desenvolvido no projeto de graduacéo, coordenado pelos
Professores Richard David Schachter, Ph.D. e Julio César Ramalho Cyrino, D.Sc.,
fazendo parte do processo de desenvolvimento do sistema computacional para

embarcagdes e plataformas.

5.3 Operagédo do programa
A operacao do programa se da através do menu “pull down”, “screen menu”, teclado,

mouse e quadro de dialogos.

Teclado: a digitacdo de dados de entrada se da normalmente pelo teclado.

Menu pull down: fica localizado na parte superior do video a direita, e segue os

padrdes e estilos do Windows como base.

Barra de Ferramentas: Esta barra fica na parte superior do video a esquerda, e que
permite as visualizagdes graficas possiveis da pagina em trabalho com apenas um

clique de mouse.

Mouse: O botdo esquerdo vai operar com um clique para abrir janelas ou comandos e
com dois cliques para dar posicdes de calculo conforme a atividade que sera explicada
no decorrer deste relatério. O botdo direito, de uma forma geral quando apontado para
uma palavra da a descrigcdo dessa determinada palavra ou faz a corre¢do de dados

conforme apresentado neste relatério.

Quadro de dialogos: durante o desenvolvimento de um determinado projeto,
aparecerao na tela quadros de didlogos, informando ao projetista sobre os préximos
passos a serem dados, erros cometidos durante a entrada de dados e solicitando mais

informagdes ou agbes quando requeridas para dar continuidade aos calculos.
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54 Arquitetura do PARLA

O PARLA foi projetado para trabalhar interativamente com o projetista. O projetista
deve seguir uma seqiiéncia de trabalho, para permitir a finalizacao e apresentacéo de
resultados pelo programa. Exemplo: O programa nao podera iniciar os calculos se a

geometria e caracteristicas basicas da embarcacao nao tiverem sido definidas.

O PARLA informa ao projetista a seqiiéncia de acdes a serem tomadas através de
caixas de dialogo, quando o mesmo avancgar em um determinado calculo onde dados

prévios forem necessarios.

5.5 Manipulagao de arquivos
A manipulagdo de arquivos no PARLA se da através da barra de menu abrindo o
arquivo (File). Ver figura 5.2.
O arquivo (File) contém as seguintes opg¢des:
v" Open: abre um arquivo de dados de calculo de uma nova embarcagéo;
v' Import Lines: importa um arquivo de dados que contém as formas do casco de
um arquivo tipo .SAl do PHF[3];
v Save as: salva todos os calculos realizados da embarcagdo em estudo em um
arquivo de escolha do projetista;

v Exit: sai do programa.

File Project Calculations Rules

Mew

Open
Import Lines
Expark:

Save

Save as

Figura 5.2: Acionamento do comando File na barra de menu

5.6 Barra de Menu

5.6.1 Trabalhando com o comando File da barra de menu
a) Comando “novo™:
Menu:>File

>New
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Descrigdo: Ao dar este comando, todos os campos de entrada de dados ficam
preparados para receberem as informagdes de outra embarcacdo. Os dados
anteriores, se nao tiverem sido salvos serdo perdidos, sem possibilidade de

recuperar. Portanto o projetista devera ter muita atencdo ao dar este comando.

b) Comando “abrir”:
Menu:>File
>QOpen
Descrigdo: Este comando abre o arquivo de uma embarcacgao ja calculada e
previamente salva. Os calculos podem ter sido finalizados ou incompletos. O

arquivo sera aberto na sua situagéo atual de calculos.

c) comando “importar as formas do casco”:
Menu:>File
>Import Lines
Descricao: Ao dar este comando, PARLA abre uma caixa de dialogo para
selegdo de um arquivo que contenha a forma do casco da embarcagao
utilizada pelo programa e que & desenvolvida em um software deste sistema
computacional chamado “Planing Hull Form” (PHF) [3]. A figura 5.3 apresenta o

quadro de dialogo aberto para selegdo de um arquivo a escolha do projetista.

Examinar: Ib DATA j - =% EB-

BAR.1.5AI

[#]BAR2.5A1
ey || R ]ROCK2,5AT
recentes |l EYRFLENIN
|® |®]woLvER2.5AT

Desktop

I

Meus

o E

L
Meu
computador

-

Meusrg:jc:is i Mome do arguivo: IEAFH SAl j Abrir I

Arquivos do tipo: | J Cancelar |

Figura 5.3: Seleg&o do arquivo a ser lido do comando “Import Lines”
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O PHF gera um arquivo no formato SAl (*.sai) que é a tabela de cotas da
embarcacao gerada, como configuragcado padrao esta tabela de cotas possui 21
balizas, podendo ser acrescidas outras balizas a estas 21 de acordo com a
preferéncia do usuario do programa. O programa desenvolvido utiliza entédo
este arquivo de formato SAI. A figura 5.4, apresenta um arquivo exemplo, no

caso, BAR1.SAl, para leitura da tabela de cotas.

I BAR1 - Bloco de notas B@@

Arquivo Edtar

Formatsr Exbi Ajuda

Hu1T File:

LOA= 39,
Lwl= 35
Breadth= 9
Depth= &

Parallel Bo
humber of 5
Number of
rake angle
Height of R
Units [m]

Mo Lwl/20
0. 00

6,00 1
7.00 1

8.00 14,015 0.000 0.000 4.243 1.405 4.500 5.500 0.000 5.500

9.00 1
10 10,00 1
11 11.00 1

12 12.00 21.023 0.000 0.000 3.938 1.685 4.306 5.536 0.000 5.536

13 13.00 2

14 14.00 24,527 0,000 0.000 3.567 1.953 3.971 5.598 0.000 5.598

15 15.00 2
16 16.00 2
17 17.00 2

18 18.00 31.534 0.000 0.000 2.214 2,887 2.750 5.824 0.000 5.824

158 19.00 3
20 19,18 3
21 20,00 3
22 22.76 3

e —
/4 Iniciar

BARL. DAT

. 000

.038 where: sta = station
. 000 k = keel

. 000 C = chine

- 600 LC = centerline
iy 2 1 station(s)

tations= 3

hines =

of Bow = 42.00

ake End= 0.000

Hsta k zk 545 il vd zd YLC L’
0.000 0.000 0.000 4.115 1.103 4.500 5.500 0.000 §.500
1.752 0.000 0.000 4.128 1.166 4.500 5.500 0.000 5.500
3.504 0.000 0.000 4.151 1.215 4.500 5.500 0.000 §.500
5,256 0.000 0.000 4.178 1.253 4.500 5.500 0.000 5.500
7.008 0.000 0.000 4,207 1.284 4.500 5.500 0.000 35,500
8.760 0.000 0.000 4.233 1.312 4.500 5.500 0.000 §.500
0.511 0.000 0.000 4,250 1.338 4.500 5.500 0.000 §.500
2,263 0.000 0.000 4,255 1,368 4.500 5.500 0.000 35,500

5,767 0.000 0.000 4.210 1.451 4.500 5.500 0.000 5,500
7.519 0.000 0.000 4,151 1.511 4.500 5.500 0.000 5.500
9.271 0.000 0.000 4.062 1.588 4.418 5.515 0.000 5,515

2,775 0.000 0.000 3.774 1.80% 4.158 5.563 0.000 5,363

6.279 0.000 0.000 3.312 2.132 3.741 5.641 0.000 5.641
8.031 0.000 0.000 3.005 2.345 3.463 5.602 0.000 5.682
9,782 0.000 0.000 2,840 2,596 3.134 5.753 0.000 5,753

3.286 0.000 0.000 1.721 3.223 2.307 5.006 0.000 5.806
3,598 0.000 0.000 1,627 3,288 2.222 5.922 0.000 5,922
5.038 0.000 1.600 1.159 3.607 1.800 &.000 0.000 6,000
9,000 0.000 6.000 0,000 6.000 0.000 6.000 0.000 6,000

TR 7 e & DaTa

Figura 5.4: Exemplo de arquivo tipo .SAl lido pelo programa

Resultados: O plano de linhas e algumas caracteristicas basicas importadas

serao necessarios para possibilitar os calculos estruturais.

Correcbes: Nesta etapa néo serdo possiveis corregcbes. Caso o projetista opte
por um novo arquivo, o comando exit, na barra de menu devera ser acionado

para retornar aos passos iniciais e selecionar um novo arquivo.

Comando “salvar como”:
Menu:>File

>Save as
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5.6.2

Descricdo: Ao dar este comando, todas as entradas de dados e calculos
realizadas até aquele momento serdo arquivadas em um arquivo definido pelo
projetista. O arquivo sera do tipo .txt, facilmente manipulado em outros

programas posteriormente.

Comando “sair”:
Menu:>File
>Exit
Descrigdo: Ao dar este comando,PARLA apresentara a seguinte mensagem:

“Are you sure that you want to exit?, isto é, “Wocé tem certeza que deseja sair?.
Caso o projetista opte em sair do programa, os dados anteriores que nao

tiverem sido salvos serédo perdidos sem possibilidade de recuperar. Portanto o

projetista devera ter muita atengao ao acionar o botéo “YES”.

Informagoes sobre caracteristicas basicas da embarcagéo

Menu: >Project

>Project Settings

Descrigdo: O comando Project Settings, ver figura 5.5, abre trés tabelas que deveréo

ser preenchidas pelo projetista com os dados basicos do projeto. Alguns dados serao

importados do arquivo .SAIl e outros deverdo ser fornecidos pelo projetista. Para os

dados que ndo forem fornecidos, PARLA assume valores a favor da segurancga

estipulados pelas Regras de Classificadora.

* PARLA

|Prnject Calculations  Rules

Froject Settings
Lines

Frames Spacing
Hull Bulkheads

comparitments
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Entrada de dados: se da através do teclado.

Telas:

a) A primeira pasta (General) solicita as referéncias de projeto e materiais que
serdo empregados na constru¢do do casco, tais como chapas de aco e
perfilados. Uma relacdo de materiais existentes no mercado é fornecida no
programa para selecdo do projetista. As propriedades mecéanicas sao
preenchidas pelo PARLA ap6s o material ter sido selecionado. Ver figuras 5.6

para Plating Material e 5.7 para Internals Material.

7 Project Settings

General | Main Dimensions | Origin Description I

Plating Material B ra— Internals Material e
i+ Steel {* Steel
Stesl Grade A Bl Steel Grade A Ele
Aluminum 5454 H34 up to 25.5mm plate = -——  —
Afumr:rrum 5456 H116 up to 38.0mm  plate Specific Weight |7BD|]7 b3
Aluminum 5456 H321 up to 38.0mm  plate
Properties of Aluminum Alloys Extrusion/ Steels
Steel Grade AH32 aterial Factor Ultimate Stress Igwg— Kaffcma
Steel Grade AH 38 ] ‘eld Stress Izqug— Kaffem2
FRP o Modulus of Elasticity W Kgflem2
Other -
Properties of Fiber Reinforced Platic Basic Laminate Properties of Fiber Reinforced Platic Basic Laminate
Flexural strength, F I— Faféemz Flexural strength, F I— Faféemz
Flexural modulus, Ef I— Kaffem2 Flesural modulus, Ef I— kgféemz
Tensile strength, T Ii Kaffemz Tensile strength, T Ii Kaffemz
Tensile Modulus, Et Ii Koffem2 Tensile Modulus, Et Ii Koffem2
Compressive stiength, C I— Kaffem2 Compressive strength, C I— Kaffem2
Compressive modulus, Ec I— Kaffema Compressive modulus, Ec I— Faféemz
Shear strength perpendicular to warp Ii Kaffcm2 Shear strength perpendicular to warp Ii Kaffcm2
Shear strength parallel to warp Ii Kgflem2 Shear strength parallel to warp Ii Kgflem2
Shear modulus parallel to warp Ii Kaflem2 Shear modulus parallel to warp Ii Kaflem2
Interlaminar shear strength I— kaféemz Interlaminar shear strength I— kaféemz
@

Figura 5.6: Selecao Menu>Project>Project Settings>General>Plating Material

Internals Material _—
{* Steel

_ = Aluminum
rade ¥
LE J {~ Composites
Aluminum 6061 T6  extrusion - |

Aluminum 6082 T6  extrusion
Aluminum 6351 T6  extrusion

Steel Grade A Els
Steel Grade AH 32

Steel Grade AH 36

FRP

Other -

Figura 5.7: Selegdo Menu>Project>Project Settings>General> Internals Material
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b) A segunda pasta (Main Dimensions) solicita as dimensdes basicas da

embarcagdo e caracteristicas hidrodindmicas da mesma. Informacdes tais

como comprimento, boca, pontal, calado, momento fletor em aguas tranquilas,

esforgo cortante em aguas tranquilas, altura de onda, velocidade, etc.. Ver

figura 5.8.

[ ot serungs — S

Genersl Main Dimensions | iigin Dasciiption |

Length Overall 29,000 [}
Length BP 23000 (m]
Length Waterline 038 (m)
Breadth [ao0
Breadth Waterline [am
Depth ISUUU— (m)
Draft [
Displacement I N
Block Coefficient ]
Wave Height I
Design Speed [ ko
Number of Passengers [
Crew L

Rules Block Coefficient m)
Rules Wave Height

Still Water Bending Moment in Hogging l—
Siil Water Bending Moment in Sagging. [~
Steel Water Shearing Force I—
Vertical acceleration at LGG [
Vertical acceleration at forward end [ ]
Vertical acceleration at aft end l—
Running trim ]
Deadrise at Lcg ]

Area of opera (TR ]

Rules Length  Please input Displacement
[220

Rules Draft

Rules Deadris ﬂl

Rules Trim
Rules Vertical acceleration af LCG

Rules Vertical acceleration at forward end

Rules Vertical acceleration at aft end

Collision Bulkhead Position from |

[m) 1o I [m} from Long. reference

Service Factor

—

c'k

=131

Figura 5.8: Selecado Menu>Project>Project Settings>Pasta Main Dimensions

c) A terceira pasta (Origin Description) solicita a referéncia de coordenadas

adotadas e pontos

referenciais caracteristicos,

tais como posicao da

perpendicular de ré em relacédo a referéncia de coordenadas. Nesta pasta, o

projetista também devera informar qual o sistema de interpolagéo desejado,

isto é, interpolacgédo linear ou interpolacao por spline, para obtenc¢ao do plano de

cavernas a partir do plano de linhas importado.

Na mesma pasta também sao fornecidos dados como: nome do projetista,

nome de projeto etc. Ver figura 5.9.
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7' Project Settings

General | Main Dimensions i iﬁés’cfiniin"n"]‘/
Project Name [RullFie: BERT.DAT
Designer [Eng Barle
Reference [HulFie: BERT.DAT
Units MKS &
Longitudinal [t Perpendicular
Transversal |L0ng\tudma\ Ceniter Ling
Vertical |Base Ling

Aft Perpendicular Position |p i
Aft Water Line Intersection |p i

 Linear

% Natural Cubic Spline

Bl@

# Tniciar| | S partaoso110

| 8 Documento 1 - Microsoft ... | J Delphi 7

| ¥ Projectparlal

SE

| ‘ <« iy W B 21:29

Figura 5.9: Selegcdo Menu>Project>Project Settings>Pasta Origin Description

Resultados: Apds preencher as tabelas, o botdo de calculo deve ser acionado para

dar continuidade ao projeto. O programa adota valores estimados para os dados

que nao forem preenchidos. Entretanto, observar que os dados marcados com (*)

devem ser preenchidos obrigatoriamente pelo projetista. Caso esses valores néo

sejam preenchidos, ap6s acionar no botao de calculo, os dados serédo pedidos nas

barras de mensagem.

d) Solicitagédo de informacdes pelo PARLA

Apbs fornecer todos os dados, isto €, preencher as trés planilhas, ao acionar o

botdo de calculo, PARLA, solicita as informagbes esquecidas e obrigatorias.

Ver figura 5.9. Notar que para todos os demais dados, ndo obrigatérios e que

nao tenham sido fornecidos, PARLA adota valores estimativos iniciais para

célculo, e também calcula os itens de regras, tais como, comprimento de regra,

coeficiente de bloco de e regra, altura onda de regra, etc.

e) Adverténcia

Depois de completadas as trés planilhas, caso o usuario tenha assumido os

defaults, ao acionar o botdo de calculo a seguinte mensagem aparecera na

tela:
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“‘Beware! All default values are preliminary, only for preliminary Project
purposes. If you need more accurate values, please, review all input data.” Ver
figura 5.10.

Projectparlal 5[

Beware! All default values are preliminary, only for preliminary project purposes, If you need more accurate values, please review all
input data

Figura 5.10: Selegcédo Menu>Project>Project Settings>Pasta Main Dimension

Alerta sobre valores preliminares adotados

Esta mensagem alerta o projetista, que todos os dados estimados séo
preliminares, e que para calculos mais precisos, os mesmos devem ser

informados pelo projetista com maior preciséo.

f) Dar continuidade aos calculos
Para poder dar continuidade ao calculo, o botdo OK deve estar habilitado. Isto

s6 acontece ap6s apertar o botdo de calculo.

Correcdo de erros: Ap6s acionar na seta “OK”, o projetista estard apto a dar
continuidade aos calculo. Entretanto se o projetista notar que cometeu algum erro, o
mesmo deve acionar novamente Project > Project Settings e repetir os passos que

foram apontados anteriormente.

5.6.3 Plano de linhas

Menu: >Project

>[ines

O comando Lines na barra de ferramentas abre o plano de linhas

T PARLA
File | Project Calculations Rules

Praoject Settings

Frames Spacing
Hull Bulkheads

comparitments

Figura 5.11: Selecdo Menu>Project>Lines
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Descricao: O projetista pode escolher a visualizagéo das linhas de balizas, linhas da
vista superior, linhas do alto e perspectiva, através dos botdes posicionados a direita e
a esquerda da tela. Ver figuras 5.12, 5.13 e 5.14 Para o caso do plano de balizas,
através do botdo de rolagem, o projetista pode escolher uma secéo especifica para

visualizagéo.

Entrada de Dados: Ndo ha necessidade de entrar com nenhum dado, pois todos os

dados desta se¢do foram importados.

a. Para visualizar as diferentes se¢des, o botdo de sec¢des deve ser acionado na

barra de rolagem de selegéo a direita. Ver figura 5.12.

T Lines BEI
o
- — A
10136 2-6.193 Hull File: BAR1,DAT =|ﬂ\\o \
SectionNo.  Long'l location (m)
10 4|e| [750E
fl 2 chine

1 0,000 0,000 k

2 4151 1511 |01

3 4500 5500 d

4 0,000 5500 LC

video zero
4 | ;IJ
cb'miciar| J 1) PARLAOS0110 | ) Documento1 - Microsoft ... | 8 Delhi 7 | ¥ Projectparlal J | « W™ R 2130

Figura 5.12: Selegdo Menu>Project>Lines>Section Button>Frames selection
As coordenadas de qualquer ponto da secéo selecionada poderéo ser obtidas
com o mouse simplesmente rolando sobre a imagem. Essas coordenadas

serao indicadas no alto da figura a esquerda.

b. Para visualizar as linhas do alto, o botdo referente deve ser acionado. Ver
figura 5.13.
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LI

ExT
Hull File: BAR1,DAT
g e =
1 Iniciar| | S parLaso1i0 | 881 Documento1 -Migasoft .. | & Delphi 7 |3 pros | ‘ « W ® R 2130

Figura 5.13: Selegcédo Menu>Project>Lines Button>Profile selection

Para visualizar as linhas da vista superior, o botao referente deve ser acionado.

C.
Ver figura 5.14
sl
Bl
Hull File: BAR1,DAT r == “
4] | _’ILI
) icar] | 3 PARLACSO110 | 881 Documentoz -Miarosoft ... | o Delphi 7 [ Projectpariat | ‘ « gy W Ry 21:30

Figura 5.14: Selecdo Menu>Project>Lines>Button Plan Lines selection
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d. Para visualizar a perspectiva, acionar o botdo da referente. Ver figura 5.15

EXIT

18]
Hull File: BAR1,DAT El‘ e

4] | _’I;I
& iciar] | (£ PaRLA0S0110 | ) pocumentoz - Microsoft .. | 7 Deiphi 7 |[@ projectpariar J| « M=) B 2031
Figura 5.15: Selecdo Menu>Project>Lines Button Perspective selection

e. Para visualizar o plano de linhas completo, incluindo a legenda, deve ser

acionado o botao das linhas do alto e dar um clique duplo com botao esquerdo
do mouse sobre a figura. Para voltar a forma original, acionar o botao esquerdo
do mouse com um clique duplo novamente nas linhas do alto. Ver figura 5.16 e
5.17.

Resultados: Os resultados sdo puramente graficos. Ver figuras 5.12, 5.13, 5.14 € 5.15

Corregbes: Como o plano de linhas é importado, ndo ha possibilidade de corrigir dados

da forma. Para corre¢bes do arquivo, voltar ao passo inicial. Ver item 5.6.1
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Figura 5.16: Selecdo Menu>Project>Lines>Com duplo clique sobre a imagem o plano

de linhas é apresentado por completo.
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Figura 5.17: Selegcdo Menu>Project>Lines Com duplo cligue novamente sobre a

imagem do perfil, a tela volta ao normal com uma unica figura.
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5.6.4 Selegdo do espagamento de cavernas

Menu: >Project

>Frames Spacing

Descrigdo: Ao ser acionado este botédo o projetista deve obrigatoriamente informar qual
0 espacamento de cavernas pretendido. Esses espagcamentos poderao variar de

regido para regiao, ao longo do comprimento do navio.

Entrada de dados: A definicdo do espagamento de cavernas ao longo da embarcagéo
€ um dado de entrada do programa. Essas instrugbes s&o dadas através do teclado na
planilha da direita e ao alto, digitando a primeira, a ultima caverna e o espagamento

desejado entre cavernas em cada linha. Ver figura 5.20.

Apos definir esse espagamento em cada linha, um clique duplo com o botdo esquerdo
do mouse na célula Spacing deve ser dado, e as cavernas serdo posicionadas no
perfil pelo PARLA.

Telas:
a. Para apresentagado da tela principal de posicionamento das cavernas, a

barra de Menu>Project>Frames deve ser acionada. Ver figura 5.18.

Calculations  Rules

Project Settings
Lines
Frames Spacing
Hull Bulkheads
cormpatkrments

Figura 5.18: Selecdo Menu>Project>Frames Spacing

b. Na tela principal, o espagcamento de cavernas deve ser informado, através
da tabela apresentada no canto superior a direita. Os espagamentos
podem ser variaveis, a critério do projetista. Sobre a tabela, os valores da
caverna inicial, final e o espagcamento de cavernas deve ser fornecido.
Para dar entrada a um novo espagamento de cavernas, um clique duplo

com o botéo direito do mouse, deve ser dado. Ver figuras 5.19 e 5.20.
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Figura 5.19: Selecédo Menu>Project>Frames Spacing>apresentacéo da tela principal.
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Figura 5.20: Selecdo Menu>Project>Frames Spacing>Escolha dos espagamentos de

cavernas.
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c. Para selecionar as linhas de alto para visualizacdo, a barra de rolagem

7 Frames Spacing

Exit

X=;er3  ZF7E%

“Line n.” deve ser acionada. Ver figura 5.21.

e

=] —l=

~Longtudinal Lines——————
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~  spline factors

o Hull File: BAR1,DAT

Line No Line Name

[z fea
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Spline Interpolation
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Figura 5.21: Selecao Menu>Project>Frames Spacing> botao de rolagem para as

linhas do alto, utilizando a carenagem por SPLINE.

d.

Para visualizar os coeficientes das Splines utilizados para obter as
cavernas, o botao “Spline Factors Open” deve ser acionado. Uma tabela
aparece na tela para consulta, apresentando todos os coeficientes das
equacgdes das Splines Cubicas. Ver figura 5.22.

Uma grade podera ser acrescida ou retirada na figura a critério do
projetista. Ver figuras 5.23, 5.24 e 5.27.

Para visualizar o plano de cavernas, o respectivo botao através da barra
de selegdo na tabela a direita deve ser acionado. As se¢bes podem ser
visualizadas uma a uma através do botado de rolagem. Ver figura 5.25.
Para visualizar o plano de linhas da vista superior, o respectivo botao
assinalado e através da barra de rolagem de selecao na tabela a direita
deve ser acionado. Ver figura 5.26.

Para obter as coordenadas de qualquer ponto sobre as figuras
geomeétricas, os valores seréo apresentados no topo superior a esquerda
através do posicionamento do mouse sobre o mesmo. Ver figuras 5.19,
5.20, 5.21, 5.23, 5.24, 5.25, 5.26 e 5.27.
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Figura 5.22: Selegcdo Menu>Project>Frames Spacing>Apresentacdo da tabela com
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Figura 5.24: Selegcédo Menu>Project>Frames Spacing> Grade desenhada.
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Resultados: No final do processo, as cavernas estardo representadas sobre o perfil

longitudinal.

Correcbes: Para alterar os espagamentos de cavernas selecionados, clicar com o
botdo direito do mouse sobre a tabela de espacamentos, canto superior a direita, e
apagar as linhas dos espacamentos que serdo alterados. Fornecer os dados de

espacamentos corrigidos e seguir os passos apontados acima.

5.6.5 Definigcdo das posi¢coes das anteparas

Menu: >Project

>Bulkhead
Descricdo: O comando “Bulkheads” permite ao projetista definir as posi¢cdes das
anteparas ao longo do comprimento da embarcag¢do. Com relagdo a antepara de pique
tanque de vante, PARLA informa a regido longitudinal onde a mesma pode ser

instalada, entretanto fica a cargo do projetista escolher a sua melhor posigéo.

Entrada de dados: As posi¢cbes sdo informadas ao PARLA clicando na caixa de

selecdo sobre a caverna selecionada. Ver figura 5.30.

Telas:
a. Para a apresentacdo da tela principal, o botdo da barra de menu Project

Settings> Bulkhead deve ser acionado. Ver figura 5.28.

Calculations

Project Settings
Lines

Frames Spacing
Hull Bulkheads
compartments

Figura 5.28: Selecédo Menu>Project>Bulkheads

b. A figura 5.29 apresenta a tela principal, com o perfil, barra de rolagem de

cavernas, caixa de selecido de posicionamento de antepara.
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Figura 5.29: Selecédo Menu>Project>Bulkheads>Apresentacéo da tela principal.

Para selecionar as cavernas em que serao posicionadas as anteparas, a barra
de rolagem de cavernas deve ser acionada, € quando a barra de rolagem
estiver sobre a caverna escolhida a caixa de selegcdo “Bulkhead” deve ser
selecionada. Notar que no canto superior a direita, PARLA informa a regido em
que a antepara do pique tanque de vante deve ser posicionada. O
posicionamento final ficara a cargo do projetista. Ver figura 5.30.

Para acrescentar e retirar a grade o respectivo botdo no quadro de ferramentas
deve ser acionado. Ver figura 5.31.
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Figura 5.30: Selecdo Menu>Project>Bulkheads>Selecao das posi¢bes das anteparas.
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Corregdes: Para retirar uma antepara posicionada erroneamente, a barra de rolagem
deve ser posicionada sobre a caverna desejada e o botdo “ERASE” deve ser
acionado. A antepara é apagada dos arquivos, e se houver necessidade de uma nova

antepara, 0s mesmos passos acima devem ser seguidos.

Resultados: No final do processo as anteparas estardo representadas sobre o perfil
longitudinal. Uma determinada antepara sera realgada quando a barra de rolagem

estiver posicionada sobre a caverna em que a mesma estiver localizada.

5.6.6 Compartimentagem

Menu: >Project

>Compartments

Descricdo: O comando “compartments” permite ao projetista definir todos os
compartimentos da embarcacéo, estanques e nao estanques, assim como casarias,

paidis, etc..

Entrada de dados: A entrada de dados se da através de um clique duplo com o botéo
esquerdo do mouse nos pontos que definem os compartimentos. Notar que os pontos
devem ser dados formando uma figura fechada, de forma que o ultimo ponto coincida
com o primeiro. O numero de pontos deve ser igual em todas as secdes, e 0os pontos
escolhidos no sentido horario ou anti-horario devem ter continuidade um a um, isto &, a
interligacdo do primeiro ponto da primeira se¢do quando ligado ao primeiro ponto da

segunda secéao formara a linha de uma das quinas ou linhas do tanque.

a. Para abrir esta secao, a barra de menu >Project Settings>Compartments deve

ser acionada. Ver figura 5.32.

Calculations  Rules

Project Settings
Lines

Frames Spacing
Hull Bulkheads
comparktments

Figura 5.32: Selecao Menu>Project>Compartments
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b.

Para acrescentar e tirar grade sobre a figura os botdes correspondentes devem

ser acionados. Ver figuras 5.33 e 5.34.

N x|
Pleaze input gnd spacing

E

k. I Cancel

Figura 5.33: Selegédo Menu>Project>Compartments>

selecéo de espacamento de grade.

K ==

—campartrmenk
Frame Long’l location {m)

]
E@gﬂ’ﬂt name

Figura 5.34 : Selecao Menu>Project>Compartments>

Retirando a grade.

Para desenhar um compartimento, seleciona-se a primeira caverna do mesmo
através da barra de rolagem de cavernas. A ordem de entrada de dados deve
ser sequencial de vante para ré ou de ré para vante.

O compartimento é identificado por um nome no quadro superior a direita.

A secdo do compartimento deve ser demarcada através de dois cliques em
cada vértice. O numero de pontos deve ser igual em todas as segbes, e 0s
pontos da sec&o anterior deverao ser correspondentes ao da sec¢ao seguinte.
Ver figura 5.35.

O passo acima deve ser repetido para as demais se¢bes dos compartimentos.
As secbes devem ser definidas de forma tal a mostrarem as variacées do
referido compartimento. Compartimentos curtos e prismaticos podem ser

definidos com apenas duas se¢des. Ver figura 5.36.
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‘ Hull File: BAR1,DAT

O numero de compartimentos a ser definido ficara a critério do projetista. A
figura 5.37 apresenta 3 compartimentos.

(Atencao! Ao iniciar a entrada de dados de cada compartimento, acionar o
botédo de rolagem indicando o numero do compartimento.)

Para ver o desenho em perfil dos compartimentos, clicar no respectivo botéo.
Ver figura 5.38.

Para ver o desenho em planta dos compartimentos, clicar no respectivo botao.
Ver figura 5.39.
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Figura

537 Selecdo Menu>Project>Compartments>Desenhando  todos os

compartimentos.
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Resultados: Apdés a entrada de dados de todas as secbes e de todos os
compartimentos, as suas figuras geométricas com suas posicbes, nomes e
coordenadas ficam gravadas internamente no programa, de modo a permitir o calculo
de sua estrutura nas fases posteriores. Desta forma, é possivel calcular qualquer
antepara, estanque ou ndo estanque, duplo fundo, divisérias e laterais de casarias,

etc..

Corregcbes: As corregcdes de coordenadas do compartimento podem ser feitas
diretamente na tabela, quadro da direita, via teclado. No fim das corre¢cbes o botéao
“CORRECT” deve ser acionado. O projetista também pode optar em eliminar todos os

pontos da se¢do do compartimento, e neste caso deve clicar em “ERASE”.

5.6.7 Calculo estrutural

Menu: >Structure

Descricao: Através da barra de menu, ao acionar o botédo “Structure”, uma nova tela é
apresentada. Esta tela habilitara os calculos estruturais de todos os elementos de uma
embarcacédo de alta velocidade com casco prismatico em V. Nesta etapa dos calculos,
a forma da embarcagéo ja foi importada, o espagamento de cavernas ja foi fixado,
posicdes de anteparas definidas e os compartimentos também ja foram definidos.
Portanto, ap6s as etapas descritas anteriormente, para calcular todos os elementos
estruturais da embarcacao em estudo, o projetista deve seguir a ordem sequencial dos

comandos da barra de ferramentas.

N&o é obrigatorio calcular todos os elementos de uma segéo, ou todos os elementos
estruturais habilitados pelo PARLA, entretanto, caso o projetista calcule somente
alguns elementos, o0 mesmo devera estar ciente, que calculos do tipo, moédulo de

secao oferecido e calculo de peso e centro nao terdo validade.

O comando “Structure” habilita os calculos estruturais da embarcacgéo, tais, como,
chapas do casco, sicordas, transversais, longitudinais, chapas de anteparas
transversais e longitudinais, prumos de anteparas, gigantes de anteparas, estruturas
de casarias e superestruturas, calculo de pesos e centros, calculo de momento fletor

total e esforgo cortante, e calculo de médulo de se¢éo requerido e oferecido.
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Procedimentos:
a. Para visualizar a tela principal, o comando “Structure” deve acionado. Figura
5.40.

1 PARLA
File Project | Calculations Rules
||

Figura 5.40: Sele¢cdo Menu>Project>Structure>

b. Para dar inicio aos calculos é necessario clicar no comando de cavernas

transversais. Ver figura 5.41.
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Figura 5.41: Selegcdo Menu>Project>Structure>Cavernas

5.6.7.1 Chapas

Menu: >Structure

Barra de Ferramentas:> Plates

Descricao: Ao acionarmos o comando “Plates” na barra de ferramentas, abre-se um
quadro a direita, para ser preenchido pelo projetista. Alguns dados devem ser

informados ao PARLA de modo a possibilitar o calculo das chapas desejadas.
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Entrada de dados: A entrada de dados se dara através de um clique duplo sobre as
extremidades das chapas que se deseja calcular. Algumas informacdes adicionais
serao necessarias e deverao ser fornecidas via teclado, tais como, tipo de estrutura,
altura de tanque, altura do suspiro em relagéo ao eixo de referéncia vertical, altura do
compartimento e intensidade da carga distribuida externa, quando aplicavel. Apés
terem sido fornecidos todos os dados requeridos para calculo, o comando de calculo
devera ser acionado. Caso algum dado nado tenha sido informado, PARLA dara o

alerta, abrindo uma caixa de dialogo a ser respondida pelo projetista.

Procedimentos:
a. Para habilitar os calculos estruturais das anteparas acionar na barra de menu>

Structure>-barra de ferramentas >“Plates”. Ver figura 5.42.
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Figura 5.42: Selegdo Menu>Project>Structure>Plates-Selecionando o botdo chapas

para calculo.

b.  Na barra de rolagem escolher a caverna de calculo. Ver figura 5.43
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Figura 5.43: Selecdo Menu>Project>Structure>Selecionando uma caverna para

trabalho.

Um clique duplo deve ser dado sobre o ponto inicial e ponto final da chapa para
calculo. Preencher os dados solicitados na tabela a direita, tais como, tipo de
estrutura, espacamento de longitudinais, altura do tanque, altura do suspiro do tanque
em relacdo ao eixo de referéncia vertical, altura do compartimento, quando em convés
inferior ao convés das anteparas e carga distribuida sobre o convés, quando aplicavel.
Apos a escolha da chapa para calculo e fornecimento de todos os dados necessarios,

o comando calcular deve ser acionado. Se todos os dados forem preenchidos
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corretamente, as espessuras das chapas calculadas serdo indicadas na parte inferior
do quadro, “calculated thickeness”. Para este tipo de embarcagcédo é recomendavel a
utilizacdo de longitudinais com pequeno espagcamento, a fim de reduzir as espessuras
de chapas e permitir a redugéo de peso. No caso em que a opg¢ao do projetista for nao
colocar longitudinais, o valor do espagcamento devera ser o comprimento da caverna

nao suportada. Ver figura 5.44.
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Figura 5.44: Selecao Menu>Project>Structure>Plates - Resultado de célculo de uma

chapa selecionada.

C. O procedimento de calculo devera ser repetido para todas as chapas. Ver
figura 5.45.
d. Para apresentacdo da tabela com todas as chapas calculadas, o comando

“OPEN scantlings and section modulus” deve ser acionado. Ver figura 5.46.

Resultados: As espessuras minimas requeridas de todas as chapas escolhidas séo
calculadas e indicadas no lado direito inferior da tela. A qualquer momento uma tabela
com todos os dados calculados pode ser aberta através do comando OPEN, na linha

de comando.
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Figura 5.45: Selecao Menu>Project>Structure>Plates- Todas as chapas calculadas.
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Figura 5.46: Selecdo Menu>Project>Structure>Plates>Botdo OPEN — apresentacio

das chapas calculadas em tabela.
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O programa calcula o valor minimo de regra. Para obter a espessura padrdo de
mercado, deve ser acionado o comando “Standard thickness”, Caso esse botdo nao

seja acionado, o valor da espessura da chapa escolhida é igual ao valor calculado

A espessura calculada ou padrdo de mercado escolhida € armazenada no programa e
sera utilizada como espessura de chapa colaborante para os calculos dos perfilados
dos painéis. Portanto, apdés o calculo dos perfis, ndo é aconselhavel voltar ao passo

anterior para corrigir as chapas.

Corregdes: Enquanto o botdo de calculo nado for acionado, todos os dados fornecidos
podem ser corrigidos diretamente na tela. Entretanto ap6s acionar o botdo de calculo,
se algum dado estiver errado, basta acionar o botdo “ERASE”, e os dados referentes a

chapa indicada na barra de rolagem serado apagados.

5.6.7.2 Longarinas Gigantes longitudinais

Menu: >Structure

Barra de Ferramentas:> Long’l Girder

Descricao: Ao acionar o botdo “Long’l Girder” na barra de ferramentas a direita o
projetista devera fornecer alguns dados para que o PARLA efetue os calculos
desejados. Este comando permitira o calculo das vigas gigantes longitudinais, tais

como quilhas, escoas e sicordas. Ver figura 5.47.

Entrada de dados: A entrada de dados se dara através de um clique duplo na posi¢céo
desejada para as longarinas gigantes. Também sera necessario informar qual o
espacamento das longarinas e qual o comprimento entre apoios, assim como qual o
numero da sua chapa colaborante. A chapa colaborante sera selecionada através do
respectivo botdo de rolagem aparecendo na tela destacada. Para evitar erros, PARLA
sempre avisara o projetista para escolher a chapa colaborante antes de iniciar

qualquer calculo.

Procedimento: A seguinte sequéncia devera ser adotada. Ver figura 5.47.

> Escolher a caverna de calculo através da barra de rolagem na tabela na parte
superior;
> Dar um duplo clique na se¢&o sobre a posigdo em que a viga sera posicionada;
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> Informar o vao da viga e a largura do painel que sera suportado;

> Informar o n. do painel da chapa colaborante da viga em calculo. O painel sera
selecionado através da barra de rolagem, e 0 mesmo acendera no local correto
quando corretamente selecionado.

> Acionar o botdo de calculo. Este comando apresentard o médulo e inércia
requeridos para viga em calculo.

> Informar os dados da viga no quadro inferior e clique sobre a viga. Se os dados
da viga estiverem abaixo dos requeridos, troque os valores da viga e clicar
novamente. Repita este passo até encontrar a viga apropriada.

> Quando a viga selecionada atender aos requisitos de modulo e inércia
minimos, clicar no botdo OK.

> (Atencéo! As dimensdes selecionadas deverdo obedecer as normas
internacionais sobre proporgdes requeridas)

> Ap6s acionado o botdo OK as longarinas gigantes calculadas serao

desenhadas na tela em suas respectivas posigoes.

> Repetir este processo para todas as longarinas gigantes.
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Figura 5.47:Selecao Menu>Project>Structure>Longitudinal Girder — Apresentagéo de

sicordas calculadas.
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Resultados: A qualquer momento o quadro com os resultados de calculo de todas as

vigas longitudinais gigantes pode ser aberto através do botdo “OPEN” e pasta “Long’l
Girder” Ver figura 5.48.

Correcgbes: Se houver algum erro na entrada de dados, antes de acionar calcular, os
dados podem ser corrigidos diretamente nos respectivos quadros. Ap6s o

acionamento do botéao de calculo, somente acionando o botdo “ERASE” para apagar a
viga com erro.
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Figura 5.48: Selegcdo Menu>Project>Structure>Longitudinal  Girder> OPEN —

Apresentacao de tabela das sicordas calculadas.

5.6.7.3 Transversais Gigantes
Sintaxe:
Menu: >Structure

Barra de Ferramentas:> Transverse Girder

Descricao: Ao acionar o botdo “Transverse Girder” na barra de ferramentas, o

projetista devera informar ao PARLA os dados necessarios para permitir o calculo de
vigas transversais gigantes.
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Entrada de dados: A entrada de dados se dara através de um clique duplo nas
extremidades da transversal. Também sera necessario informar qual o numero da sua
chapa colaborante. A chapa colaborante sera selecionada através do respectivo botao
de rolagem aparecendo na tela destacada. Para evitar erros, PARLA sempre avisara o

projetista para escolher a chapa antes de iniciar qualquer calculo.

Procedimento: Adotar a seguinte seqliéncia. Ver figuras 5.49 e 5.50.

> Escolher a caverna através da barra de rolagem na parte superior da tabela

> Dar um duplo clique sobre os pontos inicial e final da viga transversal a ser
calculada

> Informar o nimero do painel da chapa colaborante para a viga em calculo. O

painel sera selecionado através da barra de rolagem, e o0 mesmo acendera no
local correto quando corretamente selecionado.

> Acionar o botdo de calculo. Este comando apresentara o médulo e inércia
requeridos para viga em calculo.

> Informar os dados da viga no quadro inferior e dar um clique sobre a viga. Se
os dados da viga estiverem abaixo dos requeridos, troque os valores e clique
novamente. Repita este passo até encontrar a viga apropriada, com médulo e
inércia oferecidos superiores

> Quando a viga selecionada atender aos requisitos de moédulo e inércia

minimos, o botdo OK devera ser acionado.

> Apo6s acionado o botao OK, notar que a transversal calculada sera desenhada
na tela.
> Este processo devera ser repetido para todas as transversais.

Resultados: A qualquer momento o quadro com os resultados de calculo de todas as
vigas transversais pode ser aberto através do botdo “OPEN’ e pasta “Transversal
Girder”, Ver figura 5.51.

Corregdes: Se algum dado foi fornecido erroneamente, o mesmo pode ser corrigido na
respectiva tabela caso o botdo de calculo néao tiver sido acionado. Caso contrario o

botao “ERASE” deve ser acionado para apagar a viga em questao.
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transversais.
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Figura 5.51: Selegdo Menu>Project>Structure>Trasnversal Girder>OPEN —

Apresentacao da tabela das trasnversais calculadas.

5.6.7.4 Longitudinais comuns

Menu: >Structure

Barra de Ferramentas:> Long’l

Descrigdo: Ao acionar o botdo “Longl na barra de ferramentas a direita, o quadro
apresentara alguns dados que devem ser informados ao PARLA. Este comando
permitira o calculo das vigas longitudinais comuns, necessarias para estabilizar os

painéis.

Entrada de dados: A entrada de dados se dara através de um clique duplo nas
extremidades da transversal. Também sera necessario informar qual o numero da sua
chapa colaborante. A chapa colaborante sera selecionada através do respectivo botao
de rolagem, e ao ser selecionada, a mesma aparecera na tela destacada. Para evitar
erros, PARLA sempre abre uma caixa de dialogo informado ao projetista que deve

escolher a chapa colaborante antes de iniciar qualquer calculo.

Procedimento: A seguinte seqliéncia devera ser adotada.Ver figura 5.52

> Escolher a caverna através da barra de rolagem na tabela na parte superior.
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> Dar um duplo clique sobre os pontos inicial e final do chapeamento que
recebera as longitudinais.
> Informar o n. do painel da chapa colaborante das longitudinais em calculo. O
painel sera selecionado através da barra de rolagem, e o mesmo acendera no
local correto quando corretamente selecionado.
> Informar a posigdo da primeira longitudinal a partir do inicio do painel, ou
primeira coordenada fornecida.
> Acionar o botdo de calculo. Este comando apresentard o médulo e inércia
requeridos para as longitudinais em calculo. PARLA tomara o moédulo mais alto
das longitudinais para efeito de dimensionamento e selecgéo.
> Informar os dados dimensionais da longitudinal no quadro inferior e clique com
0 botdo esquerdo do mouse sobre o quadro. Se os dados da viga estiverem
abaixo dos requeridos, troque os valores da viga e cliqgue novamente. Repita
este passo até encontrar a viga apropriada.
> Quando a viga selecionada atender aos requisitos de médulo e inércia minimo
requeridos, clicar no botdo OK.
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Figura 5.52: Selecdo Menu>Project>Structure>Long I>Caélculo de Longitudinais.

>

Os passos acima devem ser repetidos para todas as chapas que tiverem

estrutura longitudinal. Ver figura 5.53
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Resultados: A qualquer momento o quadro com os resultados de calculo de todas as
longitudinais pode ser aberto através do botdo “OPEN” e pasta “Longitudinals”. Ver
figura 5.54.
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Figura 5.53: Selecdo Menu>Project>Structure>Long’[>Apresentacdo de todos os

longitudinais calculados.
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Figura 5.54: Selecao Menu>Project>Structure>Long I>Apresentacao de tabela com

todos os Longitudinais calculados.
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Correcbes: Se houve erros na entrada de dados, antes de acionar o botdo de
célculo,os dados podem ser alterados nas proprias tabelas. Ap6s acionar o botdo de

célculo, os dados podem ser apagados através do botao “ERASE”.

5.6.7.5 Calculo do Peso e Centro de uma caverna tipica

Menu:> Structure
Barra de Ferramentas:> OPEN

Pasta:> “Weight and CG”

Descricao: Ao abrir a pasta “Weight and CG”, o botao “calcular’ deve ser acionado.
PARLA efetuara os calculos de uma segéo, considerando um comprimento igual meio
espacamento a esquerda e meio espagcamento a direita da caverna considerada.
Todos os pesos dos elementos estruturais calculados da referida caverna serdo
considerados. Com apenas uma Unica caverna calculada, de preferéncia a meia nau,
PARLA ja pode fornecer uma estimativa de Peso e CG. Caso um maior o nimero de

cavernas sejam calculadas, maior sera precisdo do Peso e Centro calculados.

As cavernas que néo tiverem sua estrutura calculada terdo seus pesos proporcionais
aos seus Girths, suas posicdes transversais proporcionais as bocas e posi¢des

verticais proporcionais aos pontais da referida caverna.

5.6.7.6 Calculo do chapeamento de anteparas

Menu: >Structure

Barra de Ferramentas:>Bulkheads

Descri¢cao: Ao acionar o botdo “BKHD” na barra de ferramentas, o projetista devera
informar ao PARLA os dados necessarios para permitir os calculos do chapeamento

das anteparas.
Procedimento: A seguinte seqliéncia deve ser adotada. Ver figura 5.55

> Escolher a caverna através da barra de rolagem na tabela na parte superior em

que foi posicionada a antepara,
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> Dar um duplo clique sobre os pontos limites da antepara em estudo, sendo que
o ultimo ponto deve coincidir com o ponto inicial de modo a fechar os limites da
figura geométrica.

> O numero de figuras geométricas desenhadas dentro de uma mesma antepara
fica a cargo do projetista. Cada figura geométrica podera ter espessuras
diferentes em funcdo de sua funcéo ou da altura manométrica do ponto mais
baixo. Esta ferramenta permite ao projetista definir até mesmo pequenos
painéis de anteparas dentro de uma mesma caverna.

> Definir um espacamento de gigantes transversais e um espagamento para
prumos verticais. Se ndo houver gigante transversal, atribuir um valor maior
que a altura do tanque. Este valor definira a propor¢gao geométrica do painel.

> Definir a altura topo do tanque e a altura da parte superior do suspiro em
relagéo a referéncia vertical adotada.

> Acionar o botdo calcular para obter a espessura de cada figura geométrica
criada. Portanto para uma mesma caverna poderemos ter varios painéis ou

varias fiadas com espessuras diferentes.
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Figura 5.55: Selegcdo Menu>Project>Structure>Bkhd>Calculo de Anteparas.

|»
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Resultados: A qualquer momento através do botdo OPEN o projetista podera obter os

valores calculados.

Correcbes: Se algum ponto foi fornecido erroneamente e o botdo calcular n&o tiver
sido acionado, basta clicar sobre a tabela a direita com o botdo direito do mouse e o
mesmo sera retirado. Os demais valores fornecidos também podem ser modificados,
Entretanto, apdés o acionamento do botdo de célculo, se houver necessidade de

corre¢des adicionais, o botdo “ERASE” deve ser acionado.

5.6.7.7 Calculo de Vigas Gigantes em anteparas

Menu: >Structure

Barra de Ferramentas:> Bulkhead Girders

Descrigdo: Ao acionar o botdo “BKHD GIRDER’ na barra de ferramentas, o projetista
devera informar ao PARLA os dados necessarios para permitir os calculos dos

gigantes transversais das anteparas.

Procedimento: A seguinte seqliéncia devera ser adotada. Ver figura 5.56.
> Escolher a caverna através da barra de rolagem na tabela na parte superior em

que foi posicionada a antepara.

> Dar um duplo clique sobre os pontos inicial e final da viga gigante,
> Definir um espagamento de gigantes transversais,
> Selecione o numero da “bulkhead part’, ou seja, selecione uma das figuras

geométricas da antepara que foram dadas para calculo, onde a viga gigante
sera posicionada.
> Quando todos os dados ja tiverem sido fornecidos, clique no botdo calcular

para obter o modulo e inércia requeridos,

> Selecione as dimensbes da viga para satisfazer os modulos e inércias
requeridos,

> Apbs tudo fornecido, viga selecionada, acionar o botao “OK”,

> Os passos acima deverao ser repetidos para todas as vigas gigantes que

houverem no projeto.

Resultados: A qualquer momento através do botdo OPEN, o projetista podera obter os

valores calculados.
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Corregdes: Se algum ponto foi fornecido erroneamente e o botdo calcular nao tiver

sido acionado, basta clicar sobre a tabela a direita com o botdo direito do mouse e o

mesmo sera retirado. Os demais valores fornecidos também podem ser modificados.

Entretanto, ap6s o acionamento do botdo de calculo, se houver necessidade de

corregdes adicionais, o botdo “ERASE” deve ser acionado.
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Figura 5.56: Selegcdo Menu>Project>Structure>Bkhd Girder>Calculo de refor¢o gigante

5.6.7.8 Calculo de reforgos comuns em anteparas

Menu: >Structure

de Anteparas.

Barra de Ferramentas:> Bulkhead Stiffeners

Descricao: Ao acionar o botao “bkhd stif’ na barra de ferramentas, o projetista devera

informar ao PARLA os dados necessarios para permitir os calculos dos reforcos

comuns das anteparas.

Procedimento: Adote a seguinte seqiiéncia. Ver figura 5.57.
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> Selecionar a caverna de calculo. Esta caverna deve possuir uma antepara com
espessura previamente calculada.

> Dar um duplo clique sobre os pontos limites da antepara, formando uma figura
geométrica, delimitando o espagco onde serdo posicionados os reforgos
comuns ou prumos. O ultimo ponto deve coincidir com o ponto inicial de modo
a fechar os limites da figura geométrica, e o primeiro ponto deve coincidir com
a posicao do primeiro prumo,

> Confirmar o espagamento de prumos na tabela ao lado,

> Selecionar o numero da “bulkhead part’, ou parte da antepara em que estarao
posicionados os prumos. Se os prumos estiverem sobre duas “bulkheads
parts”.

> ApoOs a entrada de todos os dados necessarios solicitados no quadro a direita

ao lado, acionar o botao calcular para obter o médulo e inércia requeridos,

> Selecionar as dimensdes dos reforgos para satisfazer os modulos e inércia
requeridos,
> Quando todos os dados tiverem sido fornecidos e a viga tiver sido selecionada,

o botao “OK” devera ser acionado,
> Repetir os passos acima para todos os perimetros desejados para

posicionamento de prumos.
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Figura 5.57: Selegdo Menu>Project>Structure>Bkhd Stif>Célculo de prumos de

Anteparas.
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Resultados: A qualquer momento através do botdo OPEN, o projetista podera obter os

valores calculados.

Correcbes: Se algum ponto foi fornecido erroneamente e o botdo calcular n&o tiver
sido acionado, basta clicar sobre a tabela a direita com o botdo direito do mouse e o
mesmo sera retirado. Os demais valores fornecidos também podem ser modificados.
Entretanto, apdés o acionamento do botdo de célculo, se houver necessidade de

corre¢des adicionais, o botdo “ERASE” deve ser acionado.

5.6.7.9 Calculo de Peso e Centro de uma antepara

Menu: >Structure
Barra de Ferramentas:> OPEN
Pasta:> Bulkhead Weight

Descricdo: Ao abrir a pasta Bulkhead Weight, o botdo de calculo deve ser acionado,
para permitir o calculo do peso e centro da antepara selecionada.
Notar que as demais anteparas, ndo calculadas, conservativamente terdo seus pesos

e centros proporcionais a area da antepara mais pesada definida estruturalmente.

5.6.7.10 Calculo do Médulo de Secgao

Sintaxe:

Menu: >Structure

Barra de Ferramentas:> OPEN

Pasta:> Section Modulus

Descricao: Ao abrir a pasta Section Modulus o botédo de calculo deve ser acionado,
para o calculo da se¢ao previamente dimensionada estruturalmente.

PARLA tomara como base todas as estruturas calculadas e assinaladas como
incluidas no médulo de secdo da viga navio, tais como, chapeamentos, longarinas

gigantes, longarinas comuns, anteparas longitudinais, duplo fundo, etc.

Procedimento:Adote a seguinte seqiiéncia. Ver figura 5.58.

> Apbs calcular qualquer sec¢ao acione o botdo “OPEN”,
> Selecione a pasta “Section Modulus”,
> Acione o botédo de calculo
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Resultados: Os valores de Moédulo e Inércia assim como o Momento total em
tosamento e alquebramento da segcéo em estudo seréo indicados na parte superior do

quadro. Ver figura 5.58..

Correcgbes: Quando forem acrescentados, eliminados ou corrigidos, bastara voltar a
pasta de médulo de sec¢éo e acionar o botdo de calculo. Todos os calculos serdo

revistos e os valores atualizados serdo indicados na referida tabela.
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Figura 5.58: Selegédo Menu>Structure>OPEN>Section Modulus

5.6.7.11 Calculo de Peso e Centro final

Menu: >Structure

Barra de Ferramentas:> OPEN

Pasta:> Final Weight

Descrigdo: Ao abrir a pasta Final Weight, o botdo de calculo deve ser acionado. O

programa calcula o peso estrutural estimado total do barco.
PARLA tomara como base os pesos das anteparas e cavernas calculadas, sendo que

os pesos das demais cavernas e demais anteparas serdo obtidos conforme ja

explicado anteriormente, ou seja, as anteparas nao calculadas terdo seus pesos
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proporcionais a area da antepara calculada mais pesada, e as cavernas nao

calculadas terdo seus pesos proporcionais aos Girths das cavernas calculadas.

Procedimento: A seguinte seqliiéncia de comandos deve ser adotada. Ver figura 5.59.

> Apoés calcular no minimo uma segdo e no minimo uma antepara, o botédo
“OPEN” deve ser acionado,

> Abrir a pasta “Final Weight’,

> E acionar o botdo de calculo.

Resultados: Os valores do peso final estimado da embarcagédo sera apresentado na

parte superior do quadro. Ver figura 5.59.

Corregbes: Quando elementos estruturais forem acrescentados, eliminados ou
corrigidos, bastara voltar a pasta de “Final Weight” e acionar o botdo de calculo. Todos

os calculos serao revistos e os valores atualizados serdo indicados na referida tabela.
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Figura 5.59: Sele¢do Menu>Structure>OPEN>Final Weight

5.6.7.12 Relatorio de Resultados

Menu: >Structure

Barra de Ferramentas:> Report Generator
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Descricdo: Ao acionar o botdo “Report Generator’, o PARLA vai apresentar uma
relacéo de itens que podem ser selecionados para gerar o relatério final de célculo.

Como “default’, PARLA estard com todos os itens acionados. Ver figura 5.60.
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Figura 5.60: Selecdo Menu>Project>Structure>Report Generator> Seleg¢do dos itens

calculados para impressao.

Resultados: O relatério sera gerado em fomato .txt, portanto o projetista podera

facilmente organizar o relatério da melhor forma que Ihe convier. Ver figura 5.61

O quadro Report Generator é obtido acionando-se o botdo Report Generator. Para

retirar esse quadro, basta acionar novamente o mesmo botéo.

Exemplo do relatério a ser fornecido:
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2 BAR1-STEEL-090224 - Bloco de notas

Arquivo  Editar Formatar Exibir  Ajuda

PI"DjEC‘E Mame: CREWBOAT 400PAS -~
Designer: Eng. Barile El
project Reference:Barl =
coordinates reference
Tongitudinal:aft Perpendicular
transversal: Longitudinal Center Line
vetical: Base Line
Aft perpendicular position:
water Line aft intersection position:o
PROJECT SETTIMWGS
Length overall fm): 39,000
Length BP my: 39,000
Lenght waterline (m): 35,038
Breadr tmy: 9,000
Breadth water Line m): 9,000
Depth (mj: 6,000
praft 1,600
Displacement (tun) 235
Block coefficient 10,454|
wave Height m):2,s2
pesign Speed Cknotsl: 33
Mumber of Passengers 11z
number of Crew 3
operation Area rUnrestricted ocean Service
service Factor 11
5t117 water Bending moment in Hogging(t.m)):519,77
5ti1] water Bending Moment in Sagging(t.m) :319,77
51117 water shearing rForce €ty 61,17
vertical acceleration at LCG (g):2,186
vartical acceleration at fTorward end Cg) 2,59
vertical acceleration at aft end (g):0,00
running trim Cdegree) 4
deadrise at ¢ (degree):lo
rules minimum values required for calculation
Lengt m):33, 087
prafr (m):l, 600
Block Coefficient :0,454
wave height (my:2,920
Trim (degrees):4, 000
Deadrise at LCG (degrees): 10 000

3

—_—
4 Iniciar 8% BARILE ) cros T BARL-STEEL-090224 .., [P BaR1-STEEL-090224 ...

cumentos il Cam tudio Yyl i Meus arqui

Figura 5.61 — Exemplo do relatério a ser impresso.

6. Exemplos de Aplicacao

6.1 Descricao dos barcos analisados

A presente dissertacao analisou trés barcos conforme relacionados a seguir:

6.1.1 Barco de 400 passageiros em ago

O arquivo utilizado para importar as formas dos cascos foi o arquivo BAR1.SAI

Caracteristicas principais:

Comprimento total: 39,00m
Boca maxima moldada: 9,00m
Pontal moldado: 6,00m

Calado de projeto: 1,60m

Deslocamento no calado de projeto:.235,00 ton

Velocidade de projeto: 32,00 nos

Navegacéo: mar aberto servicgo irrestrito
Coeficiente de Bloco: 0,454
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Velocidade : 32 nés

Materiais a serem utilizados:
Chapas e Perfilados: Aco ASTM A131 Grau A

6.1.2 Barco de 400 passageiros em aluminio

O arquivo utilizado para importar as formas do casco foi 0 arquivo BAR1.SAl

Os dados utilizados sdo os mesmos indicados em 6.1.1, exceto o material
utilizado que foi definido da seguinte forma:

Material das chapas : Aluminio 5083 H116 up to 38.0mm

Material dos reforgos: Aluminio6061 T6  extrusao

6.1.3 Barco Wolver2 em aluminio

O arquivo utilizado para importar as formas do casco foi o arquivo
Wolver2.SAl

Caracteristicas principais:

Comprimento total : 12,200 m

Boca maxima moldada: 12,200 m

Pontal moldado: 2,150 m

Calado: 0,750 m

Deslocamento: 15 ton

Coeficiente de Bloco: 0,533

Velocidade: 20 nés

Area de operacao : Servico Restrito

Material das chapas : Aluminio 5083 H116 até to 38.0mm
Material dos reforgos : Aluminio 5083 H112 extruséo

6.2 Descrigao do processo de projeto

Os barcos tiveram a sua geometria do casco importada de um arquivo do
tipo”.SAI” (.txt) do programa PHF [3].
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Os barcos calculados e selecionados estao dentro dos parametros requeridos

para calculo na utilizacao do PARLA.(Referir se ao item 3.1 desta dissertacéo)

Utilizando as ferramentas apresentadas pelo programa PARLA, a seguinte

sequéncia de trabalho foi estabelecida:

a- Escolha de material para cada barco;

b- Definicdo do espagcamento de cavernas;

c- Posicionamento de anteparas;

d- Definicdo da geometria dos compartimentos;

e- Calculo da espessura de uma caverna tipica;

f- Calculo dos elementos longitudinais gigantes;

g- Calculo dos elementos transversais;

h- Calculo dos elementos longitudinais de estabilizacao dos painéis;
i- Calculo das espessuras das fiadas de chapa de uma antepara tipica;
j- Calculo dos reforgos gigantes da antepara;

k- Calculo dos reforgos comuns da antepara;

[- Calculo do médulo de segao de viga navio;

m- Calculo dos momentos fletores e esfor¢os cortantes atuantes;

n- Revisdo quanto a flambagem dos elementos longitudinais;

o- Caculo do peso e centro da estrutura da embarcagdo em estudo.
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7. Discussao sobre os resultados

7.1 Resultados dos barcos calculados (itens 6.1.1 e 6.1.2)

Os itens 6.1.1 e 6.1.2 analisaram o mesmo barco com materiais diferentes. O item
6.1.1. apresentou os resultados do barco BAR1 em aco e o item 6.1.2 apresentou os
resultados do mesmo barco em aluminio. Propositalmente, os materiais selecionados,
embora de composi¢cbes quimicas diferentes, apresentam valores de resisténcia

admissivel proximos, para podermos comparar os resultados.

O barco Bar1 em ago apresenta um peso estrutural estimado de 110,3 ton, enquanto
que o mesmo barco em aluminio apresenta um peso estrutural de 41.4 ton. O peso

estrutural de um barco em aluminio € bem menor, o que ja era esperado.

O tema principal desta dissertacdo nédo € a analise de resultados, e sim a elaboragéo
de um programa para calculo estrutural, ficando a critério do projetista a opcao de
escolha do material. Entretanto, os dois exemplos desta dissertacdo apresentam as
diferentes possibilidades de solucdes estruturais e recursos que o programa PARLA

oferece ao projetista.

O custo do material e da mao de obra para a constru¢do de um barco de aluminio é
muito superior. Entretanto, o custo do barco ndo esta somente associado ao custo da
estrutura com sua méao de obra. Para barcos de passageiros, o luxo e o conforto
representam uma parcela consideravel do seu preco. Deve-se lembrar que os custos
dos equipamentos de uma forma geral sdo os mesmos, e a motorizagao principal pode
ser reduzida. Portanto, o projetista devera ter em mente que o peso estrutural € muito
importante, e que talvez, ap6s uma boa analise, este ndo sera representativo no custo

final.

O programa PARLA sera a ferramenta que dara respostas rapidas as diversas

solugdes propostas pelo projetista.
Deve ser observado que os dois modelos adotam uma estrutura transversal reforgada

por elementos longitudinais. Os elementos longitudinais, permitem a redugéo da

espessura de chapeamento, e também s&o importantes para evitarem deformacgdes
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excessivas oriundas do aquecimento por solda durante a fabricacdo, além serem

recomendados pelas regras do ABS[1].

7.2 Resultados do barco Wolver2 (item 6.1.3.)

Diferentes modelos de barcos foram estudados para atestar a confiabilidade do

programa.

PARLA também foi testado com o barco WOLVERZ2, adotando-se estrutura
transversal. A tensdo admissivel em flambagem para um painel em compressao em
estrutura transversal é inferior ao painel com estrutura longitudinal, logo o programa
acusou a flambagem da chapa de convés que estava com 4,76mm de espessura.
Essa chapa foi substituida por uma de maior espessura e padrdo comercial com

6,35mm. Ver resultados apresentados em 6.1.3

7.3 Calculos racionais

Embora a primeira vista as formulagbes das classificadoras paregcam totalmente
empiricas, apds analisadas criteriosamente, nota-se que as mesmas estao
relacionadas com as formulagdes teoricas, apresentando fatores de seguranca
praticos, que vao garantir que a embarcacao néo venha a sofrer rupturas indesejaveis.
Essas formulagbes de calculo e utilizadas pelo PARLA s&o apresentadas no capitulo 3

desta dissertacao.
Os fatores de seguranca adotados dentro das formulagbes sao modificados ao longo
do tempo considerando os avangos tecnoldgicos e o banco de dados de resultados

praticos de embarcac¢des em operagao que vai sendo ampliado.

Nao faz parte deste trabalho a analise das formulagbes das classificadoras, mas seria

um trabalho bastante interessante e que propomos para as novas dissertacdes.

7.4 Tradigao Naval

Ao longo da nossa historia de construgdo naval, notamos que, os estaleiros sempre

utilizaram os mesmos modelos estruturais ja adotados anteriormente. A evolugao

técnica sempre foi muita lenta.
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E muito facil entender que para o homem voar, calculos foram necessarios, e que para
o0 homem navegar, tudo ocorreu naturalmente. Primeiro se apoiou num tronco de
madeira, posteriormente sentou-se sobre o tronco de madeira, e por fim notou que

podia abrir um recesso no tronco e sentar confortavelmente no mesmo.

E importante aprender e investigar embarcacées semelhantes ja construidas.
Entretanto, o projetista deve ter a mente aberta para novos desafios de arranjos e
dimensionamento estrutural. Com o programa PARLA torna-se facil mudar o modelo
estrutural, isto €, mudar espacamentos, tipos de perfis, materiais, etc, e em pouco

tempo obter diferentes solugdes.

8. Conclusoes

Este projeto apresenta um passo adicional no desenvolvimento do sistema
computacional para embarcagdes e plataformas, denominado SFD SYSTEM (Solution
— Focused Design System), cuja estruturacao € baseada em processos de projeto com
foco na solugéo e interagdes multidisciplinares [2], que ja conta com varios médulos,
definicdo de forma de embarcacgdes [3] e para plataformas, definicdo da forma, calculo
das caracteristicas hidrostaticas (embarcagdes e plataformas), curvas cruzadas,
estabilidade, avaliacdo do comportamento em ondas de embarcagbes, equilibrio
dindmico (lanchas [4], aerobarcos, asas em efeito de solo e aerodeslizadores),
propulséo, etc. Foram citadas aqui apenas as referéncias das publica¢des utilizadas
neste trabalho. O software desenvolvido também evoluiu de um trabalho piloto e
simplificado de projeto estrutural de embarcagbes de até 90m, também estruturado

para o sistema [5].

O programa desenvolvido mostrou-se eficiente, por reduzir o tempo de calculo do
projetista e dando ao mesmo mais tempo para estudar um maior numero de
possibilidades estruturais. E importante lembrar que os calculos apresentados pelas
regras do ABS, “Guide for Building and Classing High-Speed Craft — October 2001°T1],

sdo muito trabalhosos e de utilizagdo demorada.

As premissas de tornar o PARLA um programa amigavel e que trabalhasse
interativamente com o projetista foram cumpridas. Para uma dada embarcacéo, o
programa importa a forma geométrica, compartimenta a mesma, calcula as pressoes

locais impostas a estrutura, espessura de chapeamento, elementos estruturais
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longitudinais e transversais, reforcos de anteparas, momento fletor atuante ao longo
da vida navio, médulo de secéo e inércias requeridas e oferecidas para as se¢des da
viga navio, aproxima as espessuras calculadas para valores comerciais, verifica os
elementos longitudinais em flambagem e, por fim, calcula o peso e centro de

gravidade da estrutura calculada.

Com apenas um clique duplo nos elementos desejados o projetista consegue obter os
escantilndes estruturais minimos. Com apenas um clique no botao direito do mouse, o
projetista pode apagar alguma informacdo fornecida erroneamente. Quando o
projetista esquece de dar uma informacgéo, necessaria para o calculo, PARLA alerta o
projetista sobre a informag&o necessaria. Se o projetista se antecipa na solicitacado de
algum calculo onde o mesmo precisa do desenvolvimento de alguma etapa anterior,
PARLA avisa o projetista para voltar.

A barra de ferramentas é bastante clara, apresentando figuras geométricas ou
inscricbes sobre os botdes. Adicionalmente, passando o mouse sobre os botdes, uma

descricdo sobre a fungdo do mesmo aparece na tela.

Finalmente, o projetista podera pedir um relatério dos valores fornecidos e dos
resultados. Uma tabela “Report Generator’ é apresentada ao clicar no respectivo
botdo, e o projetista podera optar sobre quais dados deverdo ser apresentados no
relatério. O relatério é apresentado em arquivo tipo .txt, portanto podendo ser
facilmente organizado pelo projetista da forma que melhor lhe convier para a emissao

de um relatério oficial.

Por se tratar de um trabalho académico, muito ainda pode ser inovado e melhorado. A
presente proposta, entretanto vai ajudar o projetista na concepcgédo estrutural de
embarcacgbes do tipo mono cascos de planeio apresentando resultados praticos e com
visualizagdo grafica simultdnea com bastante rapidez. Os dados vao servir de base

para um projeto de detalhamento construtivo.

O programa possui uma lista muito grande de atividades, calculo de todos os
elementos estruturais, incluindo casarias e superestruturas, calculo da resisténcia da
viga navio, calculo de pesos e centros, interagdo grafica e compartimentagem. Por se
tratar de um trabalho académico e por ter sido desenvolvido por um unico Engenheiro
programador, o presente programa podera e devera sofrer evolugdes. A parte grafica

devera trabalhar em 3D, as subrotinas de interpolagdo deverao ser aperfeicoadas, as
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entradas de dados deverdao ter mais opgdes, e serem mais claras ao projetista, a
entrada das formas geométricas devera ser mais abrangente, nao ficando limitadas ao
mono casco de fundo V, permitir a selecdo de unidades e também permitir o célculo de

embarcacbes de materiais compositos, que poderédo constar em futuro trabalho.

-

“A evolugdo faz parte da histéria do homem e é necessaria para manter a

motivagao da vida.”

O programa "AutoCAD” atual sofreu uma evolugdo muito grande em relacdo ao
primeiro “AutoCAD” que foi colocado no mercado. Da mesma forma o “Office”, e

muitos outros programas.

Da mesma forma com o PARLA, a versao atual devera evoluir para uma nova versao
baseada na experiéncia dos seus usuarios. Ja foram iniciados os estudos para a
proxima versao do “PARLA 2010”.

A contribuicdo do presente trabalho é entregar ao projetista uma ferramenta amigavel
que Ihe permita com rapidez e precisido estudar diferentes modelos estruturais e com

diferentes materiais, ago ou aluminio, para embarca¢gées mono casco de planeio.

Somente com a utilizagdo constante do programa para varias embarcagées, novas e
existentes, e por diferentes projetistas, é que podera dar ao PARLA os avangos e

amadurecimento desejaveis.

E importante lembrar que:

“A nossa maior ignorancia é nao sabermos o quanto somos ignorantes”
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ANEXO A — Resultados do programa PARLA referente aos barcos calculados

(Barcos apresentados em 6.1.1, 6.1.2 € 6.1.3)

A1- Nomenclatura utilizada no PARLA

XY, Z: coordenadas longitudinal, transversal e vertical dos itens em estudo em

relacdo aos eixos de referéncia

Yi,Zi: coordenadas do ponto inicial do elemento
Yf,Zf: coordenadas do ponto final do elemento
S: lado mais curto da chapa

I: lado mais longo da chapa
top tk: coordenada vertical do ponto mais alto do tanque
overflow: coordenada vertical do ponto de transbordamendo do suspiro

SM(Y/N): incluir (Y) ou ndo (N) no médulo de sec¢éao da viga navio

Type: posicionamento do elemento na estrutura: fundo, costado, etc.

tr: espessura minima requerida de calculo

t: espessura padronizada de mercado

tcol: espessura da chapa colaborante

scol: largura efetiva da chapa colaborante

bfl: largura do flange da viga a esquerda da alma

bfr: largura do flange da viga a direita da alma

tf: espessura do flange da viga ( bfl e bfr)

hw: altura da alma da viga

tw: espessura da alma da viga

SMr: modulo de sec¢éo requerido para viga calculada

Ir: momento de inércia requerido para a viga calculada

SMoff: moddulo de segé&o oferecido para viga escolhida

loff: momento de inércia oferecido para a viga escolhida

Aoff: area seccional oferecida para a viga escolhida

RI/L: indica se o perfil esta posicionado do lado direito ou do lado esquerdo do
chapeamento
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Para médulo de segéo da Viga Navio

Area: area seccional da sec¢éo da viga navio

Zna: coordenada vertical da linha neutra

Zdeck: distancia entre a linha neutra e o convés resistente da viga navio
Zbot: distancia entre a linha neutra e o fundo da viga navio

Inertia req: Momento de inércia requerido para a se¢do em estudo da viga navio

SMr: Modulo requerido para a secao em estudo da viga navio
Mth: momento fletor total em hogging
Mts: momento fletor total em sagging

Weight: peso da secao ou embarcacao (conforme item de calculo)

LCG: posicdo longitudinal do centro de gravidade em relacdo aos eixos de
referéncia

TCG: posido transversal do centro de gravidade em relacdo aos eixos de
referéncia

VCG: posicao vertical do centro de gravidade em relagédo aos eixos de referéncia
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A2- Lancha de 400 passageiros em ago

Arquivo: BAR1

Caracteristicas principais:

Comprimento total:...................oc.. 39,00m

Boca maxima moldada...................... 9,00m

Pontal moldado:........ccooevveviiiiiiiinnn. 6,00m

Calado de projeto:...........cceeeeeeeeeeeennn. 1,60m

Deslocamento no calado de projeto..235,00 ton

Velocidade de projeto:......ccvveeen. 32,00 Knots
Navegacao:......cccccvvvveeeiieiiiiiiieeeeeeee mar aberto servico irrestrito

Materiais a serem utilizados:
Chapas: Ago ASTM A131 Grau A
Perfilados: Aco ASTM A131 Grau A

Resultados do Programa PARLA

Project Name: CREWBOAT 400PAS - STEEL
Designer: Eng.Barile
Project Reference: BAR1

Coordinates referencia
longitudinal:  Aft Perpendicular
transversal:  Longitudinal Center Line

vetical: Base Line

Aft Perpendicular Position: 0
Water Line aft intersection position: 0
PROJECT SETTINGS

Length Overall  (m): 39,000
Length BP (m): 39,000
Lenght Waterline (m): 35,038
Breadt (m): 9,000

Breadth Water Line (m): 9,000
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Depth (m): 6,000

Draft (m): 1,600
Displacement  (ton): 235
Block Coefficient 0,454
Wave Height (m): 2,92

Design Speed (knots): 32

Number of Passengers : 12

Number of Crew : 3

Operation Area : Unrestricted Ocean Service
Service Factor : 1

Still water Bending Moment in Hogging(t.m): 519,77
Still Water Bending Moment in Sagging(t.m) : 519,77
Still Water Shearing Force (t): 61,17
vertical acceleration at LCG (9): 2,16

vertical acceleration at forward end (g): 2,5

vertical acceleration at aftend  (g): 0,00

running trim (degree): 4

deadrise at CG (degree): 20

Rules minimum values required for calculation

Length (m): 33,987
Draft (m): 1,600
Block Coefficient : 0,454
Wave height (m): 2,920
Trim (degrees): 4,000
Deadrise at LCG (degrees): 10,000
Vertical acceleration at LCG (9): 2,160
Vertical acceleration at forward end (g): 2,592

Vertical acceleration at aft end (9): 0,000

Collision bulkheads Position from 32,235 (m) to 33,286 (m)

Selected Material
Plating Material : Steel Grade A
Specific Weight (kgf/m3) 7800
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Ultimate Stress (kgf/lcm2) 4100

Yeld Stress (kgf/lcm2) : 2400
Elasticity Modulus (kgf/cm2): 2100000
Internals Material Steel Grade A
Specific Weight (kgf/m3) 7800

Ultimate Stress (kgf/lcm2) 4100

Yeld Stress (kgf/cm2) : 2400
Elasticity Modulus (kgf/lcm2): 2100000

Lines Sections

Number of Sections: 22

X (m):

0.000
4.128
4.500
0.000
X (m):

0.000 Number of Points: 4

4 Chine
(m)
0.000 k
1.103 C1
5.500 d
5.500 LC
1.752 Number of Points: 4
4 Chine
(m)
0.000 k
1.166 C1
5.500 d
5.500 LC
3.504 Number of Points: 4
4 Chine
(m)
0.000 k
1.215 C1
5.500 d
5.500 LC
5.256 Number of Points: 4
Z Chine
(m)
0.000 k
1.253 C1
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4.500 5.500 d

0.000 5.500 LC
X (m): 7.008 Number of Points:
Y Z Chine
(m) (m)
0.000 0.000 k
4.207 1.284 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 8.760 Number of Points:
Y Z Chine
(m) (m)
0.000 0.000 k
4.233 1.312 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 10.511 Number of Points:
Y Z Chine
(m) (m)
0.000 0.000 k
4.250 1.338 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 12.263 Number of Points:
Y V4 Chine
(m) (m)
0.000 0.000 k
4.255 1.368 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 14.015 Number of Points:
Y Z Chine
(m) (m)
0.000 0.000 k
4.243 1.405 C1
4.500 5.500 d

0.000 5.500 LC
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X (m): 15.767 Number of Points:

Y Z Chine
(m) (m)
0.000 0.000 k
4.210 1.451 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 17.519 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
4.151 1.511 C1
4.500 5.500 d
0.000 5.500 LC
X (m): 19.271 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
4.062 1.588 C1
4.418 5.515 d
0.000 5.515 LC
X (m): 21.023 Number of Points:
Y V4 Chine
(m) (m)
0.000 0.000 k
3.938 1.685 C1
4.306 5.536 d
0.000 5.536 LC
X (m): 22.775 Number of Points:
Y V4 Chine
(m) (m)
0.000 0.000 k
3.774 1.805 C1
4.158 5.563 d

0.000 5.563 LC
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X (m): 24.527 Number of Points:

Y Z Chine
(m) (m)
0.000 0.000 k
3.567 1.953 C1
3.971 5.598 d
0.000 5.598 LC
X (m): 26.279 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
3.312 2132 C1
3.741 5.641 d
0.000 5.641 LC
X (m): 28.031 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
3.005 2.345 C1
3.463 5.692 d
0.000 5.692 LC
X (m): 29.782 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
2.640 2.596 C1
3.134 5.753 d
0.000 5.753 LC
X (m): 31.534 Number of Points:
Y Z Chine
(m) (m)
0.000 0.000 k
2.214 2.887 C1
2.750 5.824 d
0.000 5.824 LC
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X (m): 33.286 Number of Points:

Y Z Chine
(m) (m)
0.000 0.000 k
1.721 3.223 C1
2.307 5.906 d
0.000 5.906 LC
X (m): 33.598 Number of Points:
Y 4 Chine
(m) (m)
0.000 0.000 k
1.627 3.288 C1
2.222 5.922 d
0.000 5.922 LC
X (m): 35.038 Number of Points:
Y V4 Chine
(m) (m)
0.000 1.600 k
1.159 3.607 C1
1.800 6.000 d
0.000 6.000 LC
X (m): 39.000 Number of Points:
Y 4 Chine
(m) (m)
0.000 6.000 k
0.000 6.000 C1
0.000 6.000 d
0.000 6.000 LC
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Frames Sections

first frame number: 0 last frame number: 39

X(m): 0.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.000

4.115 1.103

4.500 5.500

0.000 5.500

-4.500 5.500

-4.115 1.103

-0.000 0.000

X(m): 1.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.000

4.121 1.140

4.500 5.500

0.000 5.500

-4.500 5.500

-4.121 1.140

-0.000 0.000

X(m): 2.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 0.000

4.131 1.174

4.500 5.500

0.000 5.500

-4.500 5.500

-4.131 1.174

-0.000 0.000
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X(m): 3.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.144 1.202
4.500 5.500
0.000 5.500
-4.500 5.500
-4.144 1.202
-0.000 0.000

X(m): 4.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
4.158 1.227
4.500 5.500
0.000 5.500
-4.500 5.500
-4.158 1.227
-0.000 0.000

X(m):  5.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4174 1.248
4.500 5.500
0.000 5.500
-4.500 5.500
-4.174 1.248

-0.000 0.000
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X(m): 6.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.190 1.267
4.500 5.500
0.000 5.500
-4.500 5.500
-4.190 1.267
-0.000 0.000

X(m): 7.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
4.207 1.284
4.500 5.500
0.000 5.500
-4.500 5.500
-4.207 1.284
-0.000 0.000

X(m): 8.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.223 1.300
4.500 5.500
0.000 5.500
-4.500 5.500
-4.223 1.300

-0.000 0.000
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X(m): 9.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.000

4.236 1.316

4.500 5.500

0.000 5.500

-4.500 5.500

-4.236 1.316

-0.000 0.000

X(m): 10.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
4.246 1.330
4.500 5.500
0.000 5.500
-4.500 5.500
-4.246 1.330
-0.000 0.000

X(m): 11.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.253 1.346
4.500 5.500
0.000 5.500
-4.500 5.500
-4.253 1.346

-0.000 0.000
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X(m): 12.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.255 1.363
4.500 5.500
0.000 5.500
-4.500 5.500
-4.255 1.363
-0.000 0.000

X(m): 13.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
4.252 1.383
4.500 5.500
0.000 5.500
-4.500 5.500
-4.252 1.383
-0.000 0.000

X(m): 14.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.243 1.405
4.500 5.500
0.000 5.500
-4.500 5.500
-4.243 1.405

-0.000 0.000
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X(m): 15.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.227 1.429
4.498 5.500
0.000 5.500
-4.498 5.500
-4.227 1.429
-0.000 0.000

X(m): 16.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
4.204 1.458
4.502 5.500
0.000 5.500
-4.502 5.500
-4.204 1.458
-0.000 0.000

X(m): 17.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4171 1.492
4.506 5.499
0.000 5.499
-4.506 5.499
-4.171 1.492

-0.000 0.000
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X(m): 18.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.000
4.130 1.530
4.485 5.503
0.000 5.503
-4.485 5.503
-4.130 1.530
-0.000 0.000

X(m): 19.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 0.000

4.078 1.575

4434 5.512

0.000 5.512

-4.434 5.512

-4.078 1.575

-0.000 0.000

X(m): 20.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.000

4.015 1.626

4.374 5.523

0.000 5.523

-4.374 5.523

-4.015 1.626

-0.000 0.000
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X(m): 21.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 -0.000
3.940 1.684
4.308 5.536
0.000 5.536
-4.308 5.536
-3.940 1.684
-0.000 -0.000

X(m): 22.000 Number of Points: 7

Y V4 Chine
(m) (m)
0.000 0.000
3.852 1.749
4.228 5.550
0.000 5.550
-4.228 5.550
-3.852 1.749
-0.000 0.000

X(m): 23.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 -0.000

3.750 1.822

4.136 5.567

0.000 5.567

-4.136 5.567

-3.750 1.822

-0.000 -0.000
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X(m): 24.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 -0.000
3.634 1.905
4.031 5.587
0.000 5.587
-4.031 5.587
-3.634 1.905
-0.000 -0.000

X(m): 25.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 0.000

3.503 1.998

3.913 5.609

0.000 5.609

-3.913 5.609

-3.503 1.998

-0.000 0.000

X(m): 26.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.000

3.356 2.101

3.781 5.634

0.000 5.634

-3.781 5.634

-3.356 2.101

-0.000 0.000
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X(m): 27.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 -0.000

3.192 2.215

3.633 5.661

0.000 5.661

-3.633 5.661

-3.192 2.215

-0.000 -0.000

X(m): 28.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 -0.000

3.011 2.341

3.468 5.691

0.000 5.691

-3.468 5.691

-3.011 2.341

-0.000 -0.000

X(m): 29.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.002

2.810 2.479

3.287 5.725

0.000 5.725

-3.287 5.725

-2.810 2.479

-0.000 0.002
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X(m): 30.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 -0.002
2.590 2.630
3.089 5.761
0.000 5.761
-3.089 5.761
-2.590 2.630
-0.000 -0.002

X(m): 31.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 -0.007

2.351 2.794

2.873 5.801

0.000 5.801

-2.873 5.801

-2.351 2.794

-0.000 -0.007

X(m): 32.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.014

2.089 2.971

2.638 5.845

0.000 5.845

-2.638 5.845

-2.089 2.971

-0.000 0.014
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X(m): 33.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.018

1.805 3.164

2.384 5.892

0.000 5.892

-2.384 5.892

-1.805 3.164

-0.000 0.018

X(m): 34.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 0.228

1.500 3.366

2112 5.945

0.000 5.945

-2.112 5.945

-1.500 3.366

-0.000 0.228

X(m): 35.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 1.544

1.171 3.595

1.813 5.998

0.000 5.998

-1.813 5.998

-1.171 3.595

-0.000 1.544
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X(m): 36.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 2.897
0.857 4.000
1.439 6.027
0.000 6.027
-1.439 6.027
-0.857 4.000
-0.000 2.897

X(m): 37.000 Number of Points: 7

Y V4 Chine
(m) (m)

0.000 4.045

0.561 4.574

0.997 6.032

0.000 6.032

-0.997 6.032

-0.561 4574

-0.000 4.045

X(m): 38.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 5.057

0.277 5.259

0.510 6.020

0.000 6.020

-0.510 6.020

-0.277 5.259

-0.000 5.057
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X(m): 39.000 Number of Points: 7
Y Z Chine
(m) (m)
0.000 6.000
0.000 6.000
0.000 6.000
0.000 6.000
-0.000 6.000
-0.000 6.000
-0.000 6.000
Bulkheads
Frame:= 0 Longitudinal Position:=  0.000 (m)
Frame:= 5 Longitudinal Position:=  5.000 (m)
Frame:= 15 Longitudinal Position:= 15.000 (m)
Frame:= 25 Longitudinal Position:= 25.000 (m)
Frame:= 33 Longitudinal Position:= 33.000 (m)
compartments sections
compartment n.: 1 n. of sections: 19
X(m): 15.000 Number of Points: 3
Y 4
(m) (m)
1.993 0.675
2.004 2.507
4.296 2.496
X(m): 16.000 Number of Points: 3
Y 4
(m) (m)
1.991 0.703
2.006 2.507
4.253 2.498
X(m): 17.000 Number of Points: 3
Y Z
(m) (m)
1.989 0.731
2.008 2.507
4.210 2.500
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3

3

X(m): 18.000 Number of Points:
Y Z
(m) (m)
1.986 0.758
2.010 2.507
4.168 2.503
X(m): 19.000 Number of Points:
Y Z
(m) (m)
1.984 0.786
2.012 2.507
4.125 2.505
X(m): 20.000 Number of Points:
Y Z
(m) (m)
1.982 0.814
2.014 2.507
4.082 2.507
X(m): 21.000 Number of Points:
Y Z
(m) (m)
1.982 0.876
2.014 2.507
3.975 2.505
X(m): 22.000 Number of Points:
Y Z
(m) (m)
1.982 0.938
2.014 2.507
3.868 2.503
X(m): 23.000 Number of Points:
Y Z
(m) (m)
1.982 1.001
2.014 2.507
3.760 2.500
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X(m): 24.000 Number of Points:

Y 4
(m) (m)
1.982 1.063
2.014 2.507
3.653 2.498
X(m): 25.000 Number of Points:
Y 4
(m) (m)
1.982 1.125
2.014 2.507
3.546 2.496
X(m): 26.000 Number of Points:
Y V4
(m) (m)
1.653 1.004
1.678 2.500
3.375 2.496
X(m): 27.000 Number of Points:
Y 4
(m) (m)
1.325 0.882
1.343 2.493
3.203 2.496

X(m): 28.000 Number of Points:

Y z
(m) (m)
0.996 0.761
1.007 2.486
3.032 2.496
X(m): 29.000 Number of Points:
Y z
(m) (m)
0.900 0.795
0.906 2.484
2.708 2.496
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X(m):

Y Z
(m) (m)
0.803 0.829
0.806 2.482
2.385 2.496
X(m): 31.000 Number of Points:
Y Z
(m) (m)
0.707 0.864
0.705 2.479
2.061 2.496
X(m): 32.000 Number of Points:
Y Z
(m) (m)
0.610 0.898
0.605 2477
1.738 2.496
X(m): 33.000 Number of Points:
Y Z
(m) (m)
0.514 0.932
0.504 2.475
1.414 2.496

compartment n.:

Y z
(m) (m)

-2.004 0.686

-2.004 2.475

-4.307 2.496

X(m): 16.000 Number of Points:

Y z
(m) (m)

-2.004 0.712

-2.002 2.479

30.000 Number of Points:
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2 n. of sections:
X(m): 15.000 Number of Points:

3

3

3

3

19



-4.262 2.496
X(m): 17.000 Number of Points:
Y Z
(m) (m)
-2.004 0.737
-2.000 2.483
-4.217 2.496
X(m): 18.000 Number of Points:
Y z
(m) (m)
-2.004 0.763
-1.997 2.488
-4.172 2.496
X(m): 19.000 Number of Points:
Y Z
(m) (m)
-2.004 0.788
-1.995 2.492
-4.127 2.496
X(m): 20.000 Number of Points:
Y Z
(m) (m)
-2.004 0.814
-1.993 2.496
-4.082 2.496
X(m): 21.000 Number of Points:
Y z
(m) (m)
-2.004 0.880
-1.997 2.494
-3.981 2.492
X(m): 22.000 Number of Points:
Y Z
(m) (m)
-2.004 0.947
-2.001 2.492
-3.881 2.488
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X(m): 23.000 Number of Points:

Y 4
(m) (m)
-2.004 1.013
-2.006 2.490
-3.780 2.483
X(m): 24.000 Number of Points:
Y 4
(m) (m)
-2.004 1.080
-2.010 2.488
-3.680 2.479
X(m): 25.000 Number of Points:
Y V4
(m) (m)
-2.004 1.146
-2.014 2.486
-3.579 2.475
X(m): 26.000 Number of Points:
Y 4
(m) (m)
-1.672 1.018
-1.678 2.486
-3.390 2.479

X(m): 27.000 Number of Points:

Y z
(m) (m)
-1.339 0.889
-1.343 2.486
-3.200 2.482
X(m): 28.000 Number of Points:

Y z

(m) (m)
-1.007 0.761
-1.007 2.486
-3.011 2.486
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X(m): 29.000 Number of Points: 3

Y 4
(m) (m)
-0.906 0.791
-0.906 2.490
-2.692 2.486
X(m): 30.000 Number of Points: 3
Y 4
(m) (m)
-0.806 0.821
-0.806 2.494
-2.372 2.486
X(m): 31.000 Number of Points: 3
Y V4
(m) (m)
-0.705 0.851
-0.705 2.499
-2.053 2.486
X(m): 32.000 Number of Points: 3
Y 4
(m) (m)
-0.605 0.881
-0.605 2.503
-1.733 2.486

X(m): 33.000 Number of Points: 3

Y
(m)
-0.504
-0.504
-1.414

compartment n.:
15.000 Number of Points: 2

X(m):

Y
(m)
-2.004
2.004

z
(m)
0.911
2.507
2.486

3 n. of sections: 19
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X(m): 16.000 Number of Points:
Y Z
(m) (m)
-2.003 2.493
2.004 2.488
X(m): 17.000 Number of Points:
Y z
(m) (m)
-2.002 2.490
2.004 2.490
X(m): 18.000 Number of Points:
Y Z
(m) (m)
-2.001 2.486
2.004 2492
X(m): 19.000 Number of Points:
Y Z
(m) (m)
-2.000 2.483
2.004 2.494
X(m): 20.000 Number of Points:
Y Z
(m) (m)
-1.998 2.480
2.004 2.497
X(m): 21.000 Number of Points:
Y Z
(m) (m)
-1.997 2477
2.004 2.499
X(m): 22.000 Number of Points:
Y Z
(m) (m)
-1.996 2474
2.004 2.501
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X(m): 23.000 Number of Points:

Y Z
(m) (m)
-1.995 2.470
2.004 2.503
X(m): 24.000 Number of Points:
Y z
(m) (m)
-1.994 2.467
2.004 2.505
X(m): 25.000 Number of Points:
Y Z
(m) (m)
-1.993 2.464
2.004 2.507
X(m): 26.000 Number of Points:
Y Z
(m) (m)
-1.664 2.475
1.672 2.507
X(m): 27.000 Number of Points:
Y Z
(m) (m)
-1.336 2.485
1.339 2.507
X(m): 28.000 Number of Points:
Y Z
(m) (m)
-1.007 2.496
1.007 2.507
X(m): 29.000 Number of Points:
Y Z
(m) (m)
-0.904 2.496
0.906 2.509
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X(m): 30.000 Number of Points:

Y Z
(m) (m)
-0.801 2.496
0.806 2.511
X(m): 31.000 Number of Points:
Y Z
(m) (m)
-0.699 2.496
0.705 2.514
X(m): 32.000 Number of Points:
Y Z
(m) (m)
-0.596 2.496
0.605 2.516
X(m): 33.000 Number of Points:
Y Z
(m) (m)
-0.493 2.496
0.504 2.518

19 N. of plates: 10

X yi Zi yf

(m) (m) (m) (m)
19,000 -0,021 0,021 4,082
19,000 4,082 1,575 4,425
19,000 4,436 5,518 -4,457
19,000 -4,457 5,507 -4,093
19,000 -4,093 1,586 -0,021
19,000 2,004 0,793 1,993
19,000 1,982 2,496 4,157
19,000 -2,025 0,793 -2,014
19,000 -2,004 2,496 -4,168
19,000 -2,025 2,486 1,993

zf

(m)

1,575

5,607

5,518
1,596
0,021
2,496
2,518
2,496
2,496
2,486
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(m)

1,000
1,000
1,000
1,000
1,000
1,000
1,000
1,000
1,000
1,000



n. tk overflow w h

(m) (m) (m)

(m)
1 25
2 25
3
2,5
2,5
2,5
2,5
2,5
2,5

© 0 N o o &

N
o

© 0o N o o b~ WO DN -

-
o

6,26
6,26

6,26
6,26
6,26
6,26
6,26
6,26

yes
yes
yes
yes
yes
yes
yes
yes
yes

yes

type

bottom

side/transom

exposed freeboard deck

side/transom
bottom
tank boundaries
tank boundaries
tank boundaries
tank boundaries

internal decks

Longitudinal Girders

Frame n.:

Lgirder

A W N -

19 N. of Longitudinal Girders: 4

plate i

(m)
1 -0,021
3 4,436
3 4,436
3 4,436

187

Zi

0,021
5,518
5,518
5,518

tr
(mm)
11,34
6,66
3,55
6,65
11,34
6,05
5,89
6,05
5,89
3,04

yf

(m)
4,082
-4,457
-4,457
-4,457

(mm)
12,7
7,93
4,76
7,93
12,7
6,35
6,35
6,35
6,35
3,18

zf

1,575
5,518
5,518
5,518



Lgirder vy z S
(m) (m) (m)

tcol SMreq Ireq
(mm) (cm3) (cm4)

3

1 -0,011 0,011 4 2 12,7 2183 13500

2 2,004 5507 4 2 4,76 488 2089

3 -0,021 5,507 4 2 4,76 488 2089

4 -2,004 5,507 4 2 4,76 488 2089
Lgirder bfl bfr tf hw tw L/R

(cm) (cm) (cm)  (cm)  (cm)

1 15 15 1,6 40 1 0

2 5 5 0,79 35 0,79 180

3 5 5 0,79 35 0,79 180

4 5 5 0,79 35 0,79 180

Lgirder Aoff SMoff loff SM
(cm2) (cm3) (cm4)

88 2291 61577 yes
36 524 13190 vyes
36 524 13190 vyes
36 524 13190 vyes

A WO DN -

Transversal Girders

Frame n.: 19 N. of Transversalal Girders: 17

Tgirder plate yi zi yf zf
(m) (m) (m) (m)
1 1 0,000 0,011 1,993 0,793
2 1 2,004 0,782 4,104 1,575
3 2 4,104 1,596 4,157 2,529
4 2 4157 2,518 4,414 5,507
5 3 4,425 5507 1,993 5,518
6 3 1,993 5,518 -0,021 5,529
7 3 -0,011 5,539 -2,014 5,529
8 3 -2,004 5,518 -4,446 5,529
9 4 -4,457 5,507 -4,179 2,496
10 4 -4,168 2,518 -4,082 1,586
1 5 -4,093 1,596 -2,014 0,771
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12
13
14
15
16
17

Tgirder

© 00 N O 0o B~ ODN -

N G
w N =~ O

14
15
16
17

Tqirder

0 N O a0 B~ W0 N -

© 00 N O O

—_
o

2,141
2,245
0,935
3,000
2,432
2,014
2,003
2,442
3,024
0,936
2,237
2,142
1,714
2,164
1,714
2,153
3,997

bf
(cm)
10
10

15

7,5
7,5
7,5
7,5

-2,014
2,014
1,993
-2,004
-2,004
-2,004

bfr
(cm)
10
10
10

o O o o

0,771
0,782
2,496
0,761
2,507
2,507

tf
(cm)
0,95
0,95

0,95
0,65
0,65
0,65
0,65
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-0,011
1,993
4,157
-2,004
-4,157
1,993

SMreq
(cm3)
366
399
23
261
40
27
27
40
265
23
396
366
58
108
58
107
76

hw
(cm)
20
20
15
15
7,5
7,5
7,5
7,5

0,011
2,496
2,518
2,475
2,496
2,496

Ireq
(cm4)
1489
1703
25
1116
235
133
131
238
1141
26
1686
1492
142
335
142
330
690

tw

(cm)
0,95
0,95
0,95
0,95
0,65
0,65
0,65
0,65

L/R

r x - - - —



9 15
10 O
1 10
12 10
13 0
14 10
15 0
16 10
17 10
Tgirder Aoff
(cm2)
1 38
2 38
3 14
4 29
5 10
6 10
7 10
8 10
9 29
10 14
11 38
12 38
13 14
14 19
15 14
16 19
17 19

10
10

o O O O

SMoff
(cm3)
499
500
66
276
48

48

48

48
276
66
500
499
68
123
68
123
116

0,95

0,95
0,95

0,95

0,95
0,95

loff
(cm4)
8416
8510
830
3446
342
342
334
342
3446
830
8502
8416
892
1093
892
1091
882
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15
15
20
20

10
15
10
10

0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95

rxrr X0 X0 X0 XN A0 X



Longitudinals

Framen.: 19 N.
long plate i
(m)
1 1 0,000
2 1 0,000
3 10,000
4 1 0,000
5 1 0,000
6 1 0,000
7 1 0,000
8 10,000
9 24,104
10 2 4,104
11 2 4,104
12 2 4,104
13 2 4,104
14 2 4,104
15 2 4,104
16 3 4,436
17 3 4,436
18 3 4,436
19 3 4,436
20 3 4,436
21 3 4,436
22 3 4,436
23 3 4,436
24 3 4,436
25 3 4,436
26 3 4,436
27 3 4,436
28 3 4,436
29 3 4,436
30 3 4,436
31 3 4,436
32 3 4,436

of Longitudinal: 68

Zi yf
(m)  (m)
0,011 4,082
0,011 4,082
0,011 4,082
0,011 4,082
0,011 4,082
0,011 4,082
0,011 4,082
0,011 4,082
1,607 4,436
1,607 4,436
1,607 4,436
1,607 4,436
1,607 4,436
1,607 4,436
1,607 4,436
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
5,496 -4,414
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zf li
(m) (m)
1,575 0,500
1,575 0,984
1,575 1,468
1,575 1,952
1,575 2,436
1,575 2,920
1,575 3,404
1,575 3,887
5,518 0,500
5,518 0,989
5,518 1,479
5,518 1,968
5,518 2,457
5,618 2,946
5,618 3,436
5,491 -0,500
5,491 -0,991
5,491 -1,482
5,491 -1,974
5,491 -2,465
5,491 -2,956
5,491 -3,447
5,491 -3,938
5,491 -4,429
5,491 -4,921
5,491 -5,412
5,491 -5,903
5,491 -6,394
5,491 -6,885
5,491 -7,376
5,491 -7,868
5,491 -8,359

—
v o w3 @
N

S e e v s s e s s g1 01 O Ol Ol ol o1 o1 o

& S TS TS TS TS TS S IS HrS WA B S B S B S B BN, B S, I &) BN &) BRRNS IS B¢ ) B &



33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68

4 -4,446
4 -4,446
4 -4,446
4 -4,446
4 -4,446
4 -4,446
4 -4,446
5 -4,093
5 -4,093
5 -4,093
5 -4,093
5-4,093
5-4,093
5 -4,093
5 -4,093
6 2,004
2,004
2,004
1,971
1,971
1,971
7 1,971
8 -2,014
8 -2,014
8 -2,014
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004
9 -2,004

N N N o o

5,507 -4,104
5,507 -4,104
5,507 -4,104
5,507 -4,104
5,607 -4,104
5,607 -4,104
5,607 -4,104
1,586 -0,011
1,586 -0,011
1,586 -0,011
1,586 -0,011
1,586 -0,011
1,586 -0,011
1,586 -0,011
1,586 -0,011
0,782 1,993
0,782 1,993
0,782 1,993
2,507 4,157
2,507 4,157
2,507 4,157
2,507 4,157
0,782 -2,025
0,782 -2,025
0,782 -2,025
2,496 -4,168
2,496 -4,168
2,496 -4,168
2,496 -4,168
2,518 1,993
2,518 1,993
2,518 1,993
2,518 1,993
2,518 1,993
2,518 1,993
2,518 1,993
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1,575
1,575
1,575
1,575
1,575

0,500
0,992
1,485
1,977
2,470
1,575 2,962
1,575 3,454
0,011 0,500
0,011 0,984
0,011 1,469
0,011 1,953
0,011 2,438
0,011 2,922
0,011 3,406
0,011 3,891
2,486 -0,500
2,486 -0,901
2,486 -1,303
2,518 0,500
2,518 0,922
2,518 1,343
2,518 1,765
2,496 -0,500
2,496 -0,905
2,496 -1,309
2,507 -0,500
2,507 -0,916
2,507 -1,332
2,507 -1,748
2,515 0,500
2,515 1,000
2,515 1,499
2,515 1,999
2,515 2,498
2,515 2,998
2,515 3,497

ro RS S e, AR S A S, NS B S S IS S (S B S  NYS "R ) B S (S 'R S IS S 'R S IS (S ' IS )

SIS NS B NS IS NS, S S N S IS 'S S /IS )



long y z s | SM SMreq Ireq
(m) (m)  (m) (m) (cm3) (cm4)

1 0,467 0,190 ,5 1,000 yes 59 92
10919 0,363 ,5 1,000 yes 59 92
11,371 0,536 ,5 1,000 yes 59 92
11,823 0,709 ,5 1,000 yes 59 92
12274 0882 ,5 1,000 yes 59 92
12,726 1,056 ,5 1,000 yes 59 92
13,178 1,229 5 1,000 yes 59 92
13,630 1,402 ,5 1,000 yes 59 92
2 4146 2105 ,5 1,000 yes 15 17
24,188 2,593 ,5 1,000 yes 15 17
2 4,229 3,080 ,5 1,000 yes 15 17
24,270 3,568 ,5 1,000 yes 15 17
2 4312 4055 51,000 yes 15 17
2 4353 4543 51,000 yes 15 17
2 4,395 5030 ,5 1,000 yes 15 17
3 3936 5496 ,5 1,000 yes 8 8
3 3,445 5495 51000 yes 8 8
32954 5495 51000 yes 8 8
3 2462 5495 51000 yes 8 8
3 1971 5494 51000 yes 8 8
3 1,480 5494 51000 yes 8 8
30989 5494 51000 yes 8 8
30498 5494 51000 yes 8 8
3 0,007 5493 51000 yes 8 8
3-0,485 5493 5 1,000 yes 8 8
3-0,976 5493 5 1,000 yes 8 8
3-1,467 5492 5 1,000 yes 8 8
3-1,958 5492 5 1,000 yes 8 8
3-2,449 5492 5 1,000 yes 8 8
3-2,940 5491 51,000 yes 8 8
3-3,432 5491 51,000 yes 8 8
3-3,923 5491 5 1,000 yes 8 8
4-4403 5009 /51,000 yes 15 18
4-4,360 4,518 ,5 1,000 yes 15 18
4-4317 4,028 ,5 1,000 yes 15 18
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N N N o o

3,537
3,047
2,556
2,066
1,406
1,232
1,057
0,883
0,709
0,534
0,360
0,185
1,282
1,683
2,085
2,510
2,512
2,514
2,516
1,282
1,687
2,091
2,499
2,501
2,503
2,505
2,518
2,517
2,517
2,517
2,516
2,516
2,516

& IS IS TS NS RS RS NS B NS RS RS ) B'S B S B S 2 IS B S NS B S WS BN S B YSRGS RS ) NS ' RS ) NS ) RS ' RS ) NS S RS

yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes
yes

yes

15
15
15
15
59
59
59
59
59
59
59
59
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12
12

18
18
18
18
92
92
92
92
92
92
92
92
17
17
17
17
17
17
17
17
17
17
16
16
16
16
17
17
17
17
17
17
17



long bfl bfr tf hw tw L/R
(cm) (cm) (cm) (cm) (cm)
0 13 L
13
13
13
13
13
13

1
1
1
1
1
1
1
13 1

| e e e N N

(o]

0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
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0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95

196



Long Aoff SMoff loff
(cm2) (cm3) (cm4)

1 13 60 741
2 8 22 166
3 6 12 66
4 8 22 166
5 12 57 709
6 6 12 71
7 6 12 71
8 6 12 71
9 6 12 71

Bulkhead Plates
Frame n.: 15 N. of bulkheads parts: 2

partn. | s tk overflow
(m) (m) (m) (m)
1 25 05 25 6,27
2 3, 05

partn. area Icg tcg vcg fr t
(m2) (m) (m) (m) (mm) (mm)
1 15,315,000 -0,019 1,570 6,59 7,93
2 26,515,000-0,011 4,018 4,50 4,76

Bulkhead Girders
NAO HA PRUMOS GIGANTES

Bulkhead Stiffeners
Frame n.: 15 N. of bulkheads stiffeners: 34

part n. stif n yi Zi yf zf li
(m(m) (m) (m) (m)
1 0,000 0,021 0,000 2,486 2,465
2 0,500 0,193 0,500 2,486 2,293
3 1,000 0,365 1,000 2,486 2,121
4 1,500 0,536 1,500 2,486 1,950

e e N T N
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N DD DN D DN DN DN DNDNDNDDNDNDNDDNDDNDDNDDN-_2A 2 A A4 a4 A a a A A a a Aa

stif n

A W N -

5 2,000 0,708 2,000 2,486 1,778
6 2,500 0,880 2,500 2,486 1,606
7 3,000 1,052 3,000 2,486 1,434
8 3,500 1,224 3,500 2,486 1,262
9 4,000 1,395 4,000 2,486 1,091

10 -0,500
11 -1,000
12 -1,500
13 -2,000
14 -2,500
15 -3,000
16 -3,500
17 -4,000
18 -0,011
19 0,489
20 0,989
21 1,489
22 1,989
23 2,489
24 2,989
25 3,489
26 3,989
27 -0,511
28 -1,011
29 -1,511
30 -2,011
31-2,511
32 -3,011
33 -3,511
34 -4,011

2,486 -0,500
2,486 -1,000
2,486 -1,500
2,486 -2,000
2,486 -2,500
2,486 -3,000
2,486 -3,500
2,486 -4,000
5,518 -0,011
2,496 0,489
2,496 0,989
2,496 1,489
2,496 1,989
2,496 2,489
2,496 2,989
2,496 3,489
2,496 3,989
5,518 -0,511
5,518 -1,011
5,618 -1,511
5,618 -2,011
5,618 -2,511
5,618 -3,011
5,618 -3,511
5,518 -4,011

tk overflow SMreq Ireq

(m) (m)
25 6,27
25 6,27
25 6,27
25 6,27

(cm3) (cm4)
66 232

56 183

47 141

39 107

198

0,197
0,361
0,526
0,690
0,855
1,019
1,184
1,349
2,496
5,518
5,518
5,518
5,518
5,518
5,518
5,518
5,518
2,499
2,501
2,504
2,506
2,509
2,511
2,514
2,517

2,289
2,125
1,960
1,796
1,631
1,467
1,302
1,137
3,022
3,022
3,022
3,022
3,022
3,022
3,022
3,022
3,022
3,019
3,017
3,014
3,012
3,009
3,007
3,004
3,001

0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5



stif n

A W N -

25 6,27 31 79
25 6,27 26 59
25 6,27 21 43
25 6,27 16 30
25 6,27 12 19
25 6,27 56 182
25 6,27 47 142
25 6,27 39 109
25 6,27 32 82
25 6,27 27 62
25 6,27 22 46
25 6,27 17 32
25 6,27 14 22
42 227
42 227
42 227
42 227
42 227
42 227
42 227
42 227
42 227
42 226
42 226
42 225
42 224
42 223
42 223
41 222
41 221
bfl — bfr ftf hw tw  scol tcol
(cm) (cm) (cm) (cm) (cm) (cm) (cm)
75 0 09 75 09 0,5 0,793
75 0 09 75 09 0,5 0,793
75 0 09 75 09 0,5 0,793
75 009 75 09 0,5 0,793
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7,5

7,5

7,5

7,5

7,5

7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5

o O O O o

O O O O O O O O O O O O OO0 O oo oo o o o o o o o

0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95

stif n  Aoff SMoff loff
(cm2) (cm3) (cm4)

A W N -

14
14
14
14

71
71
71
71

510
510
510
510

7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
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0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95
0,95

0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,793
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476
0,5 0,476



14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14

71
71
71
71
71
71
71
71
71
71
71
71
71
66
66
66
66
66
66
66
66
66
66
66
66
66
66
66
66
66

510
510
510
510
510
510
510
510
510
510
510
510
510
395
395
395
395
395
395
395
395
395
395
395
395
395
395
395
395
395
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Required x Offered Inertia and Section Modulus

Frame

n.

© 0 N O o A W N~ O

W W W N DN DN DD DN DN DN DN DNDN =222 A A A A A a
N = O © 0o N O o0 A W N -~ O O 0N O O b WO N ~ O

Mhog M Sag SMreq
t.m t.m

0 -0 0

87 -111 82
175 -223 165
262 -334 247
350 -445 329
437 -556 411
525 -668 494
612 -779 576
700 -890 658
787 -1001 740
875 -1113 823
962 -1224 905
1050 -1335 987
1137 -1446 1069
1224 -1558 1152
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1203 -1531 1132
1103 -1404 1038
1003 -1276 944
903 -1149 850
803 -1022 756
704 -895 662
604 -768 568
504 -641 474
404 -513 380
304 -386 286

cmZ2m cm2m2 cm2m

202

Ireq

0
56
112
168
224
280
336
391
447
503
559
615
671
727
783
784
784
784
784
784
784
784
784
769
705
642
578
514
450
386
322
258
194

SMdeck SMbot

3526,7 4913,8

loff

cm2m cm2m?2

12318,8



33 204 -259 192

34 104 -132 98
35 4 -5 4
36 0 -0 0
37 0 -0 0
38 0 -0 0
39 0 -0 0

Final Weight and CG
Weight: 110.3 ton

LCG : 17.272 (m)
TCG : -0.003 (m)
VCG ;. 2.631(m)
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A3- Lancha de 400 passageiros em aluminio

Arquivo: BAR1

Caracteristicas principais:

Comprimento total:...................oc.. 39,00m

Boca maxima moldada...................... 9,00m

Pontal moldado:........ccooevveviiiiiiiinnn. 6,00m

Calado de projeto:...........cceeeeeeeeeeeennn. 1,60m

Deslocamento no calado de projeto..235,00 ton

Velocidade de projeto:......ccvveeen. 32,00 Knots
Navegacao:......cccccvvvveeeiieiiiiiiieeeeeeee mar aberto servico irrestrito

Materiais a serem utilizados:
Chapas: Aluminio 5083 HO
Perfilados: Aluminio 6061 T6

Project Name: CREWBOAT 400PASS - ALUMINUM
Designer: Eng. Alessandro Barile
Project Reference:Hull File: BAR1,DAT

Coordinates reference
longitudinal:Aft Perpendicular
transversal: Longitudinal Center Line

vetical: Base Line

Aft Perpendicular Position: 0

Water Line aft intersection position:0

PROJECT SETTINGS

Length Overall  (m): 39,000
Length BP (m): 39,000
Lenght Waterline (m): 35,038
Breadt (m): 9,000
Breadth Water Line (m): 9,000
Depth (m): 6,000
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Draft (m): 1,600

Displacement  (ton): 235

Block Coefficient : 0,454

Wave Height (m): 2,92

Design Speed (knots): 32

Number of Passengers : 12

Number of Crew : 3

Operation Area : Unrestricted Ocean Service
Service Factor : 1

Still water Bending Moment in Hogging(t.m)):519,77
Still Water Bending Moment in Sagging(t.m) :519,77
Still Water Shearing Force t): 61,17

vertical acceleration at LCG (9): 2,16
vertical acceleration at forward end (g): 2,59

vertical acceleration at aftend  (g): 0,00

running trim (degree): 4
deadrise at CG (degree):15

Rules minimum values required for calculation

Length (m):33,987
Draft (m): 1,600
Block Coefficient : 0,454
Wave height (m): 2,920
Trim (degrees): 4,000

Deadrise at LCG (degrees):15,000

Vertical acceleration at LCG (9): 2,160

Vertical acceleration at forward end (g):2,592

Vertical acceleration at aftend  (g): 0,000

Colision bulkheads Position from 32,235(m) to 33,286 (m)

Selected Material

Plating Material : Aluminum 5083 H116 up to 38.0mm
Specific Weight (kgf/m3) 2700
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Ultimate Stress (kgf/lcm2)
Yeld Stress (kgf/cm2)

Elasticity Modulus (kgf/cm2):

Internals Material
Specific Weight (kgf/m3)
Ultimate Stress (kgf/cm2)
Yeld Stress (kgf/cm2)

Elasticity Modulus (kgf/cm2):

Lines Sections
(note: Same as BAR1 steel)

Frames Sections

(note: Same as BAR1 steel)
Bulkheads

(note: Same as BAR1 steel)
compartments sections

(note: Same as BAR1 steel)

Plates

2810
2180
7100000

Aluminum 6061 T6
2700

1680

1680

7100000

Frame n.: 19 N. of plates: 10

n. X yi

(m)  (m)

119,000 -0,021 0,000 4,082 1,564
219,000 4,114 1,575 4,425 5,496
319,000 4,436 5,518 -4,446 5,496
419,000 -4,446 5,496 -4,082 1,586
519,000 -4,093 1,575 0,000 0,000
6 19,000 1,993 0,771 2,004 2,486
7 19,000 2,004 2,496 4,179 2,518
8 19,000 -2,004 0,761 -2,014 2,496

Zi yf zf
(m) (m) (m)

—
- S o
N

S IS IS IS TS YIS S IS
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9 19,000 -2,036 2,486 -4,168 2,507 ,5 1,000
10 19,000 -2,014 2,486 2,004 2,496 ,5 1,000

n. tk overflow w h

(m) (m) (m) (m)

1 2,5 6,26

2 25 6,26

3

4 2,5 6,26

5 25 6,26

6 25 6,26

7 25 6,26

8 25 6,26

9 25 6,26

10
n. SM type tr t

(mm)  (mm)

1 vyes bottom 11,89 12,7
2 vyes side/transom 6,99 7,93
3 yes exposed freeboard deck 4 61 476
4 vyes side/transom 6,98 7,93
5 vyes bottom 11,89 127
6 yes tank boundaries 6,36 7,93
7 yes tank boundaries 6,18 6,35
8 yes tank boundaries 6,37 7,93
9 vyes tank boundaries 6,18 6,35
10 vyes internal decks 4,03 4,76

Longitudinal Girders

Frame n.: 19 N. of Longitudinal Girders: 4
Lgirder plate vyi Zi yf zf

(m)  (m) (m) (m)
1-0,021 0,000 4,082 1,564
3 4,436 5,518 -4,446 5,496
3 4,436 5,518 -4,446 5,496
3 4,436 5,518 -4,446 5,496

A WODN -
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Lgirder vy z

-0,021 0,011
2 5,539
-0,011 5,496
-1,993 5,496

A WO N -

S |

4 2
4 2
4 2
4 2

Lgirder bfl bfr ff hw tw

(cm) (cm) (em) (c
1 15 15 19
2 5 5 09
3 5 5 09
4 5 5 095

Lgirder Aoff SMoff Ioff

(cm2) (cm3) (cm4)
107 3354 103956
48 741 20095
48 741 20095
48 741 20095

A WO DN -

Transversal Girders

m) (cm)

50 1

40 0,95
40 0,95
40 0,95

SM

yes
yes
yes

yes

tcol SMreq Ireq
(m) (m)  (m) (m)(mm) (cm3) (cm4)

11,89
4,61
4,61
4,61

L/R

180

180
180

3119 2852
697 378
697 378
697 378

Frame n.: 19 N. of Transversalal Girders: 17

Tgirder plate yi
(m)
1 -0,011
1 1,982
2 4,093
2 4,168
3 4,436
3 1,993
3 -0,021
3 -2,004
4 -4,457
4 -4,168
5 -4,093

© 0o N o o b~ W0 DN -

S SN
- O

Zi
(m)
0,000
0,782
1,575
2,518
5,518
5,518
5,529
5,496
5,496
2,507
1,575

208

yf

(m)
1,993
4,093
4,168
4,425
1,993
-0,011
-2,004
-4,446
-4,168

-4,082

zf
(m)
0,771
1,586
2,507
5,518
5,529
5,486
5,496
5,518
2,518
1,596

-2,014 0,761



12
13
14
15
16
17

Tgirder

0 N OO o b~ WO DN -

(o]

10
11
12
13
14
15
16
17

Tgirder

0 N O a0 B~ W0 N -

5 -2,025 0,782 -0,011
6 1,993 0,782 2,014
7 2,025 2475 4,136
8 -2,014 0,771 -2,004
9 -2,014 2,486 -4,168
10 -2,004 2,496 2,004
I s tcol SMreq Ireq
(m)  (m) (cm) (cm3) (cm4)
2,147 1,000 11,89 525 317
2,259 1,000 11,89 576 366
0,935 1,000 6,99 33 5
3,011 1,000 6,99 376 239
2,443 1,000 4,61 57 43
2,004 1,000 461 39 24
1,983 1,000 4,61 38 23
2,442 1,000 4,61 57 43
2,992 1,000 6,98 370 234
0,915 1,000 6,98 31 5
2,233 1,000 11,89 564 354
2,149 1,000 11,89 526 318
1,714 1,000 6,36 83 30
2,112 1,000 6,18 147 66
1,758 1,000 6,37 88 33
2,154 1,000 6,18 154 70
4,008 1,000 4,03 109 126
bfl bfr tf hw  tw L/R
(cm) (cm) (cm) (cm)(cm)
20 0 127 20 1,27 L
20 0 127 20 1,27 L
152 0 1,27 152 127 L
152 0 1,27 152 127 L
75 0 08 75 /8 L
75 0 08 75 /8 R
75 0 08 75 /8 R
75 0 08 75 /8 L
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0,032
2,496
2,529
2,529
2,529
2,464



9 15,2
10 15,2

0 127 152 1,27

0 1,27 152 1,27
1 20 0 1,27 20 1,27
12 20 0 1,27 20 1,27
13 10 0 09 10 0,95
14 10 0 1,27 10 1,27
15 10 0 095 10 0,95
16 10 0 1,27 10 1,27
177 10 0 1,27 10 1,27

r—- r X0 X0 X0 X A0 X

Tgirder Aoff SMoff loff
(cm2) (cm3) (cm4)
51 650 10322
51 652 10471
39 335 3046
39 365 4268
12 58 407
12 58 396
12 58 395
12 58 407
39 365 4266
39 334 3015
51 651 10439
51 650 10322
19 121 1030
14 25 159 1366
15 19 122 1038
16 25 158 1307
17 25 153 1197

© 00 N O 0o A ODN -

A A A A
w N =~ O

Longitudinals

Frame n.: 19 N. of Longitudinal: 47

long plate i Zi yf zf li Si
(m) (m)  (m) (m) (m) (m)
1 1-0,011 0,011 4,093 1,564 0,500 .5
2 1-0,011 0,011 4,093 1,564 0,986 5
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1-0,011 0,011
1-0,011 0,011
1-0,011 0,011
1-0,011 0,011
1-0,011 0,011
1-0,011 0,011
2 4,071 1,564

4,093 1,564
4,093 1,564
4,093 1,564
4,093 1,564
4,093 1,564
4,093 1,564
4,425 5,507

1,472
1,958
2,444
2,930
3,416
3,902
0,500

2 4,071
4,071
4,071
4,071
4,071
4,071
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
4,414
3 4,414
4 -4,435
4 -4,435
4 -4,435
4 -4,435
4 -4,435
4 -4,435
4 -4,435

W W W W W W W W W WwWwwwowwwowhNdDDdNdDDdDdDDdNdDDD

1,564 4,425
1,564 4,425
1,564 4,425
1,564 4,425
1,564 4,425
1,564 4,425
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,507 -4,414
5,627 -4,070
5,627 -4,070
5,627 -4,070
5,627 -4,070
5,627 -4,070
5,627 -4,070
5,627 -4,070

211

5,507
5,507
5,507
5,507
5,507 2,971
5,507 3,465
5,496 -0,500
5,496 -0,990
5,496 -1,480
5,496 -1,970
5,496 -2,460
5,496 -2,949
5,496 -3,439
5,496 -3,929
5,496 -4,419
5,496 -4,909
5,496 -5,399
5,496 -5,889
5,496 -6,379
5,496 -6,868
5,496 -7,358
5,496 -7,848
5,496 -8,338
1,591 0,500
1,591 0,993
1,591 1,487
1,591 1,980
1,591 2,473
1,591 2,966
1,591 3,460

0,994
1,488
1,982
2,476

e S S RS S IS YRS NS RS RS S

& RS S IS TS, B S BES HS  HS  HErS ) HErd BN BN S M S BN S BNS BN IS S ) RS ) IS ) HENY'S ) BRSNS ) N ) B¢ NS BS, B B &)



40 5-4,102 1,581 -0,027 0,032 0,500
41 5-4,102 1,581 -0,027 0,032 0,982
42 5-4,102 1,581 -0,027 0,032 1,465
43 5-4,102 1,581 -0,027 0,032 1,947
44 5-4,102 1,581 -0,027 0,032 2,430
45 5-4,102 1,581 -0,027 0,032 2,912
46 5-4,102 1,581 -0,027 0,032 3,395
47 5-4,102 1,581 -0,027 0,032 3,877

g o0 o o0 o1 O OO O

long vy z
(m) (m)

(7]

I SM SMreq Ireq
(m) (cm3) (cm4)

3

1 0,457 0,188 ,5 1,000 yes 85 19
10911 0,360 ,5 1,000 yes 85 19
11,366 0,532 ,5 1,000 yes 85 19
11,820 0,704 ,5 1,000 yes 85 19
12275 0876 ,5 1,000 yes 85 19
12,729 1,048 ,5 1,000 yes 85 19
13,184 1,220 ,5 1,000 yes 85 19
13,638 1,392 ,5 1,000 yes 85 19
24116 2,062 ,5 1,000 yes 21 4
24,160 2,554 5 1,000 yes 21 4
2 4,204 3,046 ,5 1,000 yes 21 4
2 4,248 3,538 ,5 1,000 yes 21 4
24292 4031 ,5 1,000 yes 21 4
2 4337 4523 51,000 yes 21 4
2 4381 5015 ,5 1,000 yes 21 4
3 3,914 5506 ,5 1,000 yes 11 1
3 3,424 5,506 ,5 1,000 yes 11 1
3 2,934 5505 ,5 1,000 yes 11 1
3 2,444 5505 5 1,000 yes 11 1
3 1,954 5504 5 1,000 yes 11 1
3 1,465 5,503 ,5 1,000 yes 11 1
3 0,975 5503 ,5 1,000 yes 11 1
3 0,485 5,502 ,5 1,000 yes 11 1
3-0,005 5501 ,5 1,000 yes 11 1
3-0,495 5,501 ,5 1,000 yes 11 1
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3-0,985 5500 ,5 1,000 yes
3-1,475 5500 ,5 1,000 vyes
3-1,965 5,499 5 1,000 vyes
3-2,454 5498 5 1,000 vyes
3-2,944 5498 5 1,000 vyes
3-3,434 5,497 5 1,000 vyes
3-3,924 5497 5 1,000 vyes
4-4,389 5,029 ,5 1,000 yes
4-4,343 4,538 ,5 1,000 yes
4-4,298 4,047 ,5 1,000 yes
4-4,252 3,556 ,5 1,000 yes
4-4,207 3,064 ,5 1,000 yes
4-4161 2,573 ,5 1,000 yes
4-4116 2,082 ,5 1,000 yes
5-3,635 1,403 ,5 1,000 vyes
5-3,184 1,232 ,5 1,000 vyes
5-2,733 1,061 ,5 1,000 vyes
5-2,282 0,889 ,5 1,000 vyes
5-1,831 0,718 ,5 1,000 vyes
5-1,380 0,546 ,5 1,000 vyes
5-0,929 0,375 ,5 1,000 vyes
5-0,478 0,203 ,5 1,000 vyes

long bfl bfr ff hw tw L/R

(cm) (cm) (cm) (cm)  (cm)

1 10 0 08 10 08 L
2 0 0 O 8 095 L
3 0 0 O 6 09 R
4 0 0 O 8 09 R
5 0 10 8 10 08 R

Long Aoff SMoff loff
(cm2) (cm3) (cm4)
16 110 1058
8 21 160
6 12 65
8 21 160

A W N -
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5 16 110 1058

Bulkhead Plates
Frame n.: 15 N. of bulkheads parts: 2

partn. | s tk overflow
(m) (m) (m) (m)
1 25 5 25 6,27
2 35 5

partn. area Icg tcg vcg tr
(m2) (m) (m) (m) (mm) (mm)
1 15,115,000 0,001 1,565 6,92 7,93
2 26,3 15,000 -0,003 4,012 4,73 4,76

Bulkhead Girders

Nao ha prumos gigantes na antepara

Bulkhead Stiffeners
Frame n.: 15 N. of bulkheads stiffeners: 34

part n. stif n yi zi yf zf li
(m) (m)  (m) (m) (m)
1-0,016 2,511 -0,016 0,022 2,489
0,484 0,167 0,484 2,510 2,343
0,984 0,334 0,984 2,509 2,175
1,484 0,501 1,484 2,509 2,007
1,984 0,668 1,984 2,508 1,840
2,484 0,835 2,484 2,507 1,672
2,984 1,002 2,984 2,507 1,504
3,484 1,169 3,484 2,506 1,337
9 3,984 1,336 3,984 2,505 1,169
10-0,516 2,511 -0,516 0,191 2,320
11-1,016 2,512 -1,016 0,360 2,151
12 -1,516 2,512 -1,516 0,530 1,983
13-2,016 2,513 -2,016 0,699 1,814
14 -2,516 2,514 -2,516 0,868 1,646

0 N o ok~ 0N
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N N D DD DN DN DN DN DNDNDNDDNDNDDNDDNDDNDDNDDN-_2 2

stif n

o N O o b~ W N -

11
12
13
14

15-3,016
16 -3,516
17 -4,016
18 -0,005

19
20
21
22
23
24
25
26

0,495
0,995
1,495
1,995
2,495
2,995
3,495
3,995

27 -0,505
28 -1,005
29 -1,505
30 -2,005
31-2,505
32 -3,005
33 -3,505
34 -4,005

2,514 -3,016
2,515 -3,516
2,516 -4,016

5,521
2,517
2,519
2,520
2,521
2,522
2,524
2,525
2,526

-0,005
0,495
0,995
1,495
1,995
2,495
2,995
3,495
3,995

5,622 -0,505
5,623 -1,005
5,623 -1,505
5,624 -2,005
5,625 -2,505
5,625 -3,005
5,526 -3,505
5,526 -4,005

tk overflow SMreq Ireq
(cm3) (cm4)

(m)
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5
2,5

(m)
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27
6,27

96
83
70
58
48
40
33
26
20
81
68
57
46
39

71
58
45
35
26
20
15
10

7
56
43
33
25
19
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1,037
1,206
1,376
2,538
5,621
5,520
5,520
5,519
5,518
5,518
5,517
5,517
2,537
2,535
2,534
2,533
2,532
2,530
2,529
2,528

1,477
1,309
1,140
2,983
3,004
3,002
3,000
2,998
2,996
2,994
2,992
2,990
2,985
2,987
2,989
2,991
2,993
2,995
2,997
2,999

T S O S S S S PO YU NS
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15 2,5 6,27 32 14
16 2,5 6,27 25 10
17 2,5 6,27 19 7

18 58 64

19 59 66

20 59 65

21 59 65

22 59 65

23 59 65

24 59 65

25 59 65

26 58 65

27 58 64

28 58 64

29 58 64

30 58 64

31 58 65

32 58 65

33 59 65

34 59 65

stif n  bfl bfr tf hw tw scol tcol

(cm) (cm) (cm) (cm) (cm)  (cm) (cm)

1 10 O0 08 10 0,8 0,5 0,692

2 10 O0 08 10 0,8 0,5 0,692

3 10 O 08 10 0,8 0,5 0,692

4 10 o0 08 10 0,8 0,5 0,692

5 10 0 08 10 0,8 0,5 0,692

6 10 O 08 10 0,8 0,5 0,692

7 10 0 08 10 0,8 0,5 0,692

8 10 O 08 10 0,8 0,5 0,692

9 10 O 08 10 0,8 0,5 0,692

10 10 O 0,8 10 0,8 0,5 0,692

1 10 O0 0,8 10 0,8 0,5 0,692

12 10 O0 0,8 10 0,8 0,5 0,692

13 10 0 0,8 10 0,8 0,5 0,692

14 10 O0 0,8 10 0,8 0,5 0,692
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15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

10

10

10
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5

O O O O O O O O O O O O oo o o o o o o

0,8

0,8

0,8
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953

stif n  Aoff SMoff loff
(cm2) (cm3) (cm4)

© 0o N o o b~ W0 N -
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16
16
16
16
16
16
16
16
16
16
16
16
16
16

104
104
104
104
104
104
104
104
104
104
104
104
104
104

893
893
893
893
893
893
893
893
893
893
893
893
893
893

10

10

10

7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
7,5
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0,8

0,8

0,8

0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953
0,953

0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5
0,5

0,692
0,692
0,692
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473
0,473



15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

16
16
16
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14
14

104 893
104 893
104 893

66
66
66
66
66
66
66
66
66
66
66
66
66
66
66
66
66

394
394
394
394
394
394
394
394
394
394
394
394
394
394
394
394
394

Required x Offered Inertia and Section Modulus

Frame Mhog M Sag

n.

© 0O N oo o0 A W N~ O

S SN
= O

t.m
0
87
175
262
350
437
525
612
700
787
875
962

t.m
-0
-111
-223
-334
-445
-556
-668
=779
-890
-1001
-1113
-1224

SMreq
cm2m
0

82
165
247
329
411
494
576
658
740
823
905

218

Ireq SMdeck SMbot loff
cm2m2 cm2m cm2m cm2m?2
0

56

112

168

224

280

336

391

447

503

559

615



12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39

1050 -1335 987

1137  -1446 1069
1224  -1558 1152
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1226 -1559 1153
1203  -1531 1132
1103  -1404 1038
1003 -1276 944

903 -1149 850

803
704
604
504
404
304
204
104
4

o O O O

-1022 756
-895 662
-768 568
-641 474
-513 380
-386 286
-259 192
-132 98
-5 4

-0 0

-0 0

-0 0

-0 0

Final Weight and CG

Weight:
LCG
TCG
VCG

41.4 ton
17.307 (m)
-0.002 (m)
2.592 (m)
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671
727
783
784
784
784
784
784
784
784
784
769
705
642
578
514
450
386
322
258
194
130

O O O O N

3694,3 5239,9 13000,2



A4- Lancha Wolver2 em aluminio
Project Name: WOLVER2
Designer:

Project Reference:Hull File: WOLVER2,DAT

Coordinates reference

longitudinal: Aft Perpendicular
transversal: Longitudinal Center Line
vetical: Base Line

Aft Perpendicular Position:

Water Line aft intersection position: 0

PROJECT SETTINGS

Length Overall  (m): 12,200
Length BP (m): 12,200
Lenght Waterline (m): 11,089
Breadt (m): 3,300
Breadth Water Line (m): 3,300
Depth (m): 2,150
Draft (m): 0,750
Displacement  (ton): 15
Block Coefficient : 0,533
Wave Height (m): 0,92
Design Speed (knots): 20
Number of Passengers : 6
Number of Crew : 2
Operation Area : Restricted Service
Service Factor : 0,5

Still water Bending Moment in Hogging (t.m)):81,00
Still Water Bending Moment in Sagging (t.m) :81,00
Still Water Shearing Force t): 30,12
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vertical acceleration at LCG (9): 1,58
vertical acceleration at forward end (g): 1,90

vertical acceleration at aftend  (g): 0,00

running trim (degree). 4
deadrise at CG (degree): 30

Rules minimum values required for calculation

Length (m):

Draft (m):
Block Coefficient

Wave height (m):
Trim (degrees):
Deadrise at LCG (degrees):

Vertical acceleration at LCG (9):
Vertical acceleration at forward end (g): 1,900

Vertical acceleration at aftend  (g): 0,000

10,756
0,750
0,533
0,924
4,000
10,000
1,580

Colision bulkheads Position from 10,202(m) to 10,535 (m)

Selected Material

Plating Material : Aluminum 5083 H116 up to 38.0mm
Specific Weight (kgf/m3) 2700
Ultimate Stress (kgf/lcm2) 2810
Yeld Stress (kgf/lcm2) ; 2180

Elasticity Modulus (kgf/cm2): 7100000

Internals Material : Aluminum 5083 H112 extrusion
Specific Weight (kgf/m3) 2700
Ultimate Stress (kgf/lcm2) : 2810
Yeld Stress (kgf/lcm2) : 1120

Elasticity Modulus (kgf/cm2): 7100000

Lines Sections

Number of Sections: 22
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X (m):
Y
(m)
0.000
1.384
1.650
0.000

X (m):
Y
(m)
0.000
1.388
1.650
0.000

X (m):

0.000 Number of Points:

Z Chine
(m)
0.050 k
0.581 C1
1.950 d
1.950 LC
0.554 Number of Points:
Y4 Chine
(m)
0.046 k
0.595 C1
1.953 d
1.953 LC
1.109 Number of Points:
V4 Chine
(m)
0.040 k
0.609 C1
1.956 d
1.956 LC
1.663 Number of Points:
4 Chine
(m)
0.032 k
0.625 C1
1.959 d
1.959 LC
2.218 Number of Points:
4 Chine
(m)
0.023 k
0.643 C1
1.962 d
1.962 LC
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X (m):
Y
(m)
0.000
1.430
1.650
0.000

X (m):
Y
(m)
0.000
1.439
1.650
0.000

X (m):

2.772 Number of Points:

4 Chine
(m)
0.015 k
0.664 C1
1.966 d
1.966 LC
3.327 Number of Points:
Y4 Chine
(m)
0.007 k
0.687 C1
1.971 d
1.971 LC
3.881 Number of Points:
Z Chine
(m)
0.001 k
0.714 C1
1.977 d
1.977 LC
4.436 Number of Points:
4 Chine
(m)
-0.003 k
0.745 C1
1.983 d
1.983 LC
4.990 Number of Points:
4 Chine
(m)
-0.003 k
0.780 C1
1.991 d
1.991 LC
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X (m):
Y
(m)
0.000
1.421
1.650
0.000

X (m):
Y
(m)
0.000
1.393
1.616
0.000

X (m):

5.545 Number of Points:

Z Chine
(m)
-0.000 k
0.820 C1
2.000 d
2.000 LC
6.099 Number of Points:
Y4 Chine
(m)
0.008 k
0.867 C1
2.011 d
2.011 LC
6.654 Number of Points:
V4 Chine
(m)
0.021 k
0.918 C1
2.023 d
2.023 LC
7.208 Number of Points:
4 Chine
(m)
0.040 k
0.975 C1
2.038 d
2.038 LC
7.763 Number of Points:
4 Chine
(m)
0.066 k
1.039 C1
2.053 d
2.053 LC
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X (m):
Y
(m)
0.000
1.164
1.350
0.000

X (m):
Y
(m)
0.000
1.071
1.244
0.000

X (m):

0.000
0.830
0.971
0.000
X (m):

8.317 Number of Points:

4 Chine
(m)
0.100 k
1.112 C1
2.070 d
2.070 LC
8.872 Number of Points:
Z Chine
(m)
0.185 k
1.194 C1
2.086 d
2.086 LC
9.426 Number of Points:
Z Chine
(m)
0.310 k
1.288 C1
2.103 d
2.103 LC
9.980 Number of Points:
Z Chine
(m)
0.485 k
1.395 C1
2.119 d
2.119 LC
10.535 Number of Points:
4 Chine
(m)
0.718 k
1.516 C1
2.135 d
2.135 LC
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X (m): 10.701 Number of Points: 4

Y 4 Chine

(m) (m)

0.000 0.800 k

0.628 1.556 C1

0.742 2.140 d

0.000 2.140 LC
X (m): 11.089 Number of Points: 4
Y V4 Chine

(m) (m)

0.000 1.150 k

0.503 1.653 C1

0.600 2.150 d

0.000 2.150 LC
X (m): 12.200 Number of Points: 4
Y V4 Chine

(m) (m)

0.000 2.150 k

0.000 2.150 C1

0.000 2.150 d

0.000 2.150 LC

Frames Sections

first frame number: 0 last frame number:

X(m):  0.000 Number of Points: 7

Y z Chine
(m) (m)

0.000 0.050

1.384 0.581

1.650 1.950

0.000 1.950

-1.650 1.950

-1.384 0.581

-0.000 0.050
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X(m): 0.500 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.046

1.387 0.594

1.650 1.953

0.000 1.953

-1.650 1.953

-1.387 0.594

-0.000 0.046

X(m): 1.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.041

1.395 0.606

1.650 1.955

0.000 1.955

-1.650 1.955

-1.395 0.606
-0.000 0.041

X(m):  1.500 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.035

1.405 0.620

1.650 1.958

0.000 1.958

-1.650 1.958
-1.405 0.620
-0.000 0.035
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X(m): 2.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.026
1.415 0.636
1.650 1.961
0.000 1.961
-1.650 1.961
-1.415 0.636
-0.000 0.026

X(m): 2.500 Number of Points: 7

Y 4 Chine
(m) (m)
0.000 0.019
1.425 0.653
1.650 1.964
0.000 1.964
-1.650 1.964
-1.425 0.653
-0.000 0.019

X(m): 3.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.012

1.434 0.673

1.650 1.968

0.000 1.968

-1.650 1.968

-1.434 0.673

-0.000 0.012
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X(m): 3.500 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.005

1.441 0.695

1.650 1.973

0.000 1.973
-1.650 1.973
-1.441 0.695
-0.000 0.005

X(m): 4.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 -0.000

1.444 0.720

1.650 1.978

0.000 1.978
-1.650 1.978
-1.444 0.720
-0.000 -0.000

X(m):  4.500 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 -0.003

1.442 0.749

1.650 1.984

0.000 1.984
-1.650 1.984
-1.442 0.749
-0.000 -0.003
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X(m): 5.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 -0.003

1.436 0.781

1.650 1.991

0.000 1.991

-1.650 1.991

-1.436 0.781

-0.000 -0.003

X(m): 5.500 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 -0.000

1.423 0.816

1.651 1.999

0.000 1.999

-1.651 1.999

-1.423 0.816

-0.000 -0.000

X(m):  6.000 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.006

1.399 0.858

1.624 2.009

0.000 2.009

-1.624 2.009

-1.399 0.858

-0.000 0.006
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X(m): 6.500 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.017
1.367 0.903
1.584 2.019
0.000 2.019
-1.584 2.019
-1.367 0.903
-0.000 0.017

X(m): 7.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.032
1.326 0.953
1.535 2.032
0.000 2.032
-1.535 2.032
-1.326 0.953
-0.000 0.032

X(m):  7.500 Number of Points: 7

Y Z Chine
(m) (m)

0.000 0.054

1.274 1.008

1.476 2.046

0.000 2.046
-1.476 2.046
-1.274 1.008

-0.000 0.054
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X(m): 8.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.077
1.210 1.069
1.403 2.060
0.000 2.060
-1.403 2.060
-1.210 1.069
-0.000 0.077

X(m): 8.500 Number of Points: 7

Y 4 Chine
(m) (m)

0.000 0.122

1.135 1.138

1.317 2.075

0.000 2.075

-1.317 2.075

-1.135 1.138

-0.000 0.122

X(m):  9.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.211
1.047 1.215
1.217 2.090
0.000 2.090
-1.217 2.090
-1.047 1.215
-0.000 0.211
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X(m): 9.500 Number of Points: 7

Y 4 Chine
(m) (m)
0.000 0.330
0.944 1.302
1.101 2.105
0.000 2.105
-1.101 2.105
-0.944 1.302
-0.000 0.330

X(m): 10.000 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.493
0.825 1.399
0.965 2.120
0.000 2.120
-0.965 2.120
-0.825 1.399
-0.000 0.493

X(m): 10.500 Number of Points: 7

Y Z Chine
(m) (m)
0.000 0.703
0.688 1.508
0.810 2.134
0.000 2.134
-0.810 2.134
-0.688 1.508

-0.000 0.703

233



X(m): 11.000 Number of Points: 7

Y 4 Chine
(m) (m)
0.000 1.059
0.534 1.628
0.635 2.148
0.000 2.148
-0.635 2.148
-0.534 1.628
-0.000 1.059

X(m): 11.500 Number of Points: 7

Y Z Chine
(m) (m)
0.000 1.544
0.337 1.805
0.405 2.154
0.000 2.154
-0.405 2.154
-0.337 1.805
-0.000 1.544

X(m): 12.000 Number of Points: 7

Y Z Chine
(m) (m)

0.000 1.981

0.100 2.046

0.120 2.152

0.000 2.152

-0.120 2.152

-0.100 2.046

-0.000 1.981
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Bulkheads

Frame:= 0 Longitudinal Position:=  0.000 (m)
Frame:= 2 Longitudinal Position:=  1.000 (m)
Frame:= 9 Longitudinal Position:=  4.500 (m)

Frame:= 21 Longitudinal Position:= 10.500 (m)

compartments sections

(independent tanks)

Plates

Frame n.: 11 N. of plates: 5

n. X yi Zi yf zf s |
(m) (m (m) (m) (m) (m) (m)
1 5,500 -0,002 0,005 1,423 0,823 1,5 0,500
2 5,500 1,423 0,819 1,646 2,001 1,2 0,500
3 5,500 1,646 1,997 -1,650 2,009 1,65 0,500
4 5,500 -1,654 2,001-1,431 0,811 1,2 0,500
5 5,500 -1,439 0,815-0,010 0,001 1,5 0,500

n. tk overflow w h

(m  (m) (m) (m)

1

2

3

4

5
n. SM type tr

(mm)

1 vyes bottom 6,61
2 vyes side/transom 4,61
3 yes exposed freeboard deck 3,50
4 yes side/transom 4,62
5 yes bottom 6,61
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Longitudinal Girders

Frame n.: 11 N. of Longitudinal Girders: 2

Lgirder plate i Zi yf  zf
(m)  (m) (m) (m)
1 1-0,002 0,005 1,423 0,823
2 3 1,646 1,997 -1,650 2,009

Lgirder y z S [ tcol SMreq Ireq
(m) (m) (m) (m) (mm) (cm3) (cm4)
1-0,006 0,013 2 145 6,61 384 79

2 -0,006 2,005 2 145 3,50 129 23

Lgirder bfl bfr tf hw  tw L/R
(cm) (cm) (cm) (cm) (cm)

1 5 5127 25 8 0

2 5 50,635 200,635 180

Lgirder Aoff SMoff loff SM
(cm2) (cm3) (cm4)

1 33 444 8395 yes

2 19 192 2809 yes

Transversal Girders

Frame n.: 11 N. of Transversalal Girders: 6

Tgirder plate i zi yf zf
(m)  (m) (m) (m)
1 0,002 0,001 1,423 0,815
2 1,423 0,819 1,646 1,986
3 1,646 1,997 -0,006 2,001
3-0,006 1,997 -1,650 2,005
4 -1,658 2,005-1,431 0,811
5-1,435 0,815 -0,014 0,009

o a A W N -
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Tgirder | s tcol SMreq Ireq

(m) (m) (cm) (cm3) (cm4)
1,638 0,500 6,61 73 22

1,188 0,500 4,61 13
1,652 0,500 3,50 13
1,644 0,500 3,50 13
1,215 0,500 4,62 14
1,634 0,500 6,61 73 22

o O A WO N -
N B OO DN

Tgirder bfl bfr tf hw tw L/R

(cm) (cm) (cm) (cm) (cm)

1 10 O0 8 10 ,8 L
2 0 0 0 8 8 L
3 0 0 O 8 8 L
4 0 O 0 8 8 L
5 0 0 0 8 8 R
6 10 O0 08 10 ,8 R

Tgirder Aoff SMoff loff
(cm2) (cm3) (cm4)

1 16 103 880
2 6 17 119
3 6 16 116
4 6 16 116
5 6 17 120
6 16 103 880

Longitudinals

N&o ha longitudinais comuns no casco

Bulkhead Plates
Frame n.: 9 N. of bulkheads parts: 1

part n. | s tk overflow

(m) (m) (m) (m)
1 2 03
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partn. area Icg tcg vcg

(m2) (m) (m) (m)
1 4,9 4,500 0,001 1,189 3,50 3,50

Bulkhead Girders

tr

t

Nao ha prumos gigantes na antepara

Bulkhead Stiffeners

Frame n.: 9 N. of bulkheads stiffeners: 11

part n. stif n yi

(m)
-0,002
0,298
0,598
0,898
1,198
1,498
-0,302
-0,602
-0,902
-1,202
-1,502

© 0o N O 0o b~ W0 DN -

B N N . N N N N Y . N N
N

—_—
—

stif n tk overflow SMreq
(m) (m) (cm3)

1 14
2 11
3 8
4 6
5 5
6 1
7 11
8 8
9 6
10 5
11 1

Zi
(m)
1,986
0,153
0,309
0,465
0,622
1,109
1,986
1,986
1,986
1,986
1,986
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yf

(m)
-0,002
0,298
0,598
0,898
1,198
1,498
-0,302
-0,602
-0,902
-1,202
-1,502

Ireq
(cm4)

O =~ N N W O =~ NN Ww o

(mm) (mm)

zf
(m)
0,001
1,986
1,986
1,986
1,986
1,986
0,156
0,312
0,467
0,623
1,095

l
(m)

1,985
1,833
1,677
1,521
1,364
0,877
1,830
1,674
1,519
1,363
0,891

(m)
0,3
0,3
0,3
0,3
0,3
0,3
0,3
0,3
0,3
0,3
0,3



stifn bfl bfr tf hw tw scol tcol

(cm) (cm) (cm) (cm) (cm) (cm) (cm)

1 o0 o o 75 08 030,350
2 0 o o 75 08 030,350
3 0 0 O 75 08 030,350
4 0 O 0 75 08 030,350
5 0 0 O 75 08 030,350
6 0 O O 75 08 030,350
7 0 O O 75 08 030,350
8 0 O O 75 08 030,350
9 0 O O 75 08 030,350
10 0 O o0 75 08 0,330,350
1 o0 O o075 08 0,330,350

stif n  Aoff SMoff loff
(cm2) (cm3) (cm4)

1 6 13 79
2 6 13 79
3 6 13 79
4 6 13 79
5 6 13 79
6 6 13 79
7 6 13 79
8 6 13 79
9 6 13 79
10 6 13 79
1 6 13 79
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Required x Offered Inertia and Section Modulus

Frame

n.

© 0o N o o0~ W N >~ O

A A A
N =~ O

Mhog M Sag
t.m t.m
0 -0
16 -18
48 -55
80 -91
112 -128
141 -162
141 -162
141 -162
131 -150
94 -108
58 -66
21 -25
0 -0

Final Weight and CG
2.4 ton

Weight:
LCG
TCG
VCG

4.874 (m)
-0.006 (m)
1.103 (m)

SMreq
cm2m
0

25

74
124
173
219
219
219
203
146
90

33

240

Ireq

cmZ2m2 cm2m

0
14
41
69
96
122
122
122
113
81
50
19

SMdeck SMbot

loff

cm2m cm2m2

318,8 323,6 3453



Livros Gratis

( http://www.livrosgratis.com.br )

Milhares de Livros para Download:

Baixar livros de Administracao

Baixar livros de Agronomia

Baixar livros de Arquitetura

Baixar livros de Artes

Baixar livros de Astronomia

Baixar livros de Biologia Geral

Baixar livros de Ciéncia da Computacao
Baixar livros de Ciéncia da Informacéo
Baixar livros de Ciéncia Politica

Baixar livros de Ciéncias da Saude
Baixar livros de Comunicacao

Baixar livros do Conselho Nacional de Educacdo - CNE
Baixar livros de Defesa civil

Baixar livros de Direito

Baixar livros de Direitos humanos
Baixar livros de Economia

Baixar livros de Economia Doméstica
Baixar livros de Educacao

Baixar livros de Educacdo - Transito
Baixar livros de Educacao Fisica

Baixar livros de Engenharia Aeroespacial
Baixar livros de Farmacia

Baixar livros de Filosofia

Baixar livros de Fisica

Baixar livros de Geociéncias

Baixar livros de Geografia

Baixar livros de Histdria

Baixar livros de Linguas
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